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关于本手册

主题 本书提供有关与 Sybase IQ 搭配使用的实用程序的参考资料。实用程
序是指那些可直接从操作系统调用的命令。还有其它书籍提供了有
关如何执行特定任务的详细背景信息。您可使用此参考书来查找可
用的语法、参数和选项等信息。

读者 本书可用作所有 Sybase IQ 用户的参考资料。

如何使用本手册 本书对 Sybase IQ 实用程序进行了全面的介绍。不过，本书没有为每
一实用程序介绍其在什么情况下以及为何需要使用。本书和 Sybase
IQ 文档集中的其它书籍一起作为参考资料使用。

下表列出了各章节涉及的主要内容。

表 1： 本手册的使用指南

Windows 平台
除非另有说明，本书中的 Windows 信息适用于所有支持的 Windows
平台。如需了解支持的 Windows 平台，请参见《适用于 Windows 的
Sybase IQ 发行公告》

相关文档 Sybase IQ 的文档：

• 《Sybase IQ 简介》

如果您对 Sybase IQ 或 Sybase Central™ 数据库管理工具不熟悉，
请阅读并进行练习。

• 《Sybase IQ 12.7 中的新增功能》

介绍了一系列新功能，可在即将购买 Sybase IQ 之前或购买之后
不久阅读。

欲了解内容 参见

停止和启动数据库服务器 第 1 章 “运行数据库服务器”

使用 Interactive SQL (dbisql) 第 2 章 “使用 Interactive SQL (dbisql)”
运行数据库管理实用程序 第 3 章 “数据库管理实用程序”

运行 SQL 预处理器 (sqlpp) 第 4 章 “SQL 预处理器”
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• 《Sybase IQ 性能和调优指南》

阅读此文档可帮助您了解有关大型数据库的查询优化、升级和调优
问题。

• 《Sybase IQ 参考手册》

全面介绍了 Sybase IQ 支持的 SQL 语言、存储过程、数据类型和系
统表。

• 《Sybase IQ 系统管理指南》

阅读此文档可帮助您了解管理问题，如数据库创建和装载操作、数
据安全和完整性、服务器启动和连接，以及 Multiplex 操作。

• 《Sybase IQ 故障排除和恢复指南》

介绍了有关如何解决问题、执行系统恢复和修复数据库的信息。

• 《Sybase IQ Error Messages》（Sybase IQ 错误消息）

介绍了 Sybase IQ 的错误信息（由 SQLCode、SQLState 和 Sybase 错
误代码引用）、 SQL 预处理器错误和警告。

• 《Sybase IQ 安装和配置指南》

在安装 Sybase IQ 之前或安装 Sybase IQ 的过程中、迁移到新版本的
Sybase IQ 或针对特定平台配置 Sybase IQ 时，可阅读适用于您所用
平台的该文档版本。

• 《Sybase IQ 发行公告》

介绍了对产品和文档所做的最新更改，可在即将购买 Sybase IQ 时或
购买之后不久阅读。如果遇到问题，可阅读以获得帮助。

• 《Sybase IQ 中的大对象管理》

阅读以了解如何在 Sybase IQ 数据存储库中存储和检索二进制大对
象 (BLOB) 和字符大对象 (CLOB)。需要有单独的许可证才能安装此
产品选件。

• 《Sybase IQ 中的加密列》

阅读本文档可了解如何在 Sybase IQ 数据存储库中使用用户加密的
列。需要有单独的许可证才能安装此产品选件。

Sybase IQ 和 Adaptive Server Anywhere
由于 Sybase IQ 是 Adaptive Server® Anywhere 的扩展，而后者是 SQL 
Anywhere® Studio 的组件，因此 IQ 支持的许多功能与 Adaptive Server 
Anywhere 相同。IQ 文档集会在相应位置指向 SQL Anywhere Studio 文档。
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Adaptive Server Anywhere 的文档：

• 《Adaptive Server Anywhere 编程指南》

目标读者是编写用于直接访问 ODBC、 Embedded SQL™ 或 Open 
Client™ 接口的程序的应用程序开发人员，本书说明如何为 
Adaptive Server Anywhere 开发应用程序。

• 《Adaptive Server Anywhere 数据库管理指南》

目标读者是所有用户，本书涵盖运行、管理和配置数据库及数据库
服务器的相关资料。

• 《Adaptive Server Anywhere SQL 参考手册》

本书提供了关于 Adaptive Server Anywhere 所用 SQL 语言的全面参
考，还对 Adaptive Server Anywhere 系统表和过程进行了介绍，目标
读者为所有用户。

此外，还可以参见 Sybase Product Manuals Web 站点的 SQL Anywhere 
Studio 9.0.2 系列中的 Adaptive Server Anywhere 文档。要访问此站点，请
转至位于 http://www.sybase.com/support/manuals/ 的“Product Manuals”。

其它信息来源 使用 Sybase Getting Started CD、 SyBooks CD 和 Sybase Product Manuals
Web 站点可以了解有关产品的详细信息：

• Getting Started CD 包含 PDF 格式的发行公告和安装指南，也可能包
含 SyBooks CD 中未收纳的其它文档或更新信息。Getting Started CD 
随软件一起提供。要阅读或打印 Getting Started CD 上的文档，需要
使用 Adobe Acrobat Reader，该软件可以通过 CD 上提供的链接从 
Adobe Web 站点免费下载。

• SyBooks CD 含有产品手册，随软件提供。基于 Eclipse 的 SyBooks
浏览器使您能够阅读以基于 HTML 的简单易用格式编写的手册。

有些文档可能是以 PDF 格式提供的，您可以通过 SyBooks CD 上的
PDF 目录访问这些文档。要阅读或打印 PDF 文件，需要使用 Adobe
Acrobat Reader。

有关安装和启动 SyBooks 的说明，请参见 Getting Started CD 上的
《SyBooks 安装指南》或 SyBooks CD 上的 README.txt 文件。
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• Sybase Product Manuals Web 站点是 SyBooks CD 的联机版本，您可
以使用标准 Web 浏览器进行访问。除了产品手册之外，还可以找到
“EBFs/Maintenance”（EBF/维护）、“Technical Documents”（技术
文档）、“Case Management”（案例管理）、“Solved Cases”（解决
的案例）、“Newsgroups”（新闻组）和“Sybase Developer Network”
（Sybase 开发人员网络）的链接。

若要访问 Sybase Product Manuals Web 站点，请转至位于 
http://www.sybase.com/support/manuals/ 的 “Product Manuals”。

• Infocenter 是联机版本的 SyBooks，您可以使用标准 Web 浏览器进行
查看。若要访问 Infocenter Web 站点，请转至位于 
http://infocenter.sybase.com/help/index.jsp 的 “Sybooks Online Help”。

Web 上的 Sybase 
认证

Sybase Web 站点上的技术文档经常更新。

❖ 查找有关产品认证的最新信息 

1 将 Web 浏览器定位到位于 http://www.sybase.com/support/techdocs/ 的
“Technical Documents”。

2 单击 “Certification Report”（认证报告）。

3 在 “Certification Report”（认证报告）过滤器中选择相应的产品、
平台和时间范围，然后单击 “Go”（查找）。

4 单击 “Certification Report”（认证报告）标题以显示此报告。

❖ 查找有关组件认证的最新信息

1 将 Web 浏览器定位到位于 http://certification.sybase.com/ 的“Availability 
and Certification Reports”。

2 在“Search by Base Product”（按基本产品搜索）下面选择产品系列
和产品，或在“Search by Platform”（按平台搜索）下面选择平台和
产品。

3 选择 “Search”（搜索）以显示所选项目的可用性和认证报告。

❖ 创建 Sybase Web 站点（包括支持页）的个性化视图

设置 MySybase 配置文件。 MySybase 是一项免费服务，它允许您创建 
Sybase 网页的个性化视图。

1 将 Web 浏览器定位到位于 http://www.sybase.com/support/techdocs/ 的
“Technical Documents”。

2 单击 “MySybase”并创建 MySybase 配置文件。
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Sybase EBF 和软件
维护

❖ 查找有关 EBF 和软件维护的最新信息

1 将 Web 浏览器定位到位于 http://www.sybase.com/support 的“Sybase 
Support”页面。

2 选择“EBFs/Maintenance”（EBF/维护）。如果出现提示，请输入您
的 MySybase 用户名和口令。

3 选择产品。

4 指定时间范围并单击 “Go”（查找）。随即显示一个 EBF/维护版本
的列表。

挂锁图标表示您没有注册为“Technical Support Contact”（技术支持
联系人），因此您没有某些 EBF/维护版本的下载授权。如果您尚未
注册，但拥有 Sybase 代表提供的或通过支持合同获得的有效信息，
请单击 “Edit Roles”（编辑角色）将 “Technical Support Contact”
（技术支持联系人）角色添加到 MySybase 配置文件中。

5 单击“Info”（信息）图标显示“EBF/Maintenance”（EBF/维护）报
告，或者单击产品说明下载软件。

语法约定 本文档在语法说明中使用了以下语法约定：

• 关键字 SQL 关键字以大写字母显示。不过， SQL 关键字不区分
大小写，所以您在输入时可以不考虑大小写问题；输入 SELECT、
Select 和 select 的效果完全相同。

• 占位符 必须以相应的标识符或表达式替代的项显示为斜体。

• 续行符 以 ... 开头的行为上一行语句的继续。

• 重复项 重复项列表以相应列表元素后跟省略号（三点）的形式表
示。允许指定一个或多个列表元素。如果指定了多个元素，则必须
用逗号将它们隔开。

• 可选部分 语句的可选部分以中括号括起。例如：

RELEASE SAVEPOINT [ savepoint-name ] 

中括号表示 savepoint-name 是可选的。不可键入中括号。
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• 选项 如果在一个项列表中只能选择其中的一项或者都不选择，
这些项会以竖线分隔，且整个列表以中括号括起。例如：

[ ASC | DESC ]

中括号搭配竖线表示仅可选择 ASC 和 DESC 中的一项，或者都不选
择。不可键入中括号。

• 可选项 如果必须选择多个选项中的一个选项，这些可选项以大括
号括起。例如：

QUOTES { ON | OFF }

大括号搭配竖线表示必须仅提供 ON 或者 OFF。不可键入大括号。

排版约定 表 2 列出了本文档中采用的排版约定。

表 2： 排版约定

样本数据库 Sybase IQ 包含一个样本数据库，供 IQ 文档中许多示例使用。

样本数据库描述的是一家小型公司，包含该公司的内部信息（职员、部
门和财务数据）、产品信息 （产品）、销售信息 （销售订单、客户和联
系信息），以及财务信息 （fin_code、 fin_data）。

样本数据库存储在一个名为 asiqdemo.db 的文件中，该文件在 UNIX 系统
中位于 $ASDIR/demo 目录，在 Windows 系统中位于 %ASDIR%\demo 目录。

易用特点 此文档提供专门用于实现易用性的 HTML 版本。可以利用适应性技术
（如屏幕阅读器）浏览 HTML，也可以用屏幕放大器查看。

Sybase IQ 12.7 和 HTML 文档已经过了测试，符合美国政府 “第 508 条
易用性”的要求。符合第 508 条的文档一般也符合非美国的易用性原则，
如针对 Web 站点的 World Wide Web 协会 (W3C) 原则。

如需用于 Sybase Central 的 Sybase IQ 插件的易用性支持的相关信息，请
参见《Sybase IQ 简介》中的“使用易用特点”。本产品的联机帮助（可
使用屏幕阅读器进行浏览）也介绍了易用特点，包括 Sybase Central 键盘
快捷键。

项 说明

代码 SQL 和程序代码以 mono-spaced （固定宽度）字体显示。

用户输入 用户输入的文本以粗体 serif 字型显示。

强调 强调字以斜体显示。

文件名 文件名以斜体显示。

数据库对象 数据库对象（如表和过程）名在印刷版本中以粗体 san-serif
字型显示，在联机版本中以斜体显示。
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配置辅助工具
您可能需要对辅助工具进行配置以实现最优化。某些屏幕阅读器按照大
小写来辨别文本，例如将 “ALL UPPERCASE TEXT”看作首字母的缩
写，而将 “MixedCase Text”看作单词。您可能会发现按语法约定来配
置工具更为方便实用。请参考该工具的文档，并参见《Sybase IQ 简介》
中的 “使用屏幕阅读器”。

有关 Sybase 如何支持易用性的信息，请参见位于 
http://www.sybase.com/accessibility 的“Sybase Accessibility”。 Sybase 
Accessibility 站点包括有关 “第 508 条”和 W3C 标准的信息的链接。

有关 “第 508 条”中适用于 Sybase IQ 的合规性声明，请转至位于 
http://www.sybase.com/products/accessibility 的“Sybase Accessibility”。

如果需要帮助 对于购买了支持合同的每项 Sybase 安装，均指定了一位或多位人员负责
与 Sybase 技术支持部门联系。如果您通过手册或联机帮助不能解决问
题，请让指定的人员与您所在区域的 Sybase 技术支持部门或 Sybase 子
公司联系。
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第  1  章 运行数据库服务器

关于本章 本章介绍用于启动和停止 Sybase IQ 数据库服务器的实用程序及可
用启动开关。除了这些实用程序之外，还有另外几种启动和停止数
据库服务器的方法。有关启动和停止数据库服务器的方法及各方法
应何时使用的完整说明，请参见《Sybase IQ 系统管理指南》中的第
2 章 “运行 Sybase IQ”。

目录

启动数据库服务器
数据库启动实用程序 start_asiq 用于启动 Sybase IQ 网络数据库服
务器。

UNIX 版本的 Sybase IQ 提供的是脚本 start_asiq，而 Windows 版本的
IQ 提供的是 start_asiq.exe。这两个脚本将验证您环境的设置是否正
确并用预置为建议缺省值的所有所需开关 （以及您所添加的任何开
关）启动服务器。此外， start_asiq 还包含某些参数并对另外一些参
数进行计算。有关特定于操作系统的开关的详细信息，请参见
《Sybase IQ 安装和配置指南》。

注意  Sybase Central 中的启动数据库服务器实用程序提供了一种用
于启动服务器的简单图形界面，建议通过它来启动 IQ Multiplex 服
务器。有关详细信息，请参见《Sybase IQ 系统管理指南》中的第 2
章 “运行 Sybase IQ”。

语法 start_asiq -n server-name
[ server-switches ] [ database-file [ database-switches ] ]

主题 页码

启动数据库服务器 1
停止数据库服务器 28
对数据库服务器进行故障排除 32
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参数 下表列出了 start_asiq server-switches 和 database-switches 参数的可用开关。

您可以使用以下命令列出 start_asiq 开关

start_asiq -?

服务器开关 表 1-1： start_asiq 服务器开关

开关 说明

@filename 从配置文件中读取开关。

@envvar 从环境变量中读取开关。

-c cache-size 设置初始目录存储高速缓存大小。

-ca 0 禁用目录存储动态缓存大小。

-cc {+|-} 为高速缓存预热启用/禁用页收集。

-ch size 设置目录存储高速缓存大小上限。

-cl size 设置目录存储高速缓存大小下限 。
-cr {+|-} 启用/禁用高速缓存预热。

-cs 显示高速缓存大小调整统计信息。

-ct { + | - } 启用/禁用字符集转换 （缺省情况下为启用状态）。

-cv {+|-} 启用/禁用高速缓存预热状态消息。

-cw 在 Windows 2000、 Windows XP 和 Windows Server 2003 上
启用地址窗口化扩展插件，以设置数据库服务器高速缓存
的大小。

-ec encryption-
options

启用包加密 [网络服务器]。

-ek key-spec 当以参数形式提供密钥值时，启动加密数据库。

-ep (Windows) 显示一个对话框，提示您输入加密密钥以启动加密
数据库。从不允许以明文显示加密密钥，因而更加安全可靠。

-f 强制数据库在无事务日志的情况下启动。

-ga 将在最后一次连接断开之后自动卸载数据库。

-gb level 将数据库处理优先级类设置为 level [Windows]。
-gc num 将检查点超时周期设置为 num 分钟。

-gd level 设置启动和停止数据库所需的权限。

-ge size 设置运行外部函数的线程的堆栈大小 [Windows]。
-gf 禁止触发触发器。

-gk level 设置停止服务器所需的权限。

-gl level 设置装载数据所需的权限。

-gm level 限制可同时处于活动状态的服务器连接数。如果此数字大
于许可约束所允许的连接数，则此选项无效。此值应接近于
预期会连接到服务器的用户数。缺省连接数为 10。

-gn integer 设置多个用户同时运行时将用于目录存储和连接的执行线
程数。
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-gp size 将最大页大小设置为 size 字节。

-gr num 将最长恢复时间设置为 num 分钟。

-gu level 实用程序命令权限级别：utility_db、 all、 none、 dba。

-h 或 -? 显示使用信息；显示所有选项的列表。

-iqgovern num 指定并发查询数。

-iqlocalreplay
{ all | none | 
[ grants | 
procedures | 
views ] ...}

指定 IQ 服务器同步后，在从本地存储区重放 TLV 日志期间
重新创建的内容。缺省值为 -iqlocalreplay all。

-iqmc size 指定主高速缓存的大小（以 MB 为单位）。（覆盖缺省值。）

-iqmt num 指定 IQ 可在多线程系统上使用的线程数。缺省值为 
60*numCPU+2*num_conn+1。最小值为 2*num_conn+1。

-iqmpx_ov 1 仅用于启动 Multiplex 数据库。使用“覆盖”来启动服务器，
即承认写入服务器 (1) 在另一主机上启动， (2) 使用另一服
务器名称启动，或者 (3) 使用另一目录 (.db) 文件路径启动。
不要针对同一数据库启动两台写入服务器。

-iqmpx_sn 1 仅用于启动 Multiplex 数据库。针对某些类型的恢复，以单
节点运行模式启动写入服务器。

-iqnolocalreplay 1 在同步 Multiplex 后不重放 TLV 日志。

-iqnomain 1 在不打开共享 IQ 主存储区的情况下启动具有本地存储的查
询服务器。

-iqnotemp size 创建一个代替已定义临时数据库空间的临时文件。该开关
的参数以 MB （该开关的另一个参数）为单位指定该临时
文件的大小。

-iqnumbercpus 用可用于 IQ 的 CPU 数覆盖物理 CPU 数。

-iqpartition 指定主缓冲区高速缓存和临时缓冲区高速缓存中分区的
数量。

-iqro 以只读模式打开 IQ 主存储区或 IQ 本地存储区，不管 IQ 主存
储区或 IQ 本地存储区中数据库空间的状态如何均是如此。

-iqstart N 提供数据库空间的启动诊断信息。

-iqtc size 指定临时高速缓存的大小（以 MB 为单位）。（覆盖缺
省值。）

-iqtss size 指定线程堆栈的大小（以 KB 为单位）。

-iqwmem size 指定在 HP 和 Sun UNIX 平台中不能分页的特殊内存池的大
小（以 MB 为单位）。

-m 在检查点后截断事务日志。

开关 说明
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-n name 使用 name 作为数据库服务器的名称。

注意  有两个 -n 选项。-n 选项与位置有关。如果此选项出现
在数据库文件名之后，则具有不同的含义。请参见 “数据
库开关”（第 5 页）。

-o filename 将服务器消息输出到指定文件。

-oe filename 设置用于记录启动错误、致命错误和断言的文件的文件名。

-os 指定服务器消息文件的最大大小。

-p packet-size 设置最大网络包大小。

-qi 控制是否显示数据库服务器任务栏图标和窗口 [Windows]。
-qp 在数据库服务器窗口中不显示有关性能的消息。

-qs 取消启动错误对话框 [Windows]。
-qw 不显示数据库服务器屏幕。

-s 设置 syslog 工具 ID（none、user、daemon、local0 到 local7）
[UNIX]。

-sb {0 | 1} 指定服务器如何响应 TCP/IP 上的广播。

-startdir dirname 启动指定目录中的服务器。如果在 Windows 上使用此参数，
则 IQ 假定每台服务器是由 Sybase IQ 代理启动的，并且在后
台中启动服务器。

-ti min 服务器关闭之前的客户端空闲时间：缺省值为 4400 分钟。

-tl sec 缺省的客户端活动超时（以秒为单位），缺省值为 120 秒。

-tq time 设置退出时间。

-ud 作为守护程序运行 [UNIX] （不推荐；不用于 start_asiq）。

-ut min 每 min 分钟创建一次临时文件 [UNIX]。
-v  或 -v2 显示数据库服务器版本。

-x list 要尝试的以逗号分隔的通信链接列表。

-xs 指定服务器端 Web 服务通信协议。

-z 提供有关通信链接的诊断信息。

-zl 为服务器上的每个数据库连接捕获最近预准备的 SQL 语句。

-zo 指定用于记录服务器请求的文件。

-zr level 启用服务器请求级记录。

-zs integer | 
integerG | 
integerK | 
integerM }

指定用于记录服务器请求的文件的最大大小。

开关 说明
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如果启动服务器时遇到问题，则 start_asiq 会返回非零的值。如果在启动
时没有于 -o 开关后指定日志文件，则错误将写入以下最先定义的日志文
件中：

• $ASLOGDIR/<servername>.xxxx.srvlog

• $ASDIR/logfiles/<servername>.xxxx.srvlog

• $ASLOGDIR/start_asiq.log

• $ASDIR/logfiles/start_asiq.log

• 系统应用程序日志文件

数据库开关 表 1-2： start_asiq 数据库开关

Multiplex 选项 Sybase 建议使用 Sybase Central 界面启动和停止 Multiplex 数据库。如果
您无法运行 Sybase Central，或者需要从脚本启动 Multiplex 数据库，请
改用本节中介绍的启动命令。

启动或关闭操作需要使用多个命令：

• start_asiq 命令，用于启动相应服务器。

• 一个或多个 dbremote 命令，用于控制写入服务器与查询服务器之间
的通信。 dbremote 始终在写入服务器主机上运行。

• dbstop 或 stop_asiq 命令，用于停止服务器。

可以指定 start_asiq 命令行的以下 Multiplex 开关来管理 Multiplex 数据库。

注意  如果使用不当，这些开关可能会导致故障。在使用 Multiplex 启动
开关之前，请务必仔细阅读以下说明。

开关 说明

-m 在检查点后截断事务日志

-n name 命名数据库

注意  有两个 -n 开关。 -n 开关与位置有关。如果此开关
出现在数据库文件名之后，则该开关是数据库开关。否
则，该开关是服务器开关。
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表 1-3： start_asiq Multiplex 开关

若要获取有关 dbremote 选项的帮助，请键入以下命令：

dbremote -h

表 1-4 列出了在运行 IQ Multiplex 服务器时建议使用的 dbremote 开关。

表 1-4： 推荐的用于 Multiplex 服务器的 dbremote 开关

Sybase 在写入服务器数据库目录中提供 shell 脚本，以便针对 Multiplex 的
每个服务器启动 dbremote。目前没有用于自动启动这些进程的服务机制；
这是由用户决定的。例如，在 Windows 系统中，DBA 可以在 Windows 注
册表中添加相应条目，以便在 DBA 登录到该系统时立即启动这些进程。
请注意，只有数据复制才需要 dbremote ；如果没有 dbremote，服务器仍然
可以运行。在运行 dbremote 时，将不会在写入服务器上恢复旧数据版本。

Multiplex 启动示例 下面的示例将启动 Multiplex 服务器 Server02。如果此服务器事先已配置
为查询服务器，则它将自动显示为查询服务器。

start_asiq @params.cfg -n Server02 
-x "tcpip(port=1234)" mpxdb.db

然后，在写入服务器的主机上输入以下命令：

dbremote -c 
"uid=DBA;pwd=SQL;eng=Server02;links=tcpip{host=ciaran;
port=1234};dbf=mpxdb"
-v -o outfile.out

若要获取启动和 dbremote 命令的更多示例，请按照 《Sybase IQ 系统管
理指南》中的说明生成管理脚本。使用文本编辑器可以查看这些脚本中
的命令。

开关 说明

-iqmpx_ov 1 仅用于启动 Multiplex 数据库。使用“覆盖”来启
动服务器，即承认写入服务器 (1) 在另一主机上启
动， (2) 使用另一服务器名称启动，或者 (3) 使用
另一目录 (.db) 文件路径启动。不要针对同一数据
库启动两台写入服务器。

-iqmpx_sn 1 仅用于启动 Multiplex 数据库。针对某些类型的恢
复，以单节点运行模式启动写入服务器。当写入服
务器处于单节点模式时，查询服务器将无法运行。

开关 说明

-o output_filename 指定输出文件

-q 以最小化方式运行

-v 指定详细输出
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无论是启动查询服务器还是写入服务器，都应始终在写入服务器的主机
上运行 dbremote。您可以自定义用于运行 dbremote 的管理脚本。有关详
细信息，请参见《Sybase IQ 系统管理指南》第 5 章“使用数据库对象”
中的 “使用管理 Shell 脚本”。

在 Windows 系统上，将会显示 SQL Remote 屏幕。可以将此屏幕最小化。

恢复开关 start_asiq recovery-options 仅是一部分数据库开关，仅用于数据库恢复操作。

表 1-5： start_asiq 恢复开关

用法 -n server-name 指定数据库服务器的名称。

database-file 指定数据库文件名。如果指定的 database-file 没有文件扩
展名，则 Sybase IQ 会查找扩展名为 .db 的 database-file。

如果使用相对路径，则相对于服务器的当前工作目录读取路径。您可以
提供完整路径。

在 Windows 上，可以提供符合通用命名约定 (UNC) 格式的路径：

\\server\volume\path\file.ext

警告！数据库文件必须与数据库服务器位于同一台计算机上。管理位于
网络驱动器上的数据库文件可能导致文件损坏。

服务器命令行开关 @filename 从所提供的文件中读取命令行开关。

该文件可以包含换行符，并且可以包含任何命令行开关集。例如，下面
的 Windows 命令文件保存一组用于名为 myserver 的服务器的命令行开
关，该服务器允许使用 15 个连接，将最大目录页大小设置为 4MB 并装
载样本数据库：

-gm 15
-gp 4096
-n myserver
c:\sybase\ASIQ-12_7\demo\asiqdemo.db

如果此配置文件保存为 c:\config.txt，则可将其用于命令行，如下所示：

start_asiq @c:\config.txt

开关 说明

-iqdroplks 
dbname

允许 sp_iqcheckdb 存储过程恢复指定的数据库内泄露的
存储。

-iqfrec dbname 将指定数据库标记为“正在使用”，并将该数据库恢复
到其上次已知的一致状态。
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@environment-variable 从所提供的环境变量中读取命令行开关。该
环境变量可以包含任何命令行开关集。例如，在下面的一对 Windows 语
句中，第一个语句设置一个包含一组命令行开关的环境变量，并装载样
本数据库。第二个语句用于启动数据库服务器：

set envvar= “-gp 4096 -gm 15” 
c:\sybase\ASIQ-12_7\demo\asiqdemo.db start_asiq 
@envvar

注意  如果文件和环境变量中都包含 @ 命令行开关值，则会产生不可预
料的结果。仅使用上述方法中的一种方法设置给定的 @ 命令行开关。

-c cache-size 为高速缓存目录存储页和其它服务器信息设置保留初
始内存。如果在高速缓存中留出了内存，则数据库服务器会使用额外内
存对数据库页进行高速缓存。假定任何小于 10000 的高速缓存大小都以
KB 为单位（1K = 1024 字节）。假定任何等于或大于 10000 的高速缓存
大小都以字节为单位。此外，还可以以 nK、nM 或 nP (1M = 1024 KB) 为
单位指定高速缓存大小。

对于 Windows 平台，default.cfg 文件和 start_asiq 中 -c 的缺省值为 32MB
(-c 32M) ；对于 UNIX 平台，该缺省值则为 48MB (-c 48M)。对于 IQ 数据
库， Sybase 建议使用此缺省值或者将 -c 设置为更高的值。

单位 P 是物理系统内存的百分比。您可以使用 % 来代替 P，但由于大多
数非 UNIX 操作系统使用 % 作为环境变量转义字符，因此必须转义 % 字
符。例如，要使用 20% 的物理系统内存，需要指定：

start_asiq -c 20%% ...

在 UNIX 操作系统中，如果用 -c 指定的高速缓存大小超出了可用内存
量，数据库服务器将使用按以下方式计算出的最大高速缓存大小：

如果未提供 -c 开关（在命令行中或使用缺省的 start_asiq），则数据库服
务器将按以下方式计算初始目录存储高速缓存分配：

1 数据库服务器使用 32MB 作为缺省高速缓存大小的最小值。

2 数据库服务器计算运行期特定的最小缺省高速缓存大小，该数值为
以下各项中的较小者：

• 25% 的计算机物理内存

• 命令行中指定的主数据库文件大小的总和。计算时不包括主数据
库文件以外的其它 dbspace。如果没有指定文件，则该值为零。



第 1 章    运行数据库服务器

实用程序指南 9

3 数据库服务器分配这两个计算值中的较大者。

不得将 -c 和 -ch 或 -cl 用于同一配置文件或命令行中。若要获取相关信
息，请参见 -ch cache-size 选项。

另请参见 -ca 0 选项。

-ca 0 强制实施静态目录高速缓存大小。需要零参数。

通常，数据库服务器会根据需要自动使用附加的高速缓存。通过在命令
行中使用 -ca 0，可以禁止因较高服务器负载而自动增加高速缓存这一行
为。高速缓存大小仍将增加，除非数据库服务器运行时发生以下错误 

Fatal Error: dynamic memory exhausted 

或者 Java VM 需要使用可导致致命错误的内存，否则高速缓存大小仍会
增加。

-ch cache-size 限制数据库服务器在高速缓存自动增长期间可使用的目
录存储高速缓存大小。缺省情况下，上限大约为 256MB 或计算机物理内
存的 90% （取二者中较低者）。

和 -c  选项一样，使用字符 K、 M 和 P 指定高速缓存大小。有关高速缓
存大小参数以及字符 K、 M 和 P 的含义和使用方法，请参见 -c cache-
size。

例如，在某些情况下，标准目录高速缓存大小可能太小，无法适合某些
需要很多分析的查询。在这类情况下，设置 -cl 和 -ch 也许能有所帮助。
例如，在 32 位平台上，尝试这些设置

-cl 128M
-ch 256M

警告！若要显式控制目录存储的高速缓存大小，必须在配置文件 (.cfg) 中
或服务器启动的 UNIX 命令行上执行以下操作之一（但不要两项操作都
执行）：

• 设置 -c 参数 

• 使用 -ch 和 -cl 参数为目录存储高速缓存大小设置具体上限和下限

如不按上述说明指定参数组合，则可能产生意外结果。

-cl cache-size 设置目录存储高速缓存在高速缓存自动增长期间的下
限。缺省情况下，该下限为初始高速缓存的大小。

可用于目录存储的高速缓存内存量可能会影响性能，尤其是有许多用户
连接时更是如此。和 -c  选项一样，使用字符 K、M 和 P 指定高速缓存大
小。有关高速缓存大小参数以及字符 K、M 和 P 的含义和使用方法，请
参见 -c cache-size。
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-ct { + | - } 缺省情况下，开启字符集转换。字符集转换在表示相同字符
但使用不同值的字符集之间转换字符串。这在客户端计算机和数据库使
用不同字符集时非常有用。若要禁用字符集转换，请指定 -ct-。若要启用
字符集转换，请指定 -ct+。

在 12.6 之前的版本中，不接受 + 或 - 值：通过指定 -ct 选项来启用字符集
转换。

有关详细信息，请参见《Sybase IQ 系统管理指南》的第 11 章“国际语
言和字符集”。

-cw 在 Windows 2000、Windows XP 和 Windows Server 2003 上启用地址
窗口化扩展插件 (AWE)，以设置目录存储高速缓存的大小。

由于 Windows 2000、 Windows XP 和 Windows Server 2003 支持地址窗口
化扩展插件，因此您可以使用 -cw 选项来利用基于系统中最大物理内存量
的大容量高速缓存。但请记住，目录存储高速缓存的大小对 IQ 数据库性
能的影响要比 IQ 主缓冲区高速缓存和 IQ 临时缓冲区高速缓存小得多。

*必须使用 /3GB 选项来引导操作系统，才能使用此容量的高速缓存。

使用 AWE 高速缓存时，系统中几乎所有可用的物理内存都可分配给高
速缓存。

操作系统
非 AWE 的最大高
速缓存大小

Windows 支持的最大
物理内存

Windows 2000 
Professional

1.8 GB 4 GB

Windows 2000 Server 1.8 GB* 4 GB
Windows 2000 
Advanced Server

2.7 GB* 8 GB

Windows 2000 
Datacenter Server

2.7 GB* 64 GB

Windows XP Home 
Edition

1.8 GB 2 GB

Windows XP 
Professional

1.8 GB 4 GB

Windows Server 2003，
Web Edition

1.8 GB 2 GB

Windows Server 2003，
Standard Edition

1.8 GB 4 GB

Windows Server 2003，
Enterprise Edition

2.7 GB* 32 GB

Windows Server 2003，
Datacenter Edition

2.7 GB* 64 GB
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如果可以使用非 AWE 高速缓存设置所需大小的目录存储高速缓存，建
议您使用此方法，因为 AWE 高速缓存分配的内存只能供目录存储使用。
这意味着在数据库服务器运行时，操作系统和 IQ 存储高速缓存不能使
用为目录存储高速缓存分配的内存。

AWE 高速缓存不支持动态调整高速缓存大小。因此，如果使用 AWE 高
速缓存，并且指定 -ch 或 -cl 选项来设置高速缓存大小的上限和下限，则
这些设置将被忽略。

要使用 AWE 高速缓存启动数据库服务器，必须执行以下步骤：

• 系统中至少有 130MB 的可用内存。

• 如果系统内存介于 2 GB 和 16 GB 之间，请将 /3GB 选项添加到 
boot.ini 文件中 “[operating systems]”部分的 Windows 引导行中。

如果系统内存大于16 GB，则不要将 /3GB 选项添加到 boot.ini 文件中
“[operating systems]”部分的 Windows 引导行中，因为 Windows 不能
处理超出 16GB 的内存。

• 如果系统内存大于4 GB，请将 /PAE 选项添加到 boot.ini 文件中
“[operating systems]”部分的 Windows 引导行中。

• 为用于运行服务器的用户 ID 授予“内存中锁定页”特权。以下步骤
说明如何在 Windows 2000 中执行此操作。

a 以 Administrator 身份登录到 Windows。

b 在 “开始”菜单中，选择 “设置” > “控制面板”。

c 打开 “管理工具”文件夹。

d 双击 “本地安全策略”。

e 打开左窗格中的 “本地策略”。

f 双击左窗格中的 “用户权利指派”。

g 双击右窗格中的 “内存中锁定页”策略。

此时将显示 “本地安全策略设置”对话框。

h 在 “本地安全策略设置”对话框中单击 “添加”。

此时将显示 “选择用户或组”对话框。

i 从列表中选择用户 ID，并单击 “添加”。

j 在 “本地安全策略设置”对话框中，单击 “确定”。

k 重新启动计算机使设置生效。
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如果在命令行中指定 -cw 选项和 -c 选项，则数据库服务器将尝试按以下
步骤分配初始高速缓存：

1 AWE 高速缓存不大于 -c 选项指定的高速缓存大小。如果 -c 选项指
定的值小于 2MB，则不使用 AWE。

2 AWE 高速缓存不大于所有可用物理内存减去 128MB 的差。

3 AWE 高速缓存不小于 2MB。如果无此最小物理内存量可用，则不使
用 AWE 高速缓存。

当指定 -cw 选项而不指定 -c 选项时，数据库服务器将尝试按以下步骤分
配初始高速缓存：

1 除保留 128MB 内存用于操作系统外，AWE 高速缓存可使用 100% 的
（全部）可用内存。

2 AWE 高速缓存不大于在命令行中指定的主数据库文件大小的总和。
计算时不包括主数据库文件以外的其它 dbspace。如果没有指定文
件，则该值为零。

3 AWE 高速缓存不小于 2MB。如果无此最小物理内存量可用，则不使
用 AWE 高速缓存。

当服务器使用 AWE 高速缓存时，目录高速缓存页大小至少为 4 KB，且
禁用动态调整高速缓存大小。

有关动态调整高速缓存大小的详细信息，请参见 -ch 和 -cl 服务器选项。

-ec 使用传输层安全性或简单加密技术对来/往于所有客户端的所有 
Sybase IQ 本机包 （DBLib、 ODBC 和 OLE DB）进行加密。不加密 
TDS 包。

-ec encryption-options …

encryption-options:

{ NONE | SIMPLE | ECC_TLS (CERTIFICATE=filename; 
CERTIFICATE_PASSWORD=password ) 
| RSA_TLS (CERTIFICATE=filename; 
CERTIFICATE_PASSWORD=password )
| RSA_TLS_FIPS (CERTIFICATE=filename;
CERTIFICATE_PASSWORD=password ) 
| ALL } , …
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-ec 选项指示数据库服务器只接受与 ODBC、 OLE DB 或嵌入式 SQL 接
口的连接，这些连接使用以下指定类型之一进行加密。无论其是否加
密，将始终接受通过 TDS 协议建立的连接，包括使用 jConnect 的 Java 应
用程序。

缺省情况下，通信包是不加密的，这样就存在潜在的安全风险。如果您
注意网络包的安全性，则可以使用 -ec 选项。加密对于性能只有很轻微
的影响。-ec 选项用于控制服务器的加密设置，并需要使用位于逗号分隔
列表中的以下一个或多个参数：

• none – 只接受未加密的连接。

• simple – 接受使用简单加密技术进行加密的连接。所有平台都支持这
种加密类型。简单加密的安全性不如 Certicom 加密高。

• ECC_TLS – 接受使用基于椭圆曲线的 Certicom 加密技术进行加密的
连接。要使用该加密类型，服务器和客户端必须都运行于 Solaris、
Linux 或任何支持的 Windows 平台，并且该连接必须通过 TCP/IP 端
口。除 Solaris 和 Linux 外， UNIX 平台不识别客户端或服务器的
ECC_TLS 参数。为了实现向后兼容，还可以将 ECC_TLS 指定为
CERTICOM。该参数接受下列参数：

• certificate – 服务器证书的文件名。这是包含服务器私有密钥的服
务器证书。此服务器证书可以是自签名证书，也可以是由企业根
证书或证书发放机构签名的证书。缺省值为 sample.crt。

• certificate_password – 服务器证书私有密钥的口令。要使用 
ECC_TLS，必须使用 ECC 密码生成证书。 sample.crt 的口令是 
tJ1#m6+W。

• RSA_TLS – 接受使用基于 RSA 的加密技术进行加密的连接。要使用
该加密类型，服务器和客户端必须都运行于 Solaris、Linux、AIX 或
任何支持的 Windows 平台，并且该连接必须通过 TCP/IP 端口。该参
数接受下列参数：

• certificate – 证书的文件名。缺省值为 rsaserver.crt。

• certificate_password – 以上指定证书的口令。 rsaserver.crt 的口令
是 test。

警告！示例证书仅可用于测试目的。示例证书无法为所部署的环境
提供安全性，因为该证书和其相应的口令已通过 Sybase 软件广泛分
发。要保护您的系统，必须创建自己的证书。
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• RSA_TLS_FIPS – 接受使用 FIPS 认可的 RSA 加密技术进行加密的连
接。RSA_TLS_FIPS 使用单独认可的库，但与使用 Sybase IQ 12.7 或
更高版本指定 RSA_TLS 的客户端兼容。要使用该加密类型，服务器
和客户端必须都运行于支持的 32 位 Windows 操作系统，并且该连接
必须通过 TCP/IP 端口。该参数接受下列参数：

• certificate – 证书的文件名。缺省值为 rsaserver.crt。

• certificate_password – 以上指定证书的口令。

如果使用 FIPS 认可的 RSA 加密，必须使用 RSA 密码生成证书。

dbtls9.dll 和 dbrsa9.dll 文件包含用于加密和解密的 Certicom 和 RSA 代
码。当连接到服务器时，如果找不到合适的文件，或发生错误，在调试
模式下会在服务器控制台上显示一条消息。如果无法启动指定的加密类
型，则该服务器不启动。

客户端和服务器的加密设置必须匹配，否则连接将失败。如果指定了 -ec
simple 而没有指定 -ec none，则不请求加密的连接可以连接并自动使用简
单加密技术。

下面的示例显示了用椭圆曲线服务器证书 sample.crt 启动服务器：

start_asiq -ec ecc_tls(certificate=sample.crt; 
certificate_password=tJ1#m6+W) -x tcpip asiqdemo.db

下面的示例用 RSA 服务器证书 rsaserver.crt 启动服务器：

start_asiq -ec rsa_tls(certificate=rsaserver.crt; 
certificate_password=test) -x tcpip asiqdemo.db

下面的示例用 RSA 服务器证书 rsaserver.crt 启动服务器。 rsa_tls_fips 参
数指定 FIPS 认可的 RSA 算法：

start_asiq -ec rsa_tls_fips(certificate=rsaserver.crt; 
certificate_password=test) -x tcpip asiqdemo.db

有关详细信息，请参见《Sybase IQ 系统管理指南》中的 “Encryption 
连接参数 [ENC]”。

-ek 在强加密数据库的文件名之后提供。必须以参数形式提供密钥
值，才能启动加密数据库。密钥值是一个字符串，包括混合的大小写、
数字、字母和特殊字符。如果您有一个强加密数据库，则必须提供加密
密钥，才能以任意方式使用数据库或事务日志。对于强加密数据库，必
须指定 -ek 或 -ep，但是不能同时指定二者。如果您没有为强加密数据库
指定密钥，则该命令将失败。
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-ep (Windows) 显示一个对话框，提示用户输入用于运行强加密数据
库的加密密钥。此选项从不允许以明文显示加密密钥，因而更加安全可
靠。对于强加密数据库，必须指定 -ep 或 -ek，但是不能同时指定二者。
如果您没有为强加密数据库指定密钥，则该命令将失败。

该引擎要么不能为 Windows 服务，要么为一项开启了与桌面交互选项的
Windows 服务。

此选项与支持的工具一起使用时，即使在不需要密钥的情况下，也总是
提示用户输入加密密钥。当显示对话框提示时，如果您知道不需要密
钥，可单击 “取消”继续。

-ga 如果在网络服务器上指定此选项，则会导致在删除了与各个数据
库的最后一次连接之后卸载这些数据库。数据库服务器本身不会关闭。

-gb level (Windows) 将数据库处理优先级类设置为 level。 Level 必须
为 idle、 normal （缺省值）、 high 或 maximum 之一。值 idle 是出于完整
性考虑而提供的，而 maximum 可能会影响计算机的运行。常用设置为 
normal 和 high。

-gc num 设置数据库服务器在不对各数据库执行检查点操作的情况
下所运行的最大分钟数。缺省值为 20 分钟。

-gd level 设置在服务器上启动数据库或停止数据库所需的权限级别：

• DBA 只有拥有 DBA 授权的用户才能启动或停止数据库。

• ALL 所有用户都可以启动或停止数据库（start_asiq 和 default.cfg 中
的缺省值）。使用此设置时，DBA 无需发出 START DATABASE 命令。
（请注意，在用户启动数据库后，仍需具备相应权限才能访问它。） 

• NONE 不允许从 Interactive SQL 启动数据库。（通过在 UNIX 上运行
stop_asiq 或在 Windows 上运行 Shutdown，仍可停止服务器和数据库。）

语法不区分大小写。

-ge size (Windows) 设置运行外部函数的线程的堆栈大小，以字节为
单位。缺省值为 16384 (16KB)。
-gk level 设置停止数据库服务器所需的权限级别：

• DBA 只有拥有 DBA 授权的用户才能使用 dbstop 停止服务器 （缺
省值）。

• ALL 所有用户都可以使用 dbstop 停止服务器。

• NONE 不能使用 dbstop 停止服务器。

语法不区分大小写。
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-gl level 设置使用 LOAD TABLE 装载数据所需的权限。

LOAD TABLE 语句从数据库服务器计算机中读取文件。

要控制使用这些语句对文件系统的访问，可使用 -gl 命令行开关来控制使
用这些语句所需的数据库权限级别。

可用值如下：

• DBA 只有拥有 DBA 授权的用户才能装载数据。

• ALL 所有用户都可以装载数据。

• NONE 不能装载数据。

语法不区分大小写。

对于用 start_asiq 启动的服务器，缺省设置为 all ；而对于其它服务器，缺
省设置为 dba。为了与早期版本保持一致， Sybase 建议所有系统均使用
设置 all。在 asiqdemo.cfg 和 default.cfg 配置文件中使用 all 设置。有关这
些配置文件的详细信息，请参见 《Sybase IQ 系统管理指南》的第 2 章
“运行 Sybase IQ”中的表 2-1。
-gm num 限制可同时处于活动状态的服务器的连接数。如果此数字
大于许可和内存约束所允许的数，则此开关无效。缺省值因计算机容量
而异，但建议缺省值为 15。此值应接近于预期会连接到服务器的用户数。

数据库服务器允许在连接限制之上建立一个额外的 DBA 连接，以便允
许 DBA 在出现紧急情况时连接到服务器并删除其它连接。

-gn num 设置多个用户同时运行时将用于目录存储和连接的执行线
程数。此参数适用于所有操作系统和服务器。

每个连接对每个请求使用一个线程，当请求完成后，该线程返回到池中
供其它连接使用。由于连接每次只能执行一个请求，因此没有连接能够
一次使用多个线程。

Java 应用程序可使用多个线程，是此规则的一个例外。 Java 应用程序中
的每个线程都是一个数据库服务器执行线程。

在 Windows 上，需要使用 start_asiq 命令指定此参数。要计算其值，请使
用以下公式：

gn_value = gm_value + 5

指定最小值 25。线程总数 (-iqmt 与 -gn 相加之和 ) 不得超过特定于平台的
最大值；有关详细信息，请参见 “-iqmt num”（第 18 页）。

此参数由 start_asiq 实用程序设置。有关详细信息，请参见适用于所用平
台的 《Sybase IQ 安装和配置指南》。
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-gp size 设置目录存储允许的最大页大小，以字节为单位。指定的大
小必须为 1024、2048、4096、8192、16384 或 32768。所有 UNIX 平台上
的最小页大小均为 2048 字节。 Sybase 强烈建议将 -gp 开关设置为 4096。
-gr num 设置数据库服务器从系统故障中恢复所需的最长时间（以分
钟为单位）。

有关详细信息，请参见 《Sybase IQ 参考手册》第 2 章 “数据库选项”
中的 “RECOVERY_TIME 选项”。

-gu level 设置诸如 CREATE DATABASE 和 DROP DATABASE 之类命令
的权限级别。可以将级别设置为以下值之一：utility_db、all、none、dba。

utility_db 级别将这些命令限制为只能供那些可以连接到实用程序数据库
的用户使用。 all 和 dba 级别分别允许所有用户和拥有 DBA 授权的已连
接用户执行实用程序命令，而 none 级别则不允许任何用户执行实用程序
命令。

要连接到实用程序数据库，必须将 utility_db 指定为该数据库名称（即没
有数据库文件），并且必须知道该实用程序数据库的口令 （存储于文件
util_db.ini 中）。

-h 显示用法信息。如果指定任何无效开关（如 -help），则 Sybase IQ
也会显示用法信息。

-iqgovern num 设置服务器允许的并发查询数。并发查询数与连接数
不同。此开关可帮助 Sybase IQ 优化将缓冲区数据分页调度到磁盘上，避
免过量使用内存。此开关的缺省值等于计算机上的 CPU 数乘 2 再加上
10。您可能会发现其它值（如 CPU 数乘 2 再加上 4）提供了更好的吞吐
量，尤其是有许多用户连接时更是如此。

-iqlocalreplay { all | none | [ grants | procedures | views | userandpwd ] ... }
指定查询服务器同步后，在从 IQ 本地存储区重放 TLV 日志期间在查询服
务器上重新构建的内容。IQ 表和用户定义的数据类型必须始终启用重放。

可用值如下：

• all 该日志重放所有 DDL 命令。

• none 该日志不重放任何 DDL 命令。

• grants 该日志重放 GRANT 和 REVOKE 命令，从而反映用户名、
组和权限的更改。

• procedures 该日志重放影响存储过程和函数的操作，其中包括用
户消息。

• views 该日志重放影响视图的操作。

• userandpwd 该日志按以下步骤重放操作：

• 添加查询服务器上新增的所有用户

• 覆盖查询服务器上发生更改的所有写入服务器用户口令
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缺省情况下，该日志按如下所示重放操作：

• 所有新查询服务器用户可能是也可能不是用 NO 口令添加的。

• 保护写入服务器用户口令，使其不被查询服务器覆盖。

例如，

-iqlocalreplay "all" 

此示例在服务器刚同步后，就从本地 TLV 日志重放所有 DDL 命令。

-iqmc size 指定 IQ 主存储区高速缓存大小（以 MB 为单位 )。用于覆盖
缺省值 16MB 或由 MAIN_CACHE_MEMORY_MB 数据库开关设置的值（如
果有）。将应用到从 IQ 服务器启动到 IQ 服务器关闭的这段时间内所启
动的所有数据库。换句话说，如果在服务器启动时启动一个数据库而稍
后又启动另一个数据库，则需要有 2 * -iqmc 的容量才能供主高速缓存使
用。一般而言，Sybase 不建议将一个 Sybase IQ 服务器与多个数据库一起
运行。

-iqmpx_ov 1 仅用于启动 Multiplex 数据库。使用 “覆盖”来启动服务
器，即承认写入服务器 (1) 在另一主机上启动， (2) 使用另一服务器名称
启动，或者 (3) 使用另一目录 (.db) 文件路径启动。不要针对同一数据库
启动两台写入服务器。有关使用此参数的详细信息，请参见“Multiplex
选项”（第 5 页）。

-iqmpx_sn 1 仅可与 Multiplex 数据库一起使用。针对某些类型的恢复，
以单节点运行模式启动写入服务器。不用于启动查询服务器。

-iqmt num 指定要创建的 Sybase IQ 线程数。缺省值为：60 乘 CPU 
数 （对于前四个 CPU）加 50 乘 CPU 数 （对于其余 CPU）再加连接
线程数。例如，在具有 12 个 CPU 和 10 个连接的系统上，缺省值为 
60*4 + 50*(numCPUs - 4) + 2*(numConnections + 2) + 1 = 665。
最小值为 2*num_conn+1。在 64 位平台上，线程总数 （-iqmt 与 -gn 相加
之和）不得超过 4096 ；而在 32 位平台上，线程总数则不得超过 2048。
缺省的 -iqtss 设置应足以支持这些最大线程数。

-iqnolocalreplay 仅可与 Multiplex 数据库一起使用。在同步 Multiplex 后
不重放 TLV 日志。

-iqnumbercpus num 指定可用于 IQ 的 CPU 数，从而覆盖用于资源规划
用途的实际 CPU 数。该参数的缺省值为 CPU 的总数，但可用值范围为
1 到 128。

Sybase 建议仅在以下情况下使用 -iqnumbercpus：

• 在配有 Intel® CPU 且已启用超线程的计算机上，可将 -iqnumbercpus
设置为可用的 CPU 数

• 在已使用操作系统实用程序将 Sybase IQ 限制为仅可使用其内 CPU 子
集的计算机上
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将 -iqnumbercpus 设置为大于可用 CPU 数的值可能会影响性能。

-iqpartition 指定 IQ 主缓冲区高速缓存和 IQ 临时缓冲区高速缓存中分
区的数量。该数字必须为 2 的次方。可用值包括：0（缺省值）、1、2、
4、8、16、32、64。缺省情况下，IQ 自动按 number_of_cpus/8 计算该分
区数，计算结果将舍入到最近的 2 次方，最大值为 64。通过调整高速缓
存分区数，也许可以提高性能。-iqpartition 开关为 IQ 服务器设置该值，并
覆盖 Cache_Partitions 数据库选项所设置的值。要为特定的数据库设置分
区数，请使用 Cache_Partitions 数据库选项。有关是否应设置这些选项之
一以及影响它们的因素的详细信息，请参见《Sybase IQ 参考手册》的第
2 章 “数据库选项”中的 “CACHE_PARTITIONS 选项” ，以及参见
《Sybase IQ 系统管理指南》的第 10 章“事务和版本控制”中的“管理
锁争用”。

-iqro dbspace-name 以只读模式打开 IQ 主存储区或 IQ 本地存储区，无
论 IQ 主存储区或 IQ 本地存储区中数据库空间的状态如何均是如此。

-iqstart N 提供数据库空间的启动诊断信息。输入参数 N 是一个表示整
数位掩码的数值。您可以将这些值组合起来，从而提供多个功能。在生
成 IQ 消息文件之前生成的输出将显示在控制台中。 -z 启动开关提供其
它启动和连接信息。

可用值如下：

• N=1 从在打开数据库空间时使用的 SYSIQFILES 返回有关文件名
的基本信息。然后显示所使用的完全限定名。可以使用此选项在 IQ
消息文件中创建数据库正在使用的文件的记录。

• N=2 在执行 RecoveryComplete 之前重放事务日志之后停止。这使您无
需一直打开数据库就可对其进行检查。此选项可以与其它选项组合在
一起使用。请注意，在某些模式中，它可能会重写 commit_identity，但
不会永久修改数据库，因为系统不允许执行提交恢复操作的检查点。
在下次打开数据库时，所有恢复操作都将重新执行。

• N=4 返回完整的诊断信息，其中包括 SYSIQFILE 的所有行、所选文
件名的子集（如果数据库是 Multiplex 数据库）、完全解析文件名、每
个单独的数据库空间文件标头块、database_identity、commit_identity、
每个检查点日志条目以及每个事务日志条目。

• N=8 允许覆盖 SYSIQFILE 中的文件路径。将使用文件名 iqmsg.iqmsg、
iqmain_1、iqmain_2...、iqtemp_1、iqtemp_2...、iqlocal_1、iqlocal_2... 依
此类推，而不是 SYSIQFILE 值。这些文件名可以是链接形式，但必须
与 .db 文件位于同一目录中。您可以使用指向实际 .db 文件的链接，但
应注意，如果为服务器提供的链接指向使用相对于数据库的事务日志
的 .db 文件，则服务器将查找相对于该链接而不是数据库的事务日志。
在这种情况下，也会为事务日志创建链接。
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-iqtc size 指定 IQ 临时存储区高速缓存大小（以 MB 为单位 )。用于覆
盖缺省值 8MB 或由 TEMP_CACHE_MEMORY_MB 数据库选项设置的值
（如果有）。将应用到从 IQ 服务器启动到 IQ 服务器关闭的这段时间内所
启动的所有数据库。换句话说，如果在服务器启动时启动一个数据库而
稍后又启动另一个数据库，则需要有 2 * -iqtc 的容量才能供临时高速缓存
使用。一般而言，Sybase 不建议将一个 Sybase IQ 服务器与多个数据库一
起运行。

-iqtss size 设置服务器中内部执行线程的堆栈大小。对于 32 位平台，
缺省值为 200KB ；对于 64 位平台，缺省值为 512KB，该值也是推荐值。
但有些非常复杂的查询可能会返回一个错误，指出堆栈深度超出了此限
制，因此 DBA 可能需要增加该值。在 32 位平台上，最佳设置取决于可
用内存、 CPU 数、连接数及运行的查询类型。在 64 位平台上，使用值
1000 是比较合理的，因为 64 位系统的内存限制不像 32 位系统那样严格。
不要选择小于缺省值的值，否则您可能会发现有些查询无法运行。

-iqwmem size 在 HP 和 Sun UNIX 系统上创建“连系”内存池。此内
存处于锁定状态，因此操作系统不能对其进行分页。指定内存大小（以
MB 为单位）。仅当有足够内存可专用于此用途时，才应使用此开关。否
则，可能导致性能大幅下降。

-m 当检查点操作完成后删除事务日志（可能在关闭时，或者由于服
务器调度的检查点所致）。该选项提供了自动限制事务日志增大的方法。
检查点频率仍由 CHECKPOINT_TIME 和 RECOVERY_TIME 选项控制（也可
在命令行设置）。

在执行需要快速响应的大容量事务，且事务日志的内容与恢复或复制无
关的情况下， -m 服务器开关非常有用。

警告！当选择 -m 服务器开关时，不会防备包含数据库文件的设备出现介
质故障。

为了避免出现数据库文件碎片，建议您在使用该选项时，将事务日志存
放在与数据库本身不同的单独设备或分区上。

如果用 -m 开关启动服务器，则不能创建数据库。

注意  不要对正在复制的数据库使用 -m 开关，因为复制本身会依赖于事
务日志信息。因此，切勿对 Multiplex 数据库使用 -m 开关。

有关使用 -m 开关截断事务日志文件的信息，请参见 《Sybase IQ 性能和
调优指南》的第 5 章 “管理系统资源”中的 “事务日志文件”。
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-n name 设置数据库服务器的名称。缺省情况下，数据库服务器接
受不带有路径和扩展名的数据库文件名。例如，如果用文件 
c:\sybase\ASIQ-12_7\demo\asiqdemo.db 启动服务器，而没有指定 -n 开
关，则服务器的名称为 asiqdemo。但您应该更改缺省名称。

在相应的局域网（域）内每一服务器名称都必须是唯一的。这样可防止
无意间连接到错误的服务器。主机名合并端口号不能唯一标识服务器。

服务器名称根据计算机的字符集进行解释，因为在启动时不存在数据库
归类。服务器名称必须是有效的标识符。长服务器名称会被截至 40 个字
符。在 NetBIOS 上，最大长度为 16 个字符。对于 Multiplex 服务器名称，
最大长度为 30 个字符。

服务器名称指定要用在客户端应用程序连接字符串或配置文件中的名称。

注意  有两个 -n 开关。-n 开关与位置有关。如果此开关出现在数据库文件
名之后，则该开关是数据库选项。否则，该开关是服务器选项。例如，
在下面的 start_asiq 命令行中，第一个 -n 指示服务器名称，而第二个 -n
位于数据库文件名 mydb.db 后面，指示数据库名称：

start_asiq -n svrname mydb.db -n dbname

服务器名称必须用在连接语句中，才能指定要连接的服务器。在所有环
境中，如果未指定服务器名称，则将使用缺省的数据库服务器，前提是
系统上至少运行一个数据库服务器。应始终指定一个服务器名称以避免
使用缺省名称。在相应的局域网（域）内每一服务器名称都必须是唯一
的。这样可防止无意间连接到错误的服务器。主机名合并端口号不能唯
一标识服务器。

同名的多个数据库服务器不允许运行在网络任何位置的 TCP/IP 上，即使
是单独的端口也是如此。

-o filename 除了将所有服务器消息窗口输出显示在屏幕上之外，还
将该输出打印到一个文件。可以使用此选项指定服务器日志文件的非缺
省名称，并在重新启动服务器后始终使用同一文件。请注意不要填满此
文件。

注意  如果 -o 文件位于已满的文件系统中，则 IQ 服务器将会挂起。一旦
发生此情况，则只能通过关闭服务器进行注销。要防止出现此问题，请
指定 -os 开关。

-os size 限制 -o 开关使用的日志文件的大小。缺省设置是无限制。单
位 G、K 和 M 不区分大小写。如果未提供 G、K 或 M，则假定任何小于 
10000 的整数都以千字节为单位，而任何大于或等于 10000 的整数都以
字节为单位。
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-p packet-size 设置通信包的最大大小。缺省值为 1460 字节。最小值
为 300 字节，最大值为 16000 字节。要为连接设置该值，请参见《Sybase
IQ 系统管理指南》中的 “CommBufferSize 连接参数 [CBSize]”。

-qi 在 Windows 服务器上，控制是否显示数据库服务器任务栏图标和窗
口。该选项使您看不到服务器正在运行的任何指示，可能出现的启动错
误对话框除外。可以使用 -o 和/或 -oe 日志来诊断错误。

-qp 禁止在数据库服务器窗口中显示有关性能的消息。被取消的消息
包括：

• No unique index or primary key for table 'table_name'

• Database file “mydatabase.db” consists of nnn fragments

指定不显示服务器屏幕 （服务器没有控制台）。

-qs 在 Windows 服务器上，取消启动错误对话框。启动错误包括类似如
下所示的错误：

• Could not open/read database file:<database file>

• A database server with that name has already started

在 Windows 平台上，如果服务器不自动启动，这些错误会显示在对话框
中，并且必须在服务器停止前将其清除。如果使用 -qs 选项，则不会显
示这些对话框。

在命令行而不是通过 @environment-variable 或 @filename 语法指定 -qs
的情况下，如果在装载语言 DLL 时出错，则不会显示对话框。此错误不
记录到 -o 或 -oe 日志中，而是记录到 Windows 应用程序事件日志中。

如果在命令行而不是通过 @filename 或 @environment-variable 扩展指定
-qs，则会取消用法错误。

-qw 取消数据库服务器窗口 （Windows 平台） ，在控制台中显示消息
（非 Windows 平台）。

-s 对于 UNIX 服务器，设置 syslog 工具的消息中所使用的系统用户 
ID。缺省值为 user，它使用数据库服务器进程的用户 ID。如果值为 
none，则将禁止记录任何 syslog 消息。

-sb { 0 | 1 } 指定服务器如何响应 TCP/IP 上的广播。

如果使用 -sb 0，则会导致服务器不启动任何 TCP/UDP 广播监听器。除
强制客户端使用 DoBroadcast=NONE 和 HOST= 选项来连接服务器之外，
此选项还会导致使用 dblocate 时不列出服务器。

使用 -sb 1 会导致该服务器不响应来自 dblocate 的广播，同时保持连接逻
辑不受影响。可以通过指定 LINKS=tcpip 和 ENG=<name> 来连接服务器。
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-ti minutes 断开在 minutes 分钟内没有提交请求的连接。缺省值为
4400 （72 小时） ，以便进行长查询操作的用户在周末长假中不会被注
销。客户端计算机在数据库事务期间保持锁定，直至事务结束或连接终
止。提供 -ti 开关是为了断开不活动的连接，从而解除客户端锁定。-ti 开
关不与使用共享内存通信链接的客户端断开连接。将该值设置为零将禁
止检查不活动的连接，因此不会断开任何连接。

可以使用 IDLE 连接参数为各连接设置连接超时。有关详细信息，请参
见 《Sybase IQ 系统管理指南》中的 “Idle 连接参数 [IDLE]”。

-tl seconds 为服务器设置活动超时周期。活动包通过客户端/服务器 
TCP/IP 通信协议定期发送，目的在于确认连接的完好性。如果服务器
运行了一个活动超时周期（缺省为 2 分钟）后未检测到活动包，通信将
断开。服务器将删除与该客户端关联的任何连接。 UNIX 非线程客户端
和 TDS 连接不进行活动检查。

服务器上的 -tl 开关会为没有指定 -tl 开关的所有客户端设置活动超时。

当连接数超过 200 个时，服务器会根据指定的 LivenessTimeout 值自动计算
一个较大的 LivenessTimeout 值。这使服务器可以更高效地处理大量连接。

客户端在 LivenessTimeout 值的三分之一到三分之二这么长的一段时间
内通过每个空闲连接发送活动包。不会同时发送大量活动包。如果发送
活动包需要很长时间 （取决于网络、计算机硬件及计算机上的 CPU 和
网络负载），则可能会在 LivenessTimeout 值的三分之二这么长的一段时
间后发送活动包。如果发送活动包所用的时间很长，服务器控制台中会
出现一条警告。如果出现这样的警告，请考虑增大 LivenessTimeout 值。

-tq time 在指定时间关闭服务器。该时间格式为 HH:MM （24 小时
制），并且可以放在可选日期之后。如果指定了日期，则日期和时间必
须括在双引号中，并使用 “YYYY/MM/DD HH:MM”格式。

-ud 对于 UNIX 服务器，此选项会导致进程在根目录中作为守护程序
运行。（不建议 IQ 使用。）

-ut min 对于 UNIX 服务器，此选项会导致服务器以 min 指定的间隔
创建目录存储临时文件。

-v 在消息框中显示数据库服务器版本，然后停止。

-x list 指定服务器端网络通信协议。

list 是从以下列表获取的设置的逗号分隔列表：TCPIP 或 NamedPipes。

例如，

-x tcpip,ipx

仅允许 TCP/IP 和 IPX 通信。

缺省情况下，将尝试使用操作系统上数据库服务器支持的所有设置。



启动数据库服务器 

24  Sybase IQ

对于某些协议，可能会以如下格式提供附加参数

-x tcpip(PARM1=value1;PARM2=value2;...)

对于 UNIX，如果提供多个参数，需要使用引号：

-x "tcpip(PARM1=value1;PARM2=value2;...)"

有关可用参数的说明，请参见《Sybase IQ 系统管理指南》的第 4 章“连
接和通信参数”。

-xs 指定服务器端 Web 服务通信协议。

-xs { all | none | web-protocols } …

web-protocols:     { [ http | https | http_fips ] parmlist }, … parmlist:     ( 
parm=value …)

使用 -xs 选项可以指定要用哪些 Web 协议来监听客户端连接广播。

如果未指定 -xs 选项，则服务器不会尝试监听 Web 请求。

如果指定带有一个或多个协议的 -xs 选项，服务器将尝试使用指定的协
议来监听客户端请求。

无论您为 -xs 选项选择了何种设置，服务器将始终使用共享内存协议来
监听连接广播。您可以指定以下任何一个参数：

• ALL 使用此平台上的服务器所支持的所有通信协议来监听客户端
的连接尝试，包括共享内存。

• HTTP 使用 HTTP 协议来监听客户端的连接尝试。监听的缺省端口
为 80。

• HTTPS 使用 HTTPS 协议来监听客户端的连接尝试。监听的缺省端
口为 443。

• NONE 仅使用共享内存协议来监听客户端的连接尝试。这是缺省值。

有关可用参数的说明，请参见《Sybase IQ 系统管理指南》的第 4 章“连
接和通信参数”中的 “网络通信参数”。

对于 UNIX，如果提供多个参数，需要使用引号：

-xs "http(PARM1=value1;PARM2=value2;...)"

下面的服务器命令行仅允许共享内存和 TCP/IP 通信：

start_asiq web.db -xs http(port=80)

有关详细信息，请参见《Sybase IQ 系统管理指南》中的 “CommLinks
连接参数 [Links]”。

-z 在启动时提供有关通信链接的诊断信息。只是在跟踪问题时才使
用该选项。
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-zl 启用为服务器上的每个数据库连接捕获最近预准备的 SQL 语句的
功能。

也可以使用 remember_last_statement 服务器设置启用此功能。通过使用 
LastStatement 属性函数，可以为连接获取最近预准备的 SQL 语句。
sa_conn_activity 存储过程可让您为服务器上数据库的所有当前连接获取
最近预准备的 SQL 语句。

对于存储过程调用，仅显示最外层的过程调用，不显示过程中的语句。

-zo 将请求级记录信息重定向到与常规日志文件不同的文件中。使用 -zr
开关启用请求级记录。-zo 开关将此文件中的输出定向到与 -o 开关上指定
的文件不同的文件中。此开关还会禁止在控制台中显示请求级记录。

-zr level 启用操作的请求级记录：

• ALL 用于将所有 SQL 语句和其它请求记录到服务器上。

• NONE 用于关闭 SQL 语句记录。这是缺省值。

• SQL  用于只记录以下类型的请求：

• CONTROL_START_DATABASE

• CONTROL_STOP_ENGINE

• CONTROL_STOP_DATABASE

• STMT_PREPARE

• STMT_EXECUTE

• STMT_EXECUTE_IMM

• STMT_EXECUTE_ANY_IMM

• SQL_OPTION_SET

• BACKUP

• DELETE_FILE

• COMMIT

• ROLLBACK

• PREPARE_TO_COMMIT

• CONNECT

• DISCONNECT

• BEGIN_TRANSACTION 

• STMT_DROP
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• CURSOR_OPEN

• CURSOR_EXPLAIN

• CURSOR_CLOSE

• CURSOR_RESUME

• 错误

此开关还禁止在控制台中显示请求级记录。要将 -zr 日志文件中的连接信
息与 .iqmsg 文件的连接信息相关联，请参见 《Sybase IQ 故障排除和恢
复指南》的第 1 章 “故障排除提示”中的 “将连接信息相关联”。

另请参见“-zo”和“-zs { integer | integerG | integerK | integerM } …”命
令行开关。

-zs { integer | integerG | integerK | integerM } … 限制请求级记录文件的
大小。请求级记录是用 -zr 开关启用的，并用 -zo 开关重定向到一个单独
文件。您可以使用 -zs 开关来限制该文件的大小。

单位 G、 K 和 M 不区分大小写。如果未提供 G、 K 或 M，则假定任何小
于 10000 的整数都以千字节为单位，而任何大于或等于 10000 的整数都
以字节为单位。

当请求日志文件达到 -zs 选项或 sa_server_option 系统过程指定的大小
后，会用附加的扩展名 .old 对该文件进行重命名（如果已经存在这样一
个文件，则用相同名称替换现有的文件）。然后，重新启动请求级的日
志文件。

缺省情况下，没有限制。该值以千字节为单位。

下面的示例说明如何使用 -zs 选项来控制日志文件的大小。假设在命令
行中使用以下选项启动数据库服务器：

-zr all -zs 10 -zo mydatabase.log

将创建新的日志文件 mydatabase.log。如果该文件的大小达到 10K，将
删除所有现有的 mydatabase.old 文件，将 mydatabase.log 重命名为 
mydatabase.old，并将启动一个新的 mydatabase.log 文件。每当 
mydatabase.log 文件达到指定大小时 （在本例中为 10K），都会重复这
一过程。

数据库选项 -m 当检查点操作完成后截断（删除）事务日志（可能在关闭时，或
者由于服务器调度的检查点所致）。该选项提供了自动限制事务日志增大
的方法。检查点频率仍由 CHECKPOINT_TIME 和 RECOVERY_TIME 选项控
制（也可以在命令行中进行定义）。
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在执行需要快速响应的大容量事务，且事务日志的内容与恢复或复制无
关的情况下，-m 选项非常有用。当选择该选项时，不会防备包含数据库
文件的设备出现介质故障。

为了避免产生数据库文件碎片，建议您在使用该选项时，将事务日志存
放在与数据库本身不同的单独设备或分区上。

此选项与 -m 服务器选项相同，但它只适用于当前数据库或由 database-
file 命令行变量标识的数据库。

注意  不要对正在复制的数据库使用 -m 选项，因为复制本身会依赖于事
务日志信息。因此，切勿对 Multiplex 数据库使用 -m 选项。

-n name 为数据库提供呢称（即，替代名称）。使用 -n 呢称可简化连
接。对于 Open Client，-n 呢称必须与 interfaces 文件中的条目相同。

数据库服务器和数据库都可以被命名。由于数据库服务器可装载多个数
据库，因此需要使用数据库名称来区分不同的数据库。但 Sybase 强烈建
议在 IQ 服务器上仅运行一个数据库。 如果必须运行两个数据库，则应在
不同的端口启动两个 IQ 数据库服务器。

缺省情况下，数据库的名称可以为不带有路径和扩展名的文件名。例
如，如果用 c:\sybase\ASIQ-12_7\demo\asiqdemo.db 启动服务器，而没有
指定 -n 选项，则数据库的名称为 asiqdemo。

有关命名约定，请参见 -n 服务器选项。

注意  -n 选项与位置有关。如果位于数据库文件名之后时，此选项命名数
据库。否则，此选项命名服务器。

恢复选项 -iqdroplks name 允许 sp_iqcheckdb 存储过程在指定数据库的 IQ 部分中
恢复泄露的存储。仅当恢复泄露的存储时，才应使用此选项。不要在正
常运行时使用此选项。dbname 必须是物理数据库名称，而不是逻辑名或
昵称。

-iqfrec name 将指定数据库标记为 “正在使用” ，并将该数据库的 IQ
部分恢复到其上次已知的一致状态。仅当强制恢复数据库时，才应使用
此选项。不要在正常运行时使用此选项。 dbname 必须是物理数据库名
称，而不是逻辑名或昵称。

注意  选项 -iqfrec 和 -iqdroplks 仅适用于数据库的 IQ 部分，而不适用于目
录存储。-iqfrec 不支持对数据库的 Adaptive Server Anywhere 部分 （目录
存储）执行强制恢复。
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使用 -iqfrec 和 -iqdroplks 时，一定要按照正确的步骤操作。有关详细信
息，请参见 《Sybase IQ 故障排除和恢复指南》。

另请参见 《Sybase IQ 系统管理指南》中的第 2 章 “运行 Sybase IQ”。

停止数据库服务器
可以使用多种方法停止数据库服务器，其中有些方法是特定于平台的。
本节介绍两种操作系统级服务器关闭实用程序 dbstop 和 stop_asiq。有关
所有服务器关闭方法及何时需要停止数据库服务器的完整说明，请参见
《Sybase IQ 系统管理指南》的第 2 章 “运行 Sybase IQ”中的 “停止数
据库服务器”一节。

停止实用程序 (dbstop)
交互式停止实用程序 dbstop 用于停止数据库服务器。

停止实用程序只是一种命令行实用程序，可用在 UNIX 和 Windows 上。
在 Windows 平台上，通过单击服务器窗口中的“关闭”或者右键单击任
务栏中的服务器图标并从弹出菜单中选择“退出”即可快速停止数据库
服务器。

语法 dbstop [ options ] server-name

参数 表 1-6： dbstop 选项

用法 在 UNIX 上， dbstop 可以关闭上网络中任何节点上的服务器。必须使用
name 才能指定要停止的服务器的名称。此外，还必须用 dbstop 指定启动
服务器时所指定的任何连接参数，才能停止服务器。如果没有适当的连
接参数， dbstop 将不知道如何连接到服务器以指示它关闭。

dbstop 命令行选项可用于控制是否停止服务器 （即使有活动连接）。

server-name 要停止的服务器的名称。

选项 说明

-c “keyword=value; ...“ 连接参数

-o filename 将输出消息记录到文件

-q 安静模式 – 不显示消息

-x 如果有活动连接，则不停止数据库服务器

-y 即使有活动连接，也会停止数据库服务器且
不给出提示
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-c 要停止网络服务器时，必须提供包含用户 ID （具有停止服务器的
权限）的连接字符串。缺省情况下，在网络服务器上需要有 DBA 权限，
所有用户都可以关闭个人服务器；但是可以使用 -gk 命令行选项对此进
行更改。

有关连接参数的说明，请参见 《Sybase IQ 系统管理指南》中的第 4 章
“连接和通信参数”。

如果在服务器上有活动连接，则可以控制 dbstop 的行为。如果有活动连
接，则 dbstop 会给出一个提示，询问您是否希望关闭服务器。如果在命
令行指定 unconditional=true，则关闭服务器时不给出提示，即使有活
动连接也是如此。

将输出消息记录到文件 (-o) 将输出消息写入指定的文件。

安静地运行 (-q) 如果数据库未运行，则不显示消息。

如果有活动连接则不停止 (-x) 如果仍有到服务器的活动连接，则不停
止服务器。

停止且不给出提示 (-y) 即使仍有到服务器的活动连接，也会停止服
务器。

示例 停止服务器 myserver 上名为 asiqdemo 的数据库：

dbstop -c "uid=DBA;pwd=SQL;eng=myserver;dbn=asiqdemo"

停止服务器 myserver，无论数据库是否运行：

dbstop -c 
"uid=DBA;pwd=SQL;eng=myserver;dbn=utility_db"

另请参见 《Sybase IQ 系统管理指南》中的第 2 章 “运行 Sybase IQ”。
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stop_asiq 实用程序 （仅限 UNIX 和 Linux）
除了使用 dbstop 命令之外，在 UNIX 和 Linux 平台上，还可以使用 
stop_asiq 命令停止数据库服务器。有关何时使用 stop_asiq 的完整详细信
息，请参见《Sybase IQ 系统管理指南》的第 2 章“运行 Sybase IQ”中
的 “停止数据库服务器”一节。

语法 stop_asiq [ -agent | -cleanup ] [ -stop [one | all ] ] [ -help ]

开关 表 1-7： stop_asiq 实用程序的开关

用法 当用在 UNIX 或 Linux 操作系统命令行时， stop_asiq 是一种交互式实用
程序，它列出其他用户所拥有的所有服务器及您所拥有的服务器，然后
询问您是否要停止服务器。如果回答 Y （是）， stop_asiq 将关闭服务器
并关闭所有用户与服务器的连接。如果回答 N （否）， stop_asiq 将返回
操作系统命令提示级别，并继续运行服务器。

请注意，使用 stop_asiq 时，会出现以下消息：

"Please note that 'stop_asiq' will shutdown a server
completely without regard for users connections or
load processes status. For a finer level of detail
the utility 'dbstop' has the options to control
whether a server is stopped based on active
connections."

通常，在服务器仍与一个或多个客户端保持连接时，不应关闭服务器。
如果尝试此操作，将会警告您所有未提交的事务都将丢失。请在断开或
关闭所有客户端后重新尝试。

-agent 选项用于关闭 UNIX 和 Linux 上的 IQ 代理。在 Windows 上，IQ 代
理作为一项服务运行，并由 Service Manager 进行管理。有关停止 IQ 代
理的详细信息，请参见《Sybase IQ 系统管理指南》的“运行 Sybase IQ”
中的 “排除 IQ 代理的启动故障”。

参数 目的

-agent 停止 UNIX 或 Linux 系统上的 IQ 代理

-cleanup 删除 Linux 上的孤立 ASIQ 进程

-help 显示 stop_asiq 语法和开关

-stop [ one | all ] 删除与 stop_asiq 的用户交互。假定
对所有问题都回答 “Y”。
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在 cron 或 at 作业中停
止服务器

要在 cron 或 at 作业中使用 stop_asiq，请使用适当的 -stop 选项指定该实
用程序：

stop_asiq -stop one

如果有且仅有一个正在运行的服务器是由启动 cron 或 at 作业的用户 ID
启动的，则设置 -stop one 将关闭一个服务器。这样可避免在多个服务器
正在运行的情况下意外关闭错误的服务器。

stop_asiq -stop all

设置 -stop all 将关闭由启动该服务器的用户 ID 启动的所有服务器。如果
安装有 ESD 8 或更高版本，则此命令将与 Sybase IQ 12.5 兼容。

可以在同一命令中指定两个选项，例如：

stop_asiq -agent -stop all

注意  必须在 cron 语句中为 stop_asiq 可执行文件指定完整路径名。

示例 下面的示例阐释如何以交互方式使用 stop_asiq 列出正在运行的所有服务
器，然后关闭其中一个服务器。

% stop_asiq
Checking system for ASIQ 12 Servers ... 
The following 3 server(s) are owned by other users.

##     Owner    PID   Started  CPU_Time
 -- ---------  -----  --------  --------  -----------------------

        hsin  19895    Mar.21      1:33  
start_asiq -c 32m -gd all -gl all -gm 10 -gn 25 -gp 4096 -ti 4400  
-n hsin -x tcp
qadaily  24754  01:25:07   1286:53  
start_asiq -gn 25 @/exp1/new.cfg asiqdemo.db 
-o /exp1/qa
wb  28350    Apr.11      0:20  
start_asiq -gn 25 @asiqdemo.cfg -o
/exp1/wb/mysybase12/asiq1

The following 1 server(s) are owned by ’janed’
##     Owner    PID   Started  CPU_Time 
-- ---------  -----  --------  --------  -----------------------
1:     janed   2838  15:11:37      0:07  
start_asiq -c 32m -gd all -gm 10 -gn 25 -gp 4096 -ti 4400 -tl 300 
@asiqdemo.cfg

--
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Please note that ’stop_asiq’ will shutdown a server completely 
without regard for users connections or load processes status. 
For a finer level of detail the utility ’dbstop’ has the options 
to control whether a server is stopped based on active connections.

Do you want to stop the server displayed above <Y/N>? Y

Shutting down server (2838) ...
Checkpointing server (2838) ...
Server shutdown.

另请参见 《Sybase IQ 系统管理指南》中的第 2 章 “运行 Sybase IQ”。

对数据库服务器进行故障排除
如果您在操作服务器时遇到问题（包括启动、关闭、不响应和异常终止
故障），请参考《Sybase IQ 故障排除和恢复指南》的第 1 章 “故障排
除提示”以获取故障排除信息。
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第  2  章 使用 Interactive SQL (dbisql)

关于本章 本章深入介绍 Interactive SQL (dbisql)。除了 dbisql 语法和参数以外，
本章还包含一些关于 dbisql 任务的教程，这些任务包括启动 Sybase
IQ、打开样本数据库、访问联机帮助、使用 dbisql 命令窗口、取消
命令和停止 dbisql。

目录
主题 页码

dbisql 简介 34
dbisql 和 dbisqlc 34
Interactive SQL (dbisql) 实用程序 35
启动 dbisql 39
提供连接参数 41
主 dbisql 窗口说明 45
打开多个窗口 45
键盘快捷键 46
使用 Interactive SQL 工具栏 47
使用 Interactive SQL 显示数据 48
在 Interactive SQL 中使用命令 49
配置 Interactive SQL 54
退出 dbisql 61
Interactive SQL Classic (dbisqlc) 实用程序 62
启动 dbisqlc 64
dbisqlc 命令窗口 65
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dbisql 简介
Interactive SQL (dbisql) 是一种用于将 SQL 语句发送到数据库服务器的实
用程序。在以下情况下可以使用此实用程序：

• 浏览数据库中的信息。

• 检验您计划包括在应用程序中的 SQL 语句。

• 将数据装载到数据库中和执行其它管理任务。

此外， dbisql 还可以运行命令文件。可以生成能够对数据库运行的可重
复脚本，然后使用 dbisql 执行这些脚本。有关详细信息，请参见“保存、
装载和运行命令文件 （第 52 页）”。

dbisql 和 dbisqlc
dbisql 是基于 Java 的应用程序。在本书中，Interactive SQL 始终是指这种
基于 Java 的应用程序。

所有新的 Interactive SQL 开发都是在 dbisql 上进行的。与 Sybase IQ 12.4.3
版以前的版本所附带的基于 Windows 的 Interactive SQL 应用程序相比，
dbisql 有几个优点：

• 查找服务器功能 – 在 “Database”选项卡中，“Connect”对话框现
在在“Server Name”框旁边有一个“Find”按钮。通过它可以浏览
和选择服务器名称。如果服务器为远程服务器，请选中在缺省情况
下未选中的 “Search network for database servers”复选框。

• 在 UNIX 上使用鼠标按钮 – 现在可以使用鼠标按钮从 dbisql 菜单中
选择菜单项。

• 剪切和粘贴功能 – 通过主菜单“Edit”项和在“SQL Statements”窗
口中选择并右键单击文本时所出现的下拉菜单均可使用此功能。

若要启动 dbisql，请在 UNIX 命令提示符下键入 dbisql，或在 Windows 上
从 Sybase IQ 12 程序组中选择 “Interactive SQL Java”。
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Sybase IQ 仍然包括 Interactive SQL 的早期版本，以防您需要那些在 
Interactive SQL Java 中尚未实现的功能。早期版本的名称已从 dbisql 更改
为 dbisqlc。有关 dbisqlc 语法的信息，请参见 “Interactive SQL Classic 
(dbisqlc) 实用程序 （第 62 页）”一节。

若要启动早期版本，请在 UNIX 命令提示符下输入 dbisqlc，或在 Windows
上从 Sybase IQ 12 程序组中选择“Interactive SQL Classic”。有关特定于
dbisqlc 的信息，请参见“Interactive SQL Classic (dbisqlc) 实用程序 （第
62 页）”。

Interactive SQL (dbisql) 实用程序
dbisql 为数据库浏览和将 SQL 语句发送到数据库服务器提供交互式环境。

使用 dbisql 可以键入 SQL 命令或运行命令文件。 dbisql 还提供有关受影
响的行数、每个命令需要的时间、查询的执行计划以及任何错误消息的
反馈。

为了使 dbisql 可正常工作， $HOME 必须存在且必须可由用户写入。

可以通过以下方式启动 dbisql：

• 从 Sybase Central，使用 “Open Interactive SQL”菜单项。

• 从“开始”菜单：选择“开始”>“程序”>“Sybase”>“Adaptive
Server IQ 12.7” >“Interactive SQL Java”。

• 在命令提示符下，使用 dbisql 命令。
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使用 dbisql 命令行实用程序打开 Interactive SQL
语法 dbisql [ options ] [ dbisql-command | command-file ]

参数 表 2-1： dbisql 选项列出了 dbisql 的可用选项。

表 2-1： dbisql 选项

用法 注意，对于 Sybase IQ 12，不能使用“Help”菜单项打开 dbisql 的联机帮
助，但在 Sybase Central 中则可找到帮助。在 Sybase Central 中，选择
“Help” >“Sybase IQ Help”，然后单击“Index”选项卡。在“Topic”
或 “Keyword”框中键入 dbisql，然后单击 “Go To”按钮。

退出代码为 0 （成功）或非零值 （失败）。

Interactive SQL 要求将 QUOTED_IDENTIFIER 数据库选项设为 ON，因为
许多数据库函数（包括一些语句）需要这样设置才能正常工作。连接到
数据库时， Interactive SQL 会将此选项自动设置为 ON。

此实用程序不接受 @filename 参数。

dbisql-command | command-file 如果指定 dbisql-command，则 dbisql 执
行该命令。您也可以指定命令文件名。如果未指定 dbisql-command，则
dbisql 进入交互模式。在这种模式下，您可以在命令窗口中键入命令。从
Windows 的“开始”菜单，通过选择“程序”>“Sybase”>“Adaptive
Server IQ 12.7” >“Interactive SQL Java”，可以进入交互模式。

选项 说明

-c "keyword=value; ..." 提供数据库连接参数。

-codepage codepage 指定在读取或写入文件时使用的代码页。

-d delimiter 将给定的字符串用作命令分隔符。

-d1 在执行语句时打印语句（仅命令提示符模式）。

-datasource dsn-name 提供 ODBC 数据源 。
-f 打开（而不运行）名为 filename 的文件。

-host hostname 指定运行数据库服务器的计算机的主机名或 IP
地址。

-jConnect 使用 jConnect 连接到数据库。

-nogui 在命令提示符模式下运行。

-ODBC 使用 iAnywhere JDBC 驱动程序连接到数据库。

-onerror { continue | exit } 对所有用户替换 ON_ERROR 选项。

-port portnumber 在指定端口号上查找数据库服务器。

-q 在安静模式下运行 – 没有窗口或消息。

-x 在语法检查模式下运行 – 不执行任何命令。
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-c "keyword=value; ..." 指定连接参数。有关连接参数的说明，请参见
《Sybase IQ 系统管理指南》中的第 4 章“连接和通信参数”。如果未指
定此选项，会使用环境变量 SQLCONNECT。如果无法连接 Interactive
SQL，则将显示一个对话框，您可以在其中输入连接参数。

注意  为了避免多义性，Sybase 建议始终指定 dbisql 的连接参数，而不要
依赖缺省值，您可以在命令行或诸如 .odbc.ini 这样的初始化文件中指定
它们。例如，如果一个服务器上启动了多个数据库，应指定数据库名称，
并在带有子网的网络中，指定通信协议参数和主机号。有关详细信息，
请参见 《Sybase IQ 系统管理指南》中的第 3 章 “Sybase IQ 连接”。

-codepage 指定在读取或写入文件时要使用的代码页。缺省代码页是所
运行平台的缺省代码页。

例如，在英文 Windows 计算机上， Interactive SQL 使用 1252 (ANSI) 代
码页。如果要让 Interactive SQL 读取用 297 (IBM France) 代码页创建的
文件，可指定下面的选项。

-codepage 297

有关支持的代码页的列表，请参见《Sybase IQ 系统管理指南》中的“支
持的代码页”。

-d 指定命令分隔符。分隔符两侧的引号是可选的，但如果命令 shell 本
身以某种特殊方式解释指定分隔符，则必须使用引号。

在命令行上指定的命令分隔符用于该 Interactive SQL 会话中的所有连接，
而不管存储在数据库中的设置（用户的设置或 PUBLIC 设置）是什么。

-d1 （最后一个字符是数字 1，而不是小写的 L）。 Interactive SQL 将它
执行的所有语句都回写到命令窗口 (STDOUT)。对于调试 SQL 脚本或在
Interactive SQL 处理长 SQL 脚本时，这样可以提供有用的反馈。

-datasource 指定要连接到的 ODBC 数据源。您无需使用 iAnywhere
JDBC 驱动程序即可使用此选项。但是，如果未将要连接到的数据源配
置为使用 TCP/IP，则必须使用 iAnywhere JDBC 驱动程序进行连接。缺
省情况下，将 Sybase IQ 数据源配置为使用 TCP/IP。
-f filename 打开（但不运行）名为 filename 的文件。文件名可用引号括
起来；如果文件名包含空白，则必须用引号括起来。如果文件不存在，
或文件实际上是目录而不是文件，那么 Interactive SQL 会向控制台输出
错误消息，然后退出。如果文件名不包括完整的驱动器和路径说明，则
假定文件相对于当前目录。

-host 指定运行数据库服务器的计算机的主机名或 IP 地址。您可以使用
名称 localhost 来代表当前计算机。
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-jConnect 使用 Sybase jConnect JDBC 驱动程序连接到数据库。在大多
数情况下，这是推荐方法。

-nogui 在命令提示符模式下运行 Interactive SQL，没有窗口式用户界
面。这对于批处理操作很有用。如果指定 dbisql-command 或 command-
file，则假定指定了 -nogui。

在此模式下， Interactive SQL 设置程序退出代码以指示成功或失败。在
Windows 操作系统中，环境变量 ERRORLEVEL 设置为程序退出代码。
表 2-2： dbisql 程序退出代码中列出了退出代码。

表 2-2： dbisql 程序退出代码

-ODBC 使用 iAnywhere JDBC 驱动程序连接。（iAnywhere JDBC 驱动
程序以前称作 JDBC-ODBC 桥。）

-onerror 控制在从命令文件读取语句时如果遇到错误会采取的操作。此
选项会覆盖 ON_ERROR 设置，当在批处理操作中使用 Interactive SQL 时
比较有用。

有关详细信息，请参见《Sybase IQ 参考手册》中的“ON_ERROR 选项
[DBISQL]”。

-port 指定数据库服务器使用的端口号。 Sybase IQ 的缺省端口号是
2638。
-q 不显示输出消息。只有在使用命令或命令文件启动 Interactive 
SQL 时，此选项才有用。指定此选项不会取消错误消息。

如果运行带有 -q 选项的 Interactive SQL Java (dbisql)，并且数据提取命令
（主要是将选项 TEMP_EXTRACT_NAME1 设置为输出文件）位于命令
文件中，则必须首先永久设置 dbisql 选项 “Show multiple result sets”。
如果未设置此选项，则不会创建数据提取输出文件。

程序退出代码 说明

0 成功。

1 一般性失败。在某一时刻，没有成功地执行 SQL 或
Interactive SQL 语句，而且用户选择停止执行 SQL
语句。或者，Interactive SQL 发现了一个内部错误。

5 用户终止 Interactive SQL。在执行期间发生错误时，
系统会提示用户忽略错误、停止或退出 Interactive
SQL。如果用户选择退出，则程序返回代码 5。如果
出现错误并且 Interactive SQL 选项 ON_ERROR 设置
为 EXIT，也返回代码 5。

9 无法连接。

255 命令行错误。命令行包含不完整或无效的开关。
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若要设置 “Show multiple result sets”选项，请在 dbisql 窗口中单击
“Tools” >“Options” >“Results”，然后选中 “Show multiple result 
sets”框并单击 “Make permanent”。

-x 扫描命令，但不执行这些命令。对于检查长命令文件的语法错误，
此选项是很有用的。

示例 本节中的示例演示在系统命令提示符级别使用 dbisql。本章中的其余 
dbisql 小节讨论如何以交互方式使用 dbisql。

• 以下命令在系统提示符下输入，它使用用户 ID DBA 和口令 SQL，对
当前缺省服务器运行命令文件 mycom.sql。如果命令文件中存在错
误，则该过程将终止。

dbisql -c "uid=DBA;pwd=SQL" -onerror exit mycom.sql

• 在命令提示符下的一行中输入以下命令时，会将用户添加到当前的
缺省数据库中：

dbisql -c "uid=DBA;pwd=SQL" grant connect to joe 
identified by passwd

另请参见 有关 SQL 语句和 dbisql 命令的详细说明，请参见《Sybase IQ 参考手册》
中的第 6 章 “SQL 语句”。

启动 dbisql
在本节中，可以实践启动 IQ 和 dbisql。

可以通过下列两种方式启动 Interactive SQL：从 Sybase Central 或在它自
身上。在 Interactive SQL 自身上启动它的方式取决于操作系统。

有关连接到数据库的详细信息，请参见 《Sybase IQ 简介》中的第 3 章
“运行和连接到服务器”。

❖ 从 Sybase Central 打开 Interactive SQL

1 在左窗格中，选择 Sybase IQ 插件。

2 在右窗格中，单击 “Utilities”选项卡。

3 在右窗格中，双击 “Open Interactive SQL”。

将显示 “Interactive SQL”窗口。

4 按照 “提供连接参数 （第 41 页）”中的步骤提供参数。
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提示
通过选择“开始” >“程序” >“Sybase” >“Adaptive Server IQ 12.7” >
“Interactive SQL Java”，或在 Sybase Central 的内部使用以下任一方法，您
也可以访问 Interactive SQL：

• 选择 “Tools” >“Sybase IQ” >“Open Interactive SQL”。

• 在左窗格中选择数据库，然后从 “File”菜单选择 “Open 
Interactive SQL”。

• 右键单击数据库，并从弹出菜单中选择 “Open Interactive SQL”。

• 右键单击存储过程，并从弹出菜单中选择 “Execute from 
Interactive SQL”。将打开 Interactive SQL，并在 “SQL Statements”
窗格中显示相应过程的 CALL，然后执行该存储过程。

❖ 从 Sybase Central 启动 Interactive SQL

• 若要启动 Interactive SQL，请右键单击服务器，并从弹出菜单中选择
“Interactive SQL”。这时， Interactive SQL 将自动连接到数据库。

若要启动 Interactive SQL 而不连接到数据库，请选择 “Sybase IQ
12”>“Utilities”>“Open Interactive SQL”。将自动显示“Connect”
对话框。

❖ 在 UNIX 上启动 dbisql

1 如果样本数据库服务器尚未运行，则启动该服务器。为此，请更改
到 demo 目录，并执行以下命令：

% start_asiq -n servername asiqdemo.db  
对于 servername，请用唯一服务器名称代替它，例如以下划线分隔
的系统名称、数据库名称和端口号。

注意  如果指定 -n servername，而没有指定 dbname，则服务器将连接
到当前服务器上的缺省数据库。如果指定 -n dbname，而没有指定
servername，则 Sybase IQ 将连接到当前服务器上的该数据库。

例如，在系统提示符下输入以下命令：

cd $SYBASE/ASIQ-12_7/demo
start_asiq -n fiona_asiqdemo_1870 asiqdemo.db

2 若要启动 dbisql，请在系统提示符下键入以下命令：dbisql
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❖ 在 Windows 上启动 dbisql

• 从 “开始”菜单，选择 “开始” >“Sybase” >“Adaptive Server 
IQ 12.7” >“Interactive SQL Java”。

将显示 “Connect”对话框。

注意  一旦数据库服务器运行，还可以通过在命令提示符下键入 dbisql 或
通过在 Sybase Central 中右键单击服务器名称然后从弹出菜单中选择
“Interactive SQL”来启动 dbisql。

提供连接参数
如果没有连接任何数据库， Sybase IQ 将显示“Connect”对话框请求您
提供连接参数。

❖ 连接到数据库

1 使用下列任何方法在 “Connect”对话框中的 “Identification”选项
卡上标识您自己：

• 输入用户 ID 和口令。口令区分大小写；用户 ID 不区分。在输
入每一项后，按 TAB 键。

User ID – 对于样本数据库，请使用用户 ID DBA

Password – 对于 DBA 用户 ID，请使用 password 
SQL

• 选择集成登录。

若要使用此选项，DBA 必须为您定义了集成登录。有关详细信息，
请参见《Sybase IQ 系统管理指南》中的“使用集成登录”。
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图 2-1： “dbisql Connect”对话框

键入口令时，口令内容不会出现。这样可防止他人看到您的口令。

2 在输入口令之后，单击 “Database”选项卡。

3 输入启动服务器时使用的服务器名称。确保服务器名称在局域网上
是唯一的。

对于远程服务器，请以 host name:port number 的格式指定服务器。选
中“Search network for database servers”复选框。

4 按 Tab 键转到 “Database name”，输入数据库文件名，不要带任何
后缀。
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5 按 Tab 键转到 “Database file”，并输入 .db 文件的完整路径。可以
使用 “Browse”键定位文件，如图 2-2 所示。

图 2-2： “dbisql Connect”对话框 “Database”选项卡

缺省情况下未选中“Search network for database servers”复选框。必
须启用此复选框才能让 dbisql 找到远程服务器。

如您使用 dbisqlc 或 dbisql 且在连接到 utility_db 时已经通过备份恢复了
数据库，则必须提供 DBF 参数和数据库文件名才能连接该数据库。
有关详细信息，请参见 《Sybase IQ 系统管理指南》中的 “在恢复
后重新连接”。

通过在命令行上提供带 -c 选项的连接参数（如“示例（第 39 页）”所
示），可以绕过 “Connect”对话框。

还可以单击 “Cancel” ，以便在不连接数据库的情况下启动 Interactive
SQL。然后，可以在 “SQL Statements”窗口中输入 CONNECT 命令。
例如，若要连接到本地服务器上的样本数据库，可以使用：

CONNECT USING 'UID=DBA;PWD=SQL'
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如果弹出 “CONNECT”对话框或有关丢失信息的错误消息，则可能需
要在 “Advanced”选项卡中输入 -host 和 -port 或其它丢失信息。如果数
据库位于远程服务器上，则输入 -host 和 -port 参数 （分两行输入），如
下所示：

-host fiona
-port 1870

有关连接参数的完整列表，请参见《Sybase IQ 系统管理指南》中的第 4
章 “连接和通信参数”。

在连接到数据库之后， Interactive SQL 将在标题栏上显示该连接的数据
库名称、用户 ID 和服务器名称，如图 2-3 所示。

图 2-3： dbisql 窗口

注意  对于 Sybase IQ 12，不能使用 “Help”菜单项打开 dbisql 联机帮
助，但在 Sybase Central 中则可找到 dbisql 帮助。在 Sybase Central 中，
选择 “Help”“Sybase IQ Help”，然后单击 “Index”选项卡。在
“Topic”或 “Keyword”框中键入 dbisql，然后单击 “Go To”按钮。
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主 dbisql 窗口说明
Interactive SQL 有以下窗格：

• “SQL Statements”提供键入 SQL 语句的位置。如果键入的代码超
过窗格的大小，则会自动出现滚动条。

• “Messages”显示有关执行的信息。可以从 “Tools” >“Options”
对话框指定消息选项，包括是将它显示为单独的窗格还是作为
“Results”窗格上的选项卡 （缺省设置）。

• “Results”显示命令的执行结果。例如，如果使用 SQL 语句检索特
定数据，则此窗格显示与搜索条件匹配的列和行。如果信息超过窗
格的大小，则会自动出现滚动条。

注意  执行查询时， Interactive SQL 还将在 “Plan”和可选的 “Ultralite 
Plan”窗格中显示 Adaptive Server Anywhere 查询计划。对于针对 IQ 存
储区的查询，请忽略这些计划。请使用 .iqmsg 文件中的 IQ 查询计划，
或 HTML 查询计划。

有关 IQ 查询计划的详细信息，请参见《Sybase IQ 性能和调优指南》中
的 “计划查询”。

打开多个窗口
可以打开多个 Interactive SQL 窗口，每个窗口对应单独的数据库连接。
通过使用多个窗口，可以同时连接到不同服务器上的两个（或更多）不
同数据库，或打开与单个数据库的并发连接。

❖ 打开新的 Interactive SQL 窗口：

1 选择 “File” >“New Window”。

2 在所出现的 “Connect”对话框中，输入连接选项，并单击 “OK”
建立连接。

此外，还可以通过 “SQL”菜单中的 “Connect”和 “Disconnect”命
令，或通过执行 CONNECT 或 DISCONNECT 语句，连接到数据库或与数
据库断开连接。
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键盘快捷键
表 2-3： dbisql 键盘快捷键中列出了 Interactive SQL 提供的键盘快捷键。

表 2-3： dbisql 键盘快捷键

功能键 说明

ALT+F4 退出 Interactive SQL。
ALT+ 左方向键 显示历史列表中的上一个 SQL 语句。

ALT+ 右方向键 显示历史列表中的下一个 SQL 语句。

CTRL+BREAK 中断正在执行的 SQL 语句。

CTRL+C 将选定的行和列标题复制到 “Results”窗格中的剪贴板。

在 “SQL Statements”窗格中，将选定的文本复制到剪贴板。

CTRL+END 移动到当前窗格的底部。

CTRL+H 显示所执行的 SQL 语句的历史记录。

CTRL+HOME 移动到当前窗格的顶部。

CTRL+N 清除 “Interactive SQL”窗口中的内容。

CTRL+P 打印 “SQL Statements”窗格中的内容。可以在“Interactive SQL Options”对
话框中配置打印文本的外观。

CTRL+Q 显示查询编辑器。

查询编辑器帮助您建立 SQL 查询。当完成建立查询后，单击 “OK”将其输出
回 “SQL Statements”窗格中。

CTRL+S 保存 “SQL Statements”窗格中的内容。

ESC 清除 “SQL Statements”窗格中的内容。

F1 打开 “Help”。
F2 编辑结果集中选定的值。可以在行中使用 Tab 键切换到其它列。

F5 执行 “SQL Statements”窗格中的所有文本。

您还可以通过单击工具栏上的 “Execute SQL Statement”按钮来执行此操作。

F7 显示 “Lookup Table Name”对话框。

在此对话框中，您可以查找并选择一个表然后按 ENTER 键将该表名称插入“SQL
Statements”窗格中光标所在的位置。或者，在列表中选中某个表时，再次按 F7
键显示该表中的列。然后，您可以选择一个列并按 ENTER 键将该列名称插入
“SQL Statements”窗格中光标所在的位置。

F8 显示 “Lookup Procedure Name”对话框。

在此对话框中，您可以查找并选择一个过程然后按 ENTER 键将该过程名称插入
“SQL Statements”窗格中光标所在的位置。

F9 执行 “SQL Statements”窗格中选中的文本。

如果未选中任何文本，则执行所有语句。

PGDN 在当前窗格中向下移动一页。

PGUP 在当前窗格中向上移动一页。
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当 “SQL Statements”窗格有焦点时，表 2-4 中的键盘快捷键可用：

表 2-4： “SQL Statements”窗格的 dbisql 键盘快捷键

使用 Interactive SQL 工具栏
Interactive SQL 工具栏（如图 2-4 所示）出现在“Interactive SQL”窗口
的顶部。此工具栏提供用于执行常见命令的按钮。

图 2-4： Interactive SQL 工具栏

功能键 说明

CTRL+] 将光标移动到匹配的括号。括号匹配可以匹配小括号、大括号、中括号和尖括号。

CTRL+ 退格键 删除光标左边的单词。

CTRL+DEL 删除光标右边的单词。

CTRL+G 打开 “Go To”对话框，您可以在该对话框中指定要转到的行。

CTRL+L 从 “SQL Statements”窗格中删除当前行并将该行放置到剪贴板上。

CTRL+SHIFT+] 将选择扩展到匹配的括号。括号匹配可以匹配小括号、大括号、中括号和尖括号。

CTRL+SHIFT+L 删除当前行。

CTRL+SHIFT+U 将选定内容更改为大写字符。

CTRL+U 将选定内容更改为小写字符。

F3 查找选定文本的下一个出现位置。

HOME 将光标移动到当前行的开始位置或当前行的第一个单词。

SHIFT+F3 查找选定文本的上一个出现位置。

SHIFT+HOME 将选定内容扩展到当前行上文本的开始位置。
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使用工具栏上的按钮，可以执行以下操作：

• 重新调用历史列表中紧接在当前位置之前的已执行的 SQL 语句。

• 查看多达 50 个以前已执行的 SQL 语句的列表。

• 重新调用历史列表中紧接在当前位置之后的已执行的 SQL 语句。

• 执行当前在 “SQL Statements”窗格中显示的 SQL 语句。

• 中断当前 SQL 语句的执行。

作为这些按钮所执行操作的简单提示，可以将鼠标光标停在每个按钮的
上方以查看弹出说明。

使用 Interactive SQL 显示数据
Interactive SQL 的主要用途之一是浏览数据库中的信息。本节说明如何
查询样本数据库中的信息。

可以在 Interactive SQL 中使用 SELECT 语句显示数据库信息。下面的示
例显示要在 “SQL Statements”窗格中键入的命令。键入命令之后，必
须单击工具栏上的 “Execute SQL Statement”按钮才能执行该命令。

在执行语句之后，数据（被调用的结果集）将显示在结果窗格中。可以
使用滚动条查看位于窗格当前视图之外的表区域。

❖ 列出 employee 表的所有列和行：

1 启动 Interactive SQL 并连接到样本数据库。

2 在 “SQL Statements”窗格中键入以下命令：

SELECT *
FROM employee

3 在工具栏上，单击 “Execute SQL Statement”按钮。

有关 SELECT 语句的详细信息，请参见《Sybase IQ 性能和调优指南》中
的第 1 章 “从数据库表中选择数据”。

Emp_id Manager_id Emp_lname emp_fname  ...
102 501 Fran Whitney  ...
105 501 Matthew Cobb  ...
129 902 Philip Chin  ...
148 1293 Julie Jordan  ...
160 501 Robert Breault  ...
...    
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在 Interactive SQL 中使用命令
后面的几章介绍可以在 Interactive SQL 中使用的一些命令。本节介绍在
Interactive SQL 中使用命令的常规任务。

所有 SQL 语句都可以作为命令输入到 Interactive SQL 查看器的顶部窗格
中。完成键入时，需要执行语句来运行它。

❖ 输入命令：

• 在 “SQL Statements”窗格中，键入命令。

❖ 若要执行命令，请执行以下操作之一：

• 按“Execute SQL Statement”按钮，或选择“SQL” >“Execute”，
或按 F5 键。

❖ 清除“SQL Statements”窗格：

• 选择 “Edit” > “Clear SQL”，或按 ESCAPE 键。

提示

通过按 F9 键，只能执行 “SQL Statements”窗口内的选中文本部分。

将在 “ISQL Error”弹出窗口中显示语法错误消息。若要查看有关错误
的详细信息，请单击 “Help”。（请勿使用 “Help”窗口中的 “Online
Books”按钮。） 

有关已执行的语句的其它消息 （例如执行时间）会显示在 “Messages”
窗格中。可以通过“Tools” >“Options” >“Messages”控制消息信息
的显示和内容。
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组合多个语句

Interactive SQL 环境允许同时输入多个语句。可以通过在每个语句的末
尾添加分号 (;) 来实现此目的。

❖ 在 “SQL Statements”窗格中输入多个语句：

1 尝试将以下三个命令输入到 “SQL Statements”窗格中。

UPDATE employee
SET dept_id = 400,
    manager_id = 1576
WHERE emp_id = 467;

UPDATE employee
SET dept_id = 400,
    manager_id = 1576
WHERE emp_id = 195;

SELECT *
FROM employee
WHERE emp_id IN ( 195, 467 );

2 在工具栏上，单击“Execute SQL Statement”按钮。将执行所有三条
语句。执行后，这些命令会保留在“SQL 语句”窗格中。如果要清
除此窗格，请按 ESC 键。

查找表、列和过程

当在 Interactive SQL 中输入命令时，可以查找当前数据库中存储的表、
列或过程的名称，并将它们插入到光标位置。

❖ 查找数据库中的表的名称：

1 选择 “Tools” >“Lookup Table Name”。

2 查找并选择该表。

3 单击 “OK”将表名称插入 “SQL Statements”窗格中。

❖ 查找数据库中的列名称：

1 选择 “Tools” >“Lookup Table Name”。

2 查找并选择包含该列的表。

3 单击 “Show Columns”。

4 选择该列，并单击“OK”将列名称插入“SQL Statements”窗格中。
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❖ 查找数据库中的过程的名称：

1 选择 “Tools” >“Lookup Procedure Name”。

2 查找并选择该过程。

3 单击 “OK”将过程名称插入 “SQL Statements”窗格中。

在表和过程查找对话框中，可以输入所要查找的表或过程的前几个字
符。在字段中键入一些内容之后，对话框会等待一段很短的时间，然后
缩小列表的范围，以便仅包括以您输入的文本开头的那些项。

可以使用标准 SQL 通配符元字符 % 来表示“匹配任何内容”。例如，若
要仅列出以 order 结尾的那些表，请在查找字段中键入 %order。若要列
出包含单词 java 的所有项，请键入 %java%。如果从查找字段中清除搜索
条件，将会重置过滤以显示所有项。

重新调用命令

执行命令时， Interactive SQL 将在当前会话持续时间内存在的历史记录
列表中自动保存命令。 Interactive SQL 维护最多 50 条最近命令的记录。

您可以在 “Command History”对话框中查看整个命令列表。若要访问
“Command History”对话框，请按 CTRL + H，或在工具栏中单击书籍
图标。

最近的命令显示在列表的底部。若要重新调用某个命令，请突出显示该
命令，并单击 “OK”。该命令将显示在 Interactive SQL 的 “SQL 
Statements”窗格中。

此外，还可以在不使用 “Command History”对话框的情况下重新调用
命令。使用工具栏中的箭头，或按 ALT + 右箭头键和 ALT + 左箭头键，
可以在命令中向后或向前滚动。

此外，还可以将命令保存在文本文件中，以便能在随后的 Interactive SQL
会话中使用它们，下一节将对此进行介绍。
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保存、装载和运行命令文件

可以保存当前出现在 “SQL Statements”窗格中的命令，以便在未来的
Interactive SQL 会话中使用它们。用于保存命令的文件称作命令文件（也
称为脚本）。

注意  ODBC 应用程序（包括 Interactive SQL 应用程序）会自动将某些数
据库选项设置为 ODBC 规范所规定的值。这样将覆盖通过 
LOGIN_PROCEDURE 数据库选项所做的设置。有关详细信息及解决方法，
请参见《Sybase IQ 参考手册》中的“LOGIN_PROCEDURE 选项”。

开始新会话时，可以将命令文件的内容装载到 “SQL Statements”窗格
中，也可以直接运行内容。

❖ 保存 “SQL Statements”窗格中的命令：

1 选择 “File” >“Save As”。

2 在 “Save”对话框中，指定文件的位置、名称和格式。完成后单击
“Save”。

❖ 将命令从文件装载到“SQL Statements”窗格中：

1 选择 “File” >“Open”。

2 在 “Open”对话框中，查找并选择文件。完成后单击 “Open”。

❖ 直接运行命令文件：

1 选择 “File” >“Run Script”。

2 在 “Open”对话框中，查找并选择文件。完成后单击 “Open”。

可以提供命令文件作为 Interactive SQL 的命令行参数。

“Run Script”菜单项的作用等效于 READ 语句。例如，在 “SQL 
Statements”窗格中，还可以通过键入以下内容来运行命令文件：

READ 'c:\filename.sql'

其中， c:\filename.sql 是文件的路径、名称和扩展名。如果需要，可以将
字符串括在单引号中 （如上所示），但仅当路径包含嵌入空格时才需要
使用引号。
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记录命令

使用 Interactive SQL 记录功能，可以在执行命令时将命令记录下来。
Interactive SQL 将连续记录，直到记录过程停止或当前会话结束。所记
录的命令将存储在日志文件中。

❖ 开始记录 Interactive SQL 命令：

1 选择 “SQL” >“Start Logging”。

2 在 “Save”对话框中，指定日志文件的位置和名称。

3 完成后单击 “Save”。

❖ 停止记录 Interactive SQL 命令：

• 选择 “SQL” >“Stop Logging”。

提示

通过在“SQL Statements”窗格中键入命令，也可以启动和停止记录。若
要开始记录，请键入并执行 START LOGGING 'c:\filename.sql'，其中，
c:\filename.sql 是日志文件的路径、名称和扩展名。日志文件必须有 .sql
扩展名。只有当路径包含嵌套空格时，才需要包括单引号。若要停止记
录，请键入并执行 STOP LOGGING。

开始记录之后，系统将记录您尝试执行的所有命令，包括那些未正确执
行的命令。

取消 Interactive SQL 命令

中断或停止操作将使当前处理过程停止，并提示您输入下一个命令或
操作。

❖ 中断 Interactive SQL 命令：

• 在工具栏上，单击 “Interrupt the SQL statement”按钮。

或

选择 “SQL” >“Stop”。

如果正在处理命令文件，则系统会提示您指定要执行的操作 （“Stop 
command file”、“Continue”或“Exit Interactive SQL”）。可以用 Interactive 
SQL ON_ERROR 选项来控制这些操作。有关详细信息，请参见
《Sybase IQ 参考手册》第 2 章 “数据库选项”中的 ON_ERROR 选项 
[DBISQL]。
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报告的错误 检测到中止时，将报告三个不同错误中的某一个，具体取决于何时检测
到中止。

1 如果在 Interactive SQL 处理请求时检测到中止 （与数据库引擎相
反），则会显示以下消息：

ISQL command terminated by user

Interactive SQL 将立即停止处理过程，并搁置数据库事务。

2 如果数据库引擎在处理标准数据操作命令 （SELECT、 INSERT 和 
DELETE）时检测到取消，并且引擎未在批量操作模式下运行，则
会显示以下消息。

Statement interrupted by user.

将撤消当前命令的执行结果，但事务的剩余部分保持完整。

3 如果在数据库引擎处理数据定义命令 （CREATE、 DROP、 ALTER
等）时检测到中止，则会出现以下消息：

Terminated by user -- transaction rolled back

由于数据定义命令都在命令启动前自动执行 COMMIT，所以执行 
ROLLBACK 命令的结果仅仅是取消当前的命令。

当数据库引擎在批量操作模式下运行并执行修改数据库的命令
（INSERT、 UPDATE 和 DELETE）时，也会显示此消息。在这种情况
下，ROLLBACK 不仅取消当前的命令，还取消上一次 COMMIT 之后执
行的所有操作。在某些情况下，数据库引擎可能要花相当长的时间来执
行自动 ROLLBACK。

配置 Interactive SQL
可以在“Options”对话框中配置不同的 Interactive SQL 查看器选项。此
对话框为命令、查看器外观、导入/导出功能和消息提供设置。

每个选项都可以从界面或使用 Interactive SQL SET OPTION 语句进行设
置。有关详细信息，请参见《Sybase IQ 参考手册》中的 SET OPTION 语
句 [DBISQL]。

❖ 访问 “Options”对话框：

• 选择 “Tools” >“Options”。

以下几节将介绍 “Options”对话框的选项卡。

注意  某些 Interactive SQL 选项仅用于 Adaptive Server Anywhere，这里不
作讨论。
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“Options”对话框：“General”选项卡

“Options”对话框的 “Commands”选项卡有以下组件：

• Commit 使用下面的选项可以选择何时提交对数据库的更改。此外，
还可以通过在任何适当的时候输入显式 COMMIT 命令手动提交。

• After each command 选择此选项将在执行每个 SQL 语句之后
提交对数据库的更改。

• On exit 选择此选项可以在退出 Interactive SQL 会话时提交数
据库的更改。这是缺省设置。

有关详细信息，请参见《Sybase IQ 参考手册》第 2 章“数据库
选项”中的 “AUTO_COMMIT 选项 [DBISQL]”。

• Command files 下列选项控制 Interactive SQL 在运行命令文件时的
行为。

• When an error occurs 选择某个选项可控制 Interactive SQL 在
执行命令文件中的语句时一旦遇到错误该如何作出响应。根据
您选择的选项，Interactive SQL 可能继续执行文件、停止执行文
件或关闭。缺省设置是 PROMPT。

有关配置 Interactive SQL 在执行命令文件中的语句时如何对错
误作出响应的详细信息，请参见《Sybase IQ 参考手册》第 2 章
“数据库选项”中的 ON_ERROR 选项。

• Echo command files to log 如果选择此选项，则 Interactive SQL
将把所执行的命令文件中的 SQL 语句记录到日志文件中。

缺省情况下，将命令文件复制到日志中。

有关详细信息，请参见《Sybase IQ 参考手册》第 2 章“数据库
选项”中的 ECHO 选项。

• When browsing for files, where should the browser start? 选择以下
选项之一指定 Interactive SQL 在浏览文件时首先使用哪个目录。如
果希望在后续 Interactive SQL 会话中使用此设置，请在选择以下选
项之一后单击 “Make Permanent”。

• Last folder used 如果选中此选项，则初始浏览器目录为上次
使用文件浏览器时所在的目录。这是缺省设置。

• Current folder 如果选中此选项，则浏览器使用的初始目录为
操作系统定义的当前文件夹。
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• File association 在 Windows 平台上，可以使 Interactive SQL 成为
.sql 文件的缺省编辑器。

• Make DBISQL the default editor for .sql files 在 Windows 上选
择此选项可以使 Interactive SQL 成为 .sql 文件的缺省编辑器。

双击这类文件时， Windows 将使用 Interactive SQL 自动打开文
件。注意， Interactive SQL 不会自动运行文件。

“Options”对话框：“Results”选项卡

Interactive SQL 中的“Options”对话框的“Results”选项卡具有以下组件：

• Display null values as 指定如何在表列中显示空值。对于该值，可
以使用任何字符串。缺省值是 (NULL)。如果此字段为空白，则空值
将显示为空字符串。

有关详细信息，请参见《Sybase IQ 参考手册》第 2 章 “数据库选
项”中的 NULLS 选项 [DBISQL]。

• Maximum number of rows to display 指定在“Results”窗格中显示
的最大行数。缺省值为 500。

• Truncation length 指定“Results”窗格每列中显示的字符数。如果
输入值 0，则不截断列。缺省值为 256。

有关详细信息，请参见第 2 章 “数据库选项”中的 
TRUNCATION_LENGTH 选项 [DBISQL]

• Show multiple result sets 如果希望在执行返回多个 SELECT 语句
的过程时，让 Interactive SQL 在“Results”窗格中显示多个结果集，
请选中此选项。每个结果集在 “Results”窗格中用单独的选项卡显
示。缺省情况下， Interactive SQL 不显示多个结果集。

如果使用 jConnect 驱动程序，并选择 “Show Multiple Result Sets”
选项，则 Interactive SQL 必须等待，直到检索完整个结果集，然后
结果行才会出现在 “Results”窗格中。对于大的结果集，这会导致
处理速度变慢。

• Show row number

如果希望行数显示在 “Results”窗格中的结果的旁边，请选中此选
项。缺省情况下，此选项打开。
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• Automatically refetch results 如果希望在执行 INSERT、UPDATE 或
DELETE 语句之后 Interactive SQL 自动重新生成结果集，请选择此选
项。缺省情况下， Interactive SQL 重新提取结果集。

有关详细信息，请参见 《Sybase IQ 参考手册》第 2 章 “数据库选
项”中的 AUTO_REFETCH 选项。

• Which font do you want to use to show table data? 选择以下选项
之一指定在 Interactive SQL 的“Results”窗格中用于表数据的字体。

• System 选择此选项可以使用计算机的常规文本字体。这是缺
省设置。

• Editor 选择此选项可以使用与代码编辑器相同的字体。

有关代码编辑器的详细信息，请参见 ““Format”选项卡 （第
60 页）”。

• Custom 选择此选项可以指定要使用的字体、字体样式和磅
值。单击 “Browse”可以在 “Font”对话框中选择所需设置。

“Options”对话框：“Import/Export”选项卡

Interactive SQL 中的 “Options”对话框的 “Import/Export”选项卡有以
下组件：

• Default export format 若要选择一种导出文件格式，请从下拉列表
中选择一种文件格式。缺省情况下，导出格式是 ASCII。

• Default import format Sybase IQ 数据库不支持使用此选项。

有关 Interactive SQL 所支持的文件格式的详细信息，请参见《Sybase
IQ 系统管理指南》中的第 7 章 “将数据移入和移出数据库”。

注意  IQ 数据提取功能将数据以二进制或 ASCII 格式导出，这种格式
的数据可以装载到另一数据库中。在进行大容量数据移动，或者需
要可用于装载的输出文件时，可使用此功能。有关此功能的详细信
息和优点，请参见 《Sybase IQ 系统管理指南》第 7 章 “将数据移
入和移出数据库”中的 “数据提取选项”。

• ASCII Options 指定以 ASCII 格式导出数据时用作字段分隔符、引
号字符串和转义字符的缺省符号。

• Default field separator 在 ASCII 文件中用于分隔值的符号。缺
省值是逗号 (,)。

• Default quote string 在 ASCII 文件中用于包围字符串的符号。
缺省值是单引号 (')。
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• Default escape character 在 ASCII 文件中用于代替不可打印字
符的符号。转义字符必须是一个单字节字符。缺省值是反斜杠 (\)。

• Default encoding 导入和导出文件时使用的编码。如果更改此
值，则更改仅应用于当前 Interactive SQL 会话。启动新 
Interactive SQL 会话时，该选项将恢复到其缺省值。缺省值为 
(Default)。如果选中 “(Default)”，将按以下方式确定编码：

• INPUT、OUTPUT 或 READ 语句的 ENCODING 子句中指定
的代码页

• 用 DEFAULT_ISQL_ENCODING 选项指定的代码页 （如果
设置了该选项） 

• 启动 Interactive SQL 时以 -codepage 命令行选项指定的代
码页

• 运行 Interactive SQL 的计算机的缺省代码页

“Options”对话框：“Messages”选项卡

Interactive SQL 中的“Options”对话框的“Messages”选项卡具有以下
组件：

• Measure execution time for SQL statements 如果希望 Interactive SQL 
测定执行一个语句所花的时间，请选中此选项。时间显示在
“Messages”选项卡上。缺省情况下，此选项处于选中状态。

• Show separate Messages pane 如果希望来自数据库服务器的信息
（如执行时间）出现在 “SQL Statements”窗格和 “Results”窗格
之间的 “Messages”窗格中，而不是出现在 “Results”窗格的
“Messages”选项卡上，请选中该选项。缺省情况下，数据库服务
器信息显示在 “Results”窗格的 “Messages”选项卡上。

• Default number of lines in Messages pane 键入要在“Messages”窗
格中返回的行数。缺省数字是 7。如果选择“Show Separate Messages
Pane”，则该数字还是 “Messages”窗格的高度 （以行为单位）。
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“Options”对话框：“Editor”选项卡

使用此选项卡可以配置在“SQL Statements”窗格中键入的文本的外观。
注意，如果在 Sybase Central 使用代码编辑器，则在此选项卡上指定的任
何设置都将应用于代码编辑器。

Interactive SQL 中的 “Options”对话框的 “Editor”选项卡由四个选项
卡组成：“Editor”、“Tabs”、“Format”和 “Print”。

“Editor”选项卡

“Editor”选项卡有以下组件：

• Vertical scroll bar 按窗口大小显示或隐藏垂直滚动条以包含所有
文本。

• Horizontal scroll bar 按窗口大小显示或隐藏水平滚动条以包含所
有文本。

“Tabs”选项卡

“Tabs”选项卡有以下组件：

• Tab size 可用于设置制表符的大小 （以空格数计算）。

• Indent size 可用于设置缩进大小 （以空格数计算）。

• Insert spaces 按下 Tab 键时插入 n 个空格，而不是插入一个制表
符。n 的值介于 1 和缩进大小空格数之间，这取决于需要多少个空格
才能将光标向前移动到下一个制表位。

• Keep tabs 按下 Tab 键时在文档中插入一个制表符，并将光标向前
移动到下一个制表位。

• Auto indent 可用于设置自动缩进功能。您具有以下选项：

• None 禁用该功能。

• Default 使用设置的制表符和缩进大小。

• Smart 使用以前的代码行作为缩进左括号和右括号的依据。

• Indent opening brace 如果要缩进左大括号，请选中此选项。
选择 “Smart”选项时，将启用此选项。

• Indent closing brace 如果希望缩进右大括号，则选择此选项。
选择“Smart”选项时，将启用此选项。

• Sample “Sample”字段显示如何根据所选择的缩进左右大括号的
选项来设置代码的格式。
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“Format”选项卡

“Format”选项卡有以下组件：

• Text Highlighting 可用于指定主编辑窗口中不同类型文本的颜色和
样式。选择一种文本，然后设置该文本类型的前景、背景和样式。

• Foreground 前景指文本的颜色。

• Background 背景指文本后面的屏幕的颜色。

• Style 可用于指定文本类型的格式类型。可以选择：

• Plain

• Italic

• Bold

• Italic and Bold

• Font size 可用于指定显示在“SQL Statements”窗格中的文本的字
体磅值。

• Caret color 可用于指定屏幕上闪烁的光标指示符的颜色。

• Sample 使用您在上面配置的设置显示文本的更新样本。

• Reset All 将所有设置恢复为其缺省值。

“Print”选项卡

“Print”选项卡有以下组件：

• Header 当您打印“SQL Statements”窗格的内容时，使用该选项可
以指定页眉中显示哪些信息以及它们的格式设置。缺省情况下，页
眉文本向左对齐。按 “>”按钮可以获得可用选项的列表。

• Footer 当您打印“SQL Statements”窗格的内容时，使用该选项可
以指定页脚中显示哪些信息以及它们的格式设置。缺省情况下，页
脚文本向左对齐。按 “>”按钮可以获得可用选项的列表。

• [>] 按钮 按“>”按钮可以从以下页眉或页脚选项中进行选择：

• File Name

• File Time

• File Date

• Page Number

• Page Count

• Current Time
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• Current Date

• Left Align

• Center

• Right Align

您选择的项不一定都要具有相同的对齐方式。例如，您可以选
择在页眉中左对齐文件名、右对齐日期。缺省情况下，页眉和
页脚中的所有文本都是左对齐的。您必须在指定文本类型之前
先指定对齐方式。例如，如果要让文件名位于页眉中央，请在
“Header”字段中键入 &C&F，或按“>”按钮，并选择
“Center”选项，然后按“>”按钮，并选择“Filename”选项。

除了指定这些选项以外，还可以键入要在页眉和页脚字段中出
现的文本。例如，如果在“Footer”字段中键入 Page &P of &p，
则 Page 1 of 1 将显示在打印文档的页脚中。

• Font size 可用于为打印的文本选择字体磅值。

“Options”对话框：“Query Editor”选项卡

使用该选项卡可以配置 “Query Editor”的设置。

Interactive SQL 的“Options”对话框的“Query Editor”选项卡有以下组件：

• Fully qualify table and column names 如果希望在“Query Editor”中
构建查询时表名和列名需由其所有者名称完全限定，请选中此选项。

• Quote names 如果希望在 “Query Editor”中构建查询时标识符的
名称括在双引号中，请选中此选项。

有关引号标识符的信息，请参见《Sybase IQ 参考手册》第 3 章“SQL
语言元素”中的 “标识符”。

退出 dbisql
使用完 dbisql 后，可以通过 EXIT 命令返回操作系统。

如果现在退出 dbisql，则必须重新启动 dbisql 才能继续学习本教程。
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Interactive SQL Classic (dbisqlc) 实用程序

注意  dbisql 命令现在作为 Interactive SQL 增强版本（一种 Java 应用程序）
运行。 Java 版本有很多优点和更多功能，它包括多个窗口，每个窗口都
可以打开单独的数据库连接。在本节中介绍的 Interactive SQL 实用程序
版本现在称为 dbisqlc，以便将它与 Java 版本区分开来。有关 Java 版本的
信息，请参见“Interactive SQL (dbisql) 实用程序 （第 35 页）”。

dbisqlc 向用户提供数据库浏览和将 SQL 语句发送到数据库服务器的交互
环境。

使用 dbisqlc 可以键入 SQL 命令，或运行命令文件。它还提供有关受影响的
行数、每个命令所需的时间、查询的执行计划以及任何错误消息的反馈。

为了使 dbisql 可正常工作， $HOME 必须存在且必须可由用户写入。

语法 dbisqlc [ options ] [ dbisqlc-command | command-file ]

参数 表 2-5： dbisqlc 选项列出了 dbisqlc 的可用选项。

表 2-5： dbisqlc 选项

用法 注意，对于 Sybase IQ 12，不能使用 “Help”菜单项打开 dbisqlc 的联机
帮助，但在 Sybase Central 中则可找到帮助。在 Sybase Central 中，选择
“Help” >“Sybase IQ Help”，然后单击“Index”选项卡。在“Topic”
或 “Keyword”框中键入 dbisqlc，然后单击 “Go To”按钮。

如果想自定义 dbisqlc，请更改到主目录 ($HOME) 并发出以下命令，以便
将 terminfo 扩展名文件 default.tix 复制到该目录中：

% cp $ASDIR/tix/default.tix .
此文件控制 dbisqlc 的按键序列，并改进命令窗口显示效果。有关详细信
息，请参见 “Shift 和 Control 键 （第 68 页）”。

选项 说明

-c "keyword=value; ..." 提供数据库连接参数

-d delimiter 指定命令分隔符

-q 安静模式 – 没有窗口或消息

-r 如果存储过程的定义结果集与实际结果集不匹
配，则返回错误 “Not enough fields allocated in 
sqlda”。

-x 仅语法检查 – 不执行任何命令
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dbisqlc-command | command-file 如果指定 dbisqlc-command，那么 
dbisqlc 将执行命令。您也可以指定命令文件名。如果没有指定 dbisql-
command，则 dbisqlc 进入可以将命令键入到命令窗口中的交互模式。从 
Windows 的“开始”菜单，通过选择“程序” >“Sybase” >“Adaptive 
Server IQ 12.7” >“Interactive SQL Classic”，可以进入交互模式。

-c "keyword=value; ..." 指定连接参数。有关连接参数的说明，请参见
《Sybase IQ 系统管理指南》中的第 4 章“连接和通信参数”。如果未指
定此选项，会使用环境变量 SQLCONNECT。如果无法连接 Interactive
SQL，则将显示一个对话框，您可以在其中输入连接参数。

注意  为了避免多义性，Sybase 建议始终指定 dbisqlc 的连接参数，而不要
依赖缺省值，您可以在命令行或诸如 UNIX 上的 odbc.ini 或 Windows 上
的 odbc.ini 这样的初始化文件中指定它们。例如，如果一个服务器上启
动了多个数据库，应指定数据库名称，并在带有子网的网络中，指定通
信协议参数和主机号。有关详细信息，请参见 《Sybase IQ 系统管理指
南》中的第 3 章 “Sybase IQ 连接”。

-d 指定命令分隔符。缺省情况下，分隔符是分号。

-q 不显示输出消息。只有在使用命令或命令文件启动 Interactive SQL
时，此选项才有用。

-r 如果存储过程的定义结果集与实际结果集不匹配，则返回错误“Not
enough fields allocated in sqlda”。查询存储过程时此选项特别
有用。

-x 扫描命令，但不执行这些命令。对于检查长命令文件的语法错误，
此选项是很有用的。

示例 本节中的示例将演示在系统命令提示符级别使用 dbisqlc。本章其余 
dbisqlc 部分将讨论如何以交互方式使用 dbisqlc。

• 以下命令在系统提示符下输入，它使用用户 ID DBA 和口令 SQL，对
当前缺省服务器运行命令文件 mycom.sql。注意，对于区分大小写数
据库，缺省口令是区分大小写的；而用户 ID 则不区分。

dbisqlc -c "uid=DBA;pwd=SQL" mycom.sql

• 在系统提示符下输入的以下命令可以将用户添加到当前缺省数据
库中：

dbisqlc -c "uid=dba;pwd=SQL" grant connect to joe 
identified by passwd

另请参见 有关 SQL 语句和 dbisql 命令的详细说明，请参见《Sybase IQ 参考手册》
中的第 6 章 “SQL 语句”。
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启动 dbisqlc
某些用户可能更喜欢使用更早的 Interactive SQL 实用程序 （现在称为
Interactive SQL Classic），它是与 12.7 之前的 IQ 版本一起交付的。注意，
虽然支持 dbisqlc，但 dbisqlc 并未包含 dbisql Java 版本的所有功能。只要
数据库服务器在运行，就可以从 dbisqlc 连接到服务器。此示例介绍与样
本数据库 asiqdemo 的连接。

❖ 从命令提示符启动 dbisqlc 并连接到数据库：

1 请确保样本数据库已装载在运行的服务器上，《Sybase IQ 简介》第
3 章 “运行和连接到服务器”中的 “启动数据库服务器”对此进行
了介绍。

2 通过在 UNIX 或 Windows 系统上的命令提示符下输入以下命令启动
dbisqlc：

dbisqlc -c "uid=DBA;pwd=SQL"

-c 参数用于指定连接参数。有关连接参数的完整列表，请参见
《Sybase IQ 系统管理指南》中的第 4 章 “连接和通信参数”。

注意  asiqdemo 数据库和其它 IQ 数据库的缺省用户 ID 和口令是
“DBA”和 “SQL”。必须始终以大写键入口令，因为缺省设置是 
CASE RESPECT。（用户 ID 永远不区分大小写。） 但是，如果连接
到用 Adaptive Server Anywhere 创建的数据库，则缺省设置可能是小
写。如果在连接到数据库时遇到麻烦，请尝试更改所提供的用户 ID 
和口令的大小写。

❖ 在 Windows 上启动 dbisqlc 并连接到数据库

1 按照 《Sybase IQ 简介》第 3 章 “运行和连接到服务器”中的 “启
动数据库服务器”中的说明启动服务器。

2 选择“开始” >“程序” >“Sybase” >“Adaptive Server IQ 12.7” >
“Interactive SQL Classic”

将显示 dbisqlc “Connect”窗口。



第 2 章    使用 Interactive SQL (dbisql)

实用程序指南 65

3 在 “Login”选项卡上，输入用户 ID 
DBA

和口令 
SQL

这是 Sybase IQ 数据库创建时使用的缺省用户 ID 和口令。（口令在
键入时不会显示。这样可防止他人看到您的口令。） 缺省情况下，对
于区分大小写的数据库，口令区分大小写；用户 ID 不区分。

4 单击 “Database”选项卡并键入服务器名称 （例如，为演示数据库
键入 “hostname_asiqdemo”）。如果服务器在远程计算机上，请确
保选中缺省情况下未选中的复选框 “Search network for database 
servers”。

5 在 “Network”选项卡上，选择 “TCPIP”。

如果数据库在远程计算机上，请通过键入 “host=servername:nnnn”
来添加主机信息，其中，servername 是系统的名称，nnnn 是端口号。
（缺省的端口号是 2638，但是如果主机启动时使用的是另一端口
号，则会改为使用后者。）

6 单击 “OK”以连接到数据库。

dbisqlc 命令窗口
在输入 dbisqlc 命令并连接到数据库之后，将显示 dbisqlc 命令窗口。此窗
口的外观和功能在 UNIX 和 Windows 系统上不同。

UNIX 上的 dbisqlc 命令窗口

如果在 Windows 系统上运行 Interactive SQL Classic，请跳到“Windows
上的 dbisqlc “Command”窗口 （第 70 页）”一节。

UNIX 上的 dbisqlc 窗口划分为三个部分：

• 顶部的 “Data”部分

• 其下的 “Statistics”部分

• 底部的 “Command”部分
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如果正确地按照 “启动 dbisqlc （第 64 页）”中的说明执行操作，则将
在 dbisqlc 的 “Statistics”部分中显示消息 “Connected to database”。

图 2-5： UNIX 上的 dbisqlc 窗口

UNIX 上的 dbisqlc 命令窗口因操作系统而异。例如， Solaris 系统上的
“Common Desktop Environment”窗口与在 OpenWindows 上不同。dbisqlc
命令窗口划分成三个子窗口。顶部是“Data”，中间是“Statistics”，底
部是 “Command”，如图 2-5 所示。

对于 Sybase IQ 12，不能使用 “Help”菜单项打开 dbisqlc 的联机帮助，
但在 Sybase Central 中则可找到帮助。在 Sybase Central 中，选择“Help”
“Sybase IQ Help”，然后单击“Index”选项卡。在“Topic”或“Keyword”
框中键入 dbisqlc，然后单击 “Go To”按钮。

下拉菜单

本章中的教程将指导您从下拉菜单中选择选项。这些菜单位于屏幕的
顶部。



第 2 章    使用 Interactive SQL (dbisql)

实用程序指南 67

执行命令

在 “Command”部分中键入命令，并通过按 F9 功能键 （在 UNIX 上）
或按 “Execute”按钮 （在 Windows 上）来执行命令。

注意  如果终端不支持功能键，请键入 CTRL-F，后跟功能键数字。例如，
对于 F9 功能键，可以键入 CTRL-F 9。如果仍然在执行命令时遇到麻烦，
请按照 “Shift 和 Control 键”中的说明设置 terminfo 扩展名文件。

若要一次输入多个命令，请用分号分隔。

通过键入 CTRL-A F 以激活 “File”菜单，并使用向下箭头从菜单栏中
选择 “File” >“Save”，可以将命令存储到 ASCII 文件中。

若要从 ASCII 文件装载，请键入 CTRL-A F，并从菜单栏中选择“File”>
“Open”。

功能键

dbisqlc 在 UNIX 上使用某些功能键和特殊键，如表 2-6 所述。

表 2-6： UNIX 上的 dbisqlc 功能键和特殊键

功能键 说明

F5 在数据窗口中将数据左移一列

SHIFT+F5 将数据左移一个字符

F6 将数据右移一列

SHIFT+F6 将数据右移一个字符

F7 显示数据库中表的列表。可以使用上箭头键和下箭头
键在表名称中滚动，更改突出显示的表名称。显示列表
后，按 Enter 会将当前表名插入到命令窗口的光标所在
位置。显示表的列表时，可以使用 F7 键，以显示突出
显示的表中的列的列表。然后，再按 Enter 可以选定突
出显示的列名，并将其放入命名窗口的光标所在位置。

CTRL+PgUp 移动到数据的顶部

CTRL+PgDn 移动到数据的底部
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Shift 和 Control 键

如有必要，还可以为要应用于下一个键的 SHIFT 和 CTRL 定义按键序列
（以便可以输入 SHIFT-FunctionKey 或 CTRL-PgDown）。

使用 ALT 键时，某些终端不允许 dbisqlc 加以识别。若要在 dbisqlc 中输
入 ALT- 键，请使用 CTRL-A，后跟将应用 ALT 修饰键的键。例如，要
看见 “File”菜单，请键入 CTRL-A f。如果从远程终端 （例如 VT100
模拟器）使用 dbisqlc，则也许能够将终端配置为使用“emacs 模式”，以
便它将 ALT-< 键 > 作为 ESC < 键 > 发送。 dbisqlc 还将识别这些转义序
列。您可以亲自键入 ESC < 键 >，但必须快速连续地键入它们，否则将
这些键单独加以解释。

如有必要，还可以为要应用于下一个键的 SHIFT 和 CTRL 定义按键序列
（以便可以输入 SHIFT-<FunctionKey> 或 CTRL-PgDown）。

这些序列由 terminfo 扩展名 (.tix) 文件进行控制。dbisqlc 实用程序首先在
${HOME}、/opt/ASIQ-12_7/tix、/opt/ASIQ-12_7/bin 中查找 ${TERM}.tix，
然后在整个 ${PATH} 中查找它。如果找不到 ${TERM}.tix，则 dbisqlc 在
相同目录中搜索 default.tix。示例 default.tix 文件是 Sybase IQ 附带的。

在 dbisqlc 中显示数据

dbisqlc 的主要用途之一是查看数据库中的信息。

此教程中使用了一个虚构的公司的数据库。该样本数据库包含关于雇
员、部门、销售订单等方面的信息。

所有这些信息通过若干表来组织，表中又包括行和列。

列出数据库中的表

Sybase IQ 提供了很多名为系统存储过程的内置函数，以显示有关数据库
的信息。

例如，使用 sp_iqtable 存储过程可以列出样本数据库中的表。若要运行存
储过程，请在 “Command”窗口中键入其名称 （和任何参数）。

有关系统存储过程的详细信息，请参见 《Sybase IQ 参考手册》中的第
10 章 “系统过程”。
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列出职员表的全部列和行

若要列出在数据库表中存储的数据，请在 dbisqlc 命令窗口中键入 SELECT 
命令。键入命令后，请选择 F9 功能键（如果支持）或从菜单中选择
“Command” >“Execute”来执行命令。后面的输出样本显示查询结果
的前几列和行。（它们显示在 dbisqlc 数据窗口中。）本手册中统一使用此
种格式。

键入以下语句：

SELECT *
FROM employee

注释 • SQL 语句不区分大小写。输入 SELECT、select 和 Select 的效果都一
样。在示例中，SQL 关键字以大写显示，但可以不以大写键入它们。

• 可以多行键入 SQL 语句。您可将语句全部以一行键入，也可以随意
分隔为多行。某些 SQL 语句（例如 SELECT 语句）由称为子句的几
个部分组成。在很多示例中，每个子句都放在单独的行上，但可以
不按此方式键入它们。

dbisqlc 的 “Data”窗口显示包含雇员相关信息的一组行和列。每一行包
含一位雇员的相关信息，每一列包含所有雇员的特定信息项。

emp_id manager_id emp_fname emp_lname  ...
102 501 Fran Whitney  ...
105 501 Matthew Cobb  ...
129 902 Philip Chin  ...
148 1293 Julie Jordan  ...
160 501 Robert Breault  ...
...    
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Windows 上的 dbisqlc “Command”窗口

在启动 dbisqlc 之后，将打开 “Interactive SQL Classic”窗口。它分成三
个子窗口。最顶端是 “Data”子窗口，第二个是 “Statistics”子窗口，
在屏幕底部是 “Command”子窗口，如图 2-6 所示。

图 2-6： Windows 上的 dbisqlc 窗口

对于 Sybase IQ 12，不能使用 “Help”菜单项打开 dbisqlc 的联机帮助，
但在 Sybase Central 中则可找到帮助。在 Sybase Central 中，选择“Help”
“Sybase IQ Help”，然后单击“Index”选项卡。在“Topic”或“Keyword”
框中键入 dbisqlc，然后单击 “Go To”按钮。

输入命令

“Command”窗口出现在 dbisqlc 屏幕的底部。它是键入 dbisqlc 命令的标
准编辑控件。如果键入的行数超出此窗口的边缘，则窗口将自动滚动。
可以使用光标键或窗口右侧的滚动条来滚动窗口。此窗口还可以按标准
Windows 方式变得更大，并最大化到全屏。

通过按执行键 (F9) 或单击 “Execute”按钮执行命令。

若要一次输入多个命令，请用分号分隔。通过选择“File” >“Save”，
可以将命令存储到 ASCII 文件中。若要从 ASCII 文件装载它们，请从菜
单栏选择 “Open”。
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在 dbisqlc 中显示数据

dbisql 的主要用途之一是查看数据库中的信息。

此教程中使用了一个虚构的公司的数据库。该样本数据库包含关于雇
员、部门、销售订单等方面的信息。

所有这些信息通过若干表来组织，表中又包括行和列。

可以使用 SELECT 语句显示数据库中的信息。以下示例显示要在 dbisqlc
命令窗口中键入的命令。键入命令后，必须单击“Execute”才能执行该
命令。示例显示查询结果的前几列和行，它们显示在 dbisqlc 数据窗口
中。本手册中统一使用此种格式。

列出职员表的全部列和行

键入以下语句：

SELECT *
FROM employee

注释 • SQL 语句不区分大小写。输入 SELECT、select 和 Select 的效果都一
样。在示例中，SQL 关键字以大写显示，但可以不以大写键入它们。

• 可以多行键入 SQL 语句。您可将语句全部以一行键入，也可以随意
分隔为多行。某些 SQL 语句（例如 SELECT 语句）由称为子句的几
个部分组成。在很多示例中，每个子句都放在单独的行上，但可以
不按此方式键入它们。

dbisqlc 的 “Data”窗口显示包含雇员相关信息的一组行和列。每一行包
含一位雇员的相关信息，每一列包含所有雇员的特定信息项。

emp_id manager_id emp_lname emp_fname  ...
102 501 Fran Whitney  ...
105 501 Matthew Cobb  ...
129 902 Philip Chin  ...
148 1293 Julie Jordan  ...
160 501 Robert Breault  ...
...    
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滚动数据窗口

键入命令时

SELECT * FROM employee

在 dbisqlc 命令窗口中， dbisqlc 数据窗口的可见部分无法容纳整个 
employee 表。

数据窗口的可见部分不显示有关每个雇员的所有信息，也不显示雇员的
整个列表。

查看其它列 若要查看有关每个雇员的详细信息 （即其它列），请使用数据窗口底部
的滚动条。这是标准 Windows 滚动条。

查看其它行 若要查看其他雇员的详细信息 （即其它行），请使用数据窗口右侧的滚
动条。样本数据库中的雇员表包含大约 75 名雇员的信息。

有时，垂直滚动条的行为与标准滚动条有轻微不同，因为结果中的行数
可能是未知的。在这种情况下，将使用猜测行数的方法。如果 dbisqlc 确
定其猜测是错误的，则会调整猜测，并使滑块 “跳跃”。

在 dbisqlc 中重新调用命令

执行另一个命令。

1 键入以下语句：

SELECT * FROM department

2 按 F9。

department 数据库表的内容将显示在 “Data”窗口中。以 dbisqlc 执
行命令时，命令将保存在命令历史记录中。

3 若要重新调用命令，请从菜单栏中选择“Command” >“Recall”。
这将激活命令重新调用窗口。

4 命令重新调用窗口显示已执行的最后 15 条命令的第一行。可以使用
上箭头键和下箭头键在命令中滚动。

5 将光标放在已执行的第一个命令上，该命令是：

SELECT *
FROM employee

然后按 Enter 键。光标将返回命令窗口，并且其中包含所选命令。现
在可以重新执行该命令，或修改它以生成新命令。



第 2 章    使用 Interactive SQL (dbisql)

实用程序指南 73

更多重新调用键 表 2-7： dbisqlc 重新调用键列出还可以用于重新调用以前命令的键。

表 2-7： dbisqlc 重新调用键

功能键

dbisqlc 在 Windows 上使用某些功能键和特殊键，如表 2-8： Windows 上
的 dbisqlc 功能键和特殊键中所列。

表 2-8： Windows 上的 dbisqlc 功能键和特殊键

取消 dbisqlc 命令

使用 “Stop”按钮可以取消命令。

停止操作将停止当前的处理过程，并提示您输入下一条命令。如果正在
处理命令文件，则会提示您指定要执行的操作：停止命令文件、继续或
退出 dbisqlc。通过 dbisql ON_ERROR 选项可以控制这些操作 （请参见
《Sybase IQ 参考手册》中的第 2 章 “数据库选项”）。

按键序列 说明

Ctrl+r 显示命令重新调用窗口

Ctrl+p 向后逐一列出以前执行过的命令。检索到的命令将放
到命令窗口中

Ctrl+n 向前逐一列出以前执行过的命令

功能键 说明

F5 在数据窗口中将数据左移一列

Shift+F5 将数据左移一个字符

F6 将数据右移一列

shift+F6 将数据右移一个字符

F7 显示数据库中表的列表。可以使用上箭头键和下箭头键在
表名称中滚动，更改突出显示的表名称。显示列表后，按
Enter 会将当前表名插入到命令窗口的光标所在位置。显
示表的列表时，可以使用 F7 键，以显示突出显示的表中
的列的列表。然后，再按 Enter 可以选定突出显示的列名，
并将其放入命名窗口的光标所在位置。

F9 执行命令窗口中的命令。此操作还可以用鼠标单击
“Execute”来执行。

F10 激活窗口顶部的菜单

Page Up 在数据页中向上移动

Page Down 在数据页中向下移动

Ctrl+PageUp 移动到数据的顶部

Ctrl+PageDown 移动到数据的底部
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报告的错误 取消命令时，将报告三个不同错误中的某一个，具体取决于何时检测到
结束。

1 如果在 dbisqlc 处理请求时检测到取消 （与数据库引擎相反），则显
示以下消息：

dbisql command terminated by user

dbisqlc 立即停止处理，并搁置数据库事务。

2 如果取消是由数据库引擎在处理数据定义命令（CREATE、DROP、
ALTER 等）时检测到的，则出现以下消息：

Terminated by user -- transaction rolled back

由于数据定义命令都在命令启动前自动执行 COMMIT，所以执行 
ROLLBACK 命令的结果仅仅是取消当前的命令。

当数据库引擎以批量操作模式运行以执行修改数据库的命令
（INSERT 和 DELETE）时，也会出现此消息。在这种情况下，
ROLLBACK 不仅取消当前的命令，还会取消上一次 COMMIT 或 
ROLLBACK 之后执行的所有操作。在某些情况下，数据库引擎可
能要花相当长的时间来执行自动 ROLLBACK。

3 如果取消是由数据库引擎在处理标准数据操纵命令 （SELECT、
INSERT、 DELETE 等）时检测到的，并且该引擎当前未在批量操
作模式下运行，则显示以下消息。

Statement interrupted by user.

将撤消当前命令的执行结果，但事务的剩余部分保持完整。
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第  3  章 数据库管理实用程序

关于本章 Sybase IQ 除了包含数据库服务器外，还包括一组用于执行数据库管
理任务的命令行实用程序。本章提供了大部分数据库管理实用程序
的参考信息。用于启动和停止数据库服务器的实用程序在第 1 章
“运行数据库服务器”中进行了介绍。

目录
主题 页码

管理实用程序概述 76
批量复制实用程序 (iq_bcp) 76
备份实用程序 (dbbackup) 82
CP874toUTF8 实用程序 84
归类实用程序 (dbcollat) 85
复制定义实用程序 (defncopy) 88
数据源实用程序 (iqdsn) 91
文件隐藏实用程序 (dbfhide) 95
信息实用程序 (dbinfo) 97
日志转换实用程序 (dbtran) 98
Ping 实用程序 (dbping) 102
服务器定位实用程序 (dblocate) 104
事务日志实用程序 (dblog) 105
验证实用程序 (dbvalid) 107
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管理实用程序概述
本章提供了有关 Sybase IQ 包含的程序和数据库管理实用程序的参考信息。
这些实用程序可通过 Interactive SQL 访问，或者作为命令行程序访问。

有关 Interactive SQL （亦称 dbisql）的介绍，请参见第 2 章 “使用 
Interactive SQL (dbisql)”。

有关全面的 Sybase Central 文档，请参见 Sybase Central 联机帮助。有关
Sybase Central 数据库管理工具的介绍，请参见 《Sybase IQ 简介》中的
第 3 章 “运行和连接到服务器”。

管理实用程序使用了一组系统环境变量。《Sybase IQ 参考手册》中的第
1 章 “文件位置和安装设置”对这些变量进行了说明。

文件管理语句 对于这些管理实用程序执行的某些任务，也可通过 SQL 语句来执行。
《Sybase IQ 参考手册》的第 6 章 “SQL 语句”中列出了这些语句。

批量复制实用程序 (iq_bcp)
基于 Open Client 的实用程序，用于将数据库表以用户指定的格式复制到
操作系统文件或反向复制。 iq_bcp 位于 $SYBASE\ASIQ-12_7\bin 中。

语法 iq_bcp [ [ database_name. ] owner. ] table_name { in | out } datafile

参数 表 3-1 列出了 iq_bcp 的可用参数。

表 3-1： iq_bcp 参数

选项 说明

-S 指定 iq_bcp 将连接的 Sybase IQ 服务器的名称。

-I 指定连接到 Sybase IQ 时要搜索的 interfaces 文件的名称和位置。

如果不指定 -I，iq_bcp 将在由 SYBASE 环境变量指定的目录下（例
如 Windows 中的 ini 目录）寻找 interfaces 文件，在 Windows 中为
sql.ini。

-U 指定 Sybase IQ 登录名。
-P 指定 Sybase IQ 口令。

如果未指定 -Ppassword， iq_bcp 将提示提供口令。如果口令为 
NULL，可忽略 -P 标志。



第 3 章    数据库管理实用程序

实用程序指南 77

-c 执行复制操作。

如果要在平台间共享数据，则使用这种跨平台文件格式。此参数不
对每个字段都进行提示；它使用 CHAR 作为数据文件中的所有列
的缺省存储类型，不带前缀，使用 \t （制表符）作为缺省的字段终
结符， \n （换行符）作为缺省的行终结符。

-J 指定客户端字符集。

iq_bcp 实用程序支持多字节字符数据。插入或提取数据时， -J
标志会将数据由服务器字符集转换为客户端字符集。如忽略 -J，客
户端字符集将设置为相应平台的缺省值，这样可能会导致错误的数
据转换，因为缺省字符集可能不是客户端所使用的字符集。

有关字符集的详细信息，请参见《Sybase IQ 系统管理指南》中的
第 11 章 “国际语言和字符集”。

-v 显示 iq_bcp 的版本号和版权消息，并将此类信息返回操作
系统。

-t 指定缺省的字段终结符。
-r 指定缺省的行终结符。

从命令行使用 -t 或 -r 参数指定终结符时，必须转义对 UNIX 操作系
统有特殊含义的字符（或 Windows 的命令提示符 shell）。可以在特
殊字符前面加一个反斜杠或使用引号将特殊字符括起来。在 iq_bcp
提示下输入（交互模式）时不必这样。

警告！不要以本机格式在 iq_bcp 中使用 -t 或 -r 参数。否则将出现意
外的结果，并且数据可能会损坏。

-A 指定要用于此 iq_bcp 会话的网络包大小。

下面的示例将网络包大小设置为 4096 字节：
iq_bcp pubs2..titles out table_out -A 4096

packet_size 必须介于缺省网络包大小和最大网络包大小配置变量的
值之间，且必须是 512 的倍数。

使用大于缺省值的网络包大小可提高大批量复制操作的性能。

选项 说明
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用法 iq_bcp 会滤出 BCP 不支持的选项，并支持表 3-1 中列出的附加选项。对
于所有不支持的选项， iq_bcp 都将显示消息。

可以通过发出下面不带参数的命令，查看此类信息：

iq_bcp[.exe]

iq_bcp 提供两种模式：iq_bcp in 和 iq_bcp out。

注意  执行批量拷入或拷出选项时，iq_bcp 提供两种用于保存或读取文件
的格式：本机格式和跨平台格式。 Sybase IQ 仅支持跨平台文件格式。
Sybase IQ 中的任何批量复制操作都不支持本机文件格式。

iq_bcp in 将数据从物理文件插入 Sybase IQ 表。

将数据通过 iq_bcp 插入 Sybase IQ 表之前，必须使用 -c 选项将其以跨平
台文件格式导入。

下表介绍了 iq_bcp in 操作支持的 ASE 数据类型。

表 3-2： 数值数据类型

IQ 数据类型

TinyInt SmallInt Int Unsigned 
Int

Big Int Unsigned 
Big Int

Decimal Real Double

ASE 数据类型

TinyInt 是 是 是 是 是 是 是 是 是

SmallInt — 是 是 是 是 是 是 是 是

Int — — 是 是 是 是 是 是 是

Unsigned Int — — — 是 是 是 是 是 是

Big Int — — — — 是 是 是 是 是

Unsigned Big Int — — — — — 是 是 是 是

Decimal — — — — — — 是 是 是

Real — — — — — — 是 是 是

Double — — — — — — 是 — —
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表 3-3： 字符数据类型 *

*仅对小于 32KB 的输入值提供字符数据类型支持。

表 3-4： 二进制数据类型 *

*要使二进制数据类型支持可用，必须在 IQ 服务器中将数据库选项 
ASE_Binary_Display 设置为 OFF。此选项的缺省值是 ON。请参见《Sybase 
IQ 参考手册》中“数据库选项”部分的“ASE_BINARY_DISPLAY 选
项”。

对于 BINARY 数据类型，仅对小于 256 字节的列提供支持。

对于 VARBINARY 和 LONG BINARY 数据类型，仅对小于 32KB 的列提供
支持。

注意  ASE 数据类型 BIT 由对应的 Sybase IQ 数据类型 BIT 支持。

表 3-5： 日期数据类型

IQ 数据类型

Char VarChar Long VarChar
ASE 数据类型

Char 是 是 是

VarChar 是 是 是

Text 是 是 是

NChar 是 是 是

NVarChar 是 是 是

UniChar — — —
UniVarChar — — —

IQ 数据类型

Binary VarBinary Long Binary
ASE 数据类型

Binary 是* 是* 是*
VarBinary 是* 是* 是*
Long Binary 是* 是* 是*

IQ 数据类型

Date Time Timestamp SmallDatetime Datetime
ASE 数据类型

SmallDatetime — — 是 是 是

Datetime — — 是 是 是
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只要相应的值可以隐式转换，从表 3-2 到表 3-5 中列出的所有支持数据
类型都可转换为任何 Sybase IQ 数据类型。在《Sybase IQ 系统管理指南》
第 7 章 “将数据移入和移出数据库”的表 7-8 中，介绍了在 Sybase IQ
INSERT 操作的数据转换中，哪些为受支持的隐式数据转换。

Sybase IQ 还支持一些与任何 ASE 数据类型不直接兼容的数据类型。表 3-6
介绍了所有的 Sybase IQ 数据类型及其在 ASE、BCP 和 ASA 的等效数据类
型。表 3-6 未列出在 Sybase IQ 中定义的别名或域。

表 3-6： IQ 数据类型

注意  iq_bcp in 和 iq_bcp out 操作支持的唯一非 ASE 数据类型是可为空的
BIT 数据类型。

IQ 数据类型 ASE 数据类型 BCP 数据类型 ASA 数据类型

数值数据类型

Tiny Int Tiny Int CS_TINYINT Unsigned Tiny Int
Small Int Small Int CS_SMALLINT Signed Small Int
Int Int CS_INT Signed Int
Unsigned Int Unsigned Int CS_UINT_TYPE Unsigned Int
Big Int Big Int CS_BIGINT_TYPE Big Int
Unsigned Big Int Unsigned Big Int CS_UBIGINT_TYPE Unsigned Big Int
Decimal Decimal CS_DECIMAL Decimal
Real Real CS_REAL Real
Double Double Precision CS_FLOAT Double
字符数据类型

Char Char CS_CHAR Char
VarChar VarChar CS_VARCHAR VarChar
Long VarChar Text CS_TEXT Long VarChar
二进制数据类型

Binary Binary CS_BINARY Binary
VarBinary VarBinary CS_VARBINARY VarBinary
Long Binary Image CS_IMAGE Long Binary
位数据类型

Bit Bit CS_BIT Bit
Bit，允许为空 — CS_BIT Bit，允许为空

日期数据类型

Date — — Date
Time — — Time
Timestamp Datetime CS_DATETIME Timestamp
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iq_bcp out 将数据从 Sybase IQ 表提取到物理文件。

对于要从 Sybase IQ 表中提取出的数据，包括来自 ASE 和 ASA 表但将导
入回 Sybase IQ 表的数据，必须先使用 -c 选项以跨平台文件格式导出。

选项 database_name 如果要复制的表位于您的缺省数据库或主数据库中，
则此选项可选。否则，必须指定数据库名称。

owner 如果您或数据库所有者拥有要复制的表，则此参数是可选项。如
果未指定所有者， iq_bcp 首先查找您所拥有的表中是否有此名称的表，
然后查找数据库所有者所拥有的表中是否有此名称的表。如果其他用户
拥有此表，则必须指定所有者名，否则命令将失败。

table_name 是要复制的数据库表的名称。表名不能是 Transact-SQL 保
留字。

in | out 是复制方向。 in 表示从文件向数据库表中复制，必须使用 -c 选
项将其以跨平台文件格式导入。out 表示从数据库表或视图向文件复制，
必须使用 -c 选项将其以跨平台文件格式导出。

datafile 指定一个唯一数据文件，或由多个唯一数据文件组成的组，各
文件之间使用逗号分隔。iq_bcp in 和 iq_bcp out 都支持该参数。路径名的
长度可以是 1 到 255 个字符。

约束 如果一个表包含小数列，则仅在其小数列的精度小于或等于 38 位的情况
下，才可对该表使用 iq_bcp out。

精度用于指定能够在列中存储的最大小数位数。精度包括小数点左右两
侧的所有位数。您可以将精度范围指定为 1 位至 38 位，或者使用缺省的
18 位精度。

请参见 《Sybase IQ 参考手册》中第 4 章 “SQL 数据类型”的数值数据
类型。

• 如果输入中的任何字符列值仅包含一个或多个空格，则在表的对应
列中将插入长度为零的字符串。

• 除 TEXTSIZE 以外的所有服务器选项的非缺省值，对于 iq_bcp 客户
端都无效。

另请参见 《Sybase IQ 系统管理指南》第 7 章 “将数据移入和移出数据库”中的
表 7-8

《Sybase IQ 参考手册》第 2 章 “数据库选项”中的
“ASE_BINARY_DISPLAY 选项” 

《Sybase IQ 参考手册》中的第 4 章 “SQL 数据类型” 
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备份实用程序 (dbbackup)
备份实用程序用于对正在运行的 IQ 数据库的事务日志制作副本。使用
此实用程序可在无需停止再重新启动服务器的情况下截断事务日志，从
而可释放磁盘空间并提高恢复速度。

注意  对于备份整个 Sybase IQ 数据库，通常使用 BACKUP 语句，而非 
dbbackup。 BACKUP 可备份所有数据库文件，是备份目录存储的唯一方
式。有关详细信息，请参见《Sybase IQ 参考手册》中的 “BACKUP 
语句”。

语法 dbbackup [options] target-directory

参数 下表列出了 dbbackup 实用程序的可用选项。

表 3-7： dbbackup 选项

用法 备份实用程序可用于在其它应用程序或用户还在使用数据库的同时备份
事务日志。备份文件名都与数据库文件名相同。

如果具有足够的磁盘空间，可使用 -r 将现有的日志文件使用新名称另
存，然后启动新的空日志。如果磁盘空间有限，可改用 -xo 截断现有的
日志。

退出代码为 0 （成功）或非零值 （失败）。

选项 @data 读取来自指定的环境变量或配置文件的选项。如果指定的环境
变量和配置文件同名，则 Sybase IQ 使用环境变量。

有关配置文件的详细信息，请参见《Sybase IQ 安装和配置指南》。

如果要保护配置文件中的口令或其它信息，您可以使用文件隐藏实用程
序 (dbfhide) 对配置文件的内容进行模糊处理。有关详细信息，请参见“文
件隐藏实用程序 (dbfhide)”。

选项 说明

@data 从指定的环境变量或配置文件中读取选项

-c "keyword=value; ... " 提供数据库连接参数

-l (lowercase L) file 将事务日志活动备份到文件

-q 安静模式 – 不显示消息

-r 将旧的事务日志复制到新名称的文件下，然后
启动新的空日志

-xo filename 截断 （删除并重新启动）事务日志



第 3 章    数据库管理实用程序

实用程序指南 83

连接参数 (-c) 如果没有指定连接参数，则使用 SQL CONNECT 环境变量
中的连接参数（如果已设置）。用户 ID 必须具有 DBA 授权或 REMOTE
DBA 授权。

有关连接参数的说明，请参见 《Sybase IQ 系统管理指南》中的第 4 章
“连接和通信参数”。

活动备份（-l （小写 L）） 发生服务器崩溃时，使辅助系统能够快速启
动。活动备份不会终止，而是随服务器的运行持续运行。它会一直运行，
直到主服务器崩溃。在主服务器崩溃时，活动备份会停止，但是已备份
的日志文件保持原状，并且可以用于快速启动辅助系统。

与活动事务日志相比，事务日志的活动备份总是与其等长或比其更短。
在活动备份运行过程中，如另一个备份重新启动事务日志 (dbbackup -x)，
则活动备份会自动截断活动备份日志，并在该新事务日志的开始处重新
启动活动备份。

有关活动备份的详细信息，请参见《Sybase IQ 系统管理指南》中的“对
事务日志执行实时备份”。

将输出消息记录到文件 (-o) 将输出消息写入指定的文件。

安静地运行 (-q) 不显示输出消息。只有在命令提示符下运行此实用程序
时才可以使用此选项。

重命名并启动新的事务日志 (-r) 强制执行检查点操作和以下三个步骤：

• 复制当前的工作事务日志并将其保存到在命令中指定的目录。

• 当前事务日志仍保留在其当前目录中，但是使用格式 yymmddxx.log
对其重命名，其中 xx 是从 AA 到 ZZ 的连续字符，yymmdd 代表当前
的年、月和日。然后，此文件就不再是当前事务日志了。

• 生成一个不包含事务的新事务日志文件。此新文件具有旧的当前事
务日志的名称，并将成为新的当前事务日志。

只备份事务日志文件 (-t) 此选项可以用作增量备份，因为事务日志可应
用于数据库文件的最新备份副本。

删除并重新启动事务日志而不进行备份 (-xo) 删除当前事务日志并启动新
的事务日志。此操作不执行备份；其目的是释放磁盘空间。

target-directory 备份文件所复制至的目录。如果该目录不存在，则 
Sybase IQ 会进行创建。父目录必须存在。
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示例 下面的 Windows 命令将在 sample_server 服务器上运行的 asiqdemo 数据
库的事务日志备份到目录 asiqbackup 下，连接时使用用户 ID DBA，口令
SQL：

dbbackup -c 
"eng=sample_server;dbn=asiqdemo;uid=DBA;pwd=SQL" 
c:\sample\asiqbackup

下面的命令使用 dbbackup 的 -xo 选项将事务日志删除并启动同名的新日
志，并使用 -l 选项以在连接到活动数据库的情况下执行同等操作：

dbbackup -l -xo -c 
"eng=sample_server;dbn=asiqdemo;uid=DBA;pwd=SQL"

CP874toUTF8 实用程序
CP874toUTF8 实用程序将数据由 CP874 字符集转换为 UTF8 归类，后者
是 Sybase IQ 针对泰语提供支持的唯一归类。无法装载使用 CP874 字符
集的数据，而是必须使用此实用程序将其转换为 UTF8。

语法 CP874toUTF8 [CP874InputFile]

用法 仅可在命令提示符下运行此实用程序。

CP874toUTF8 读取使用 CP874 字符集的指定文件（或如未指定文件，为
标准输入），然后通过 UTF8 转换提供标准输出。

注意  包含嵌入的 NULL 字符 （“\0”）的文件无法正确转换。请在运行
此实用程序前删除此类字符。

处理大数据文件时，需多加小心，因为 UTF8 输出可能大至输入数据的
4 倍。输入和输出文件大小都必须满足操作系统的相应限制。

CP874toUTF8 在成功完成时将返回为 0 的退出状态。非零退出状态指示
发生了错误。CP874toUTF8 实用程序会将所有错误消息写入 stderr 中。

CP874toUTF8 调用 Sybase Unicode Infrastructure Library (Unilib®) 执行数
据转换。如果 Unilib 无法转换相应数据， CP874toUTF8 将报告下面的转
换错误：

uniconv_unistrFromS failed
uniutf8_unistrToUTF8 failed

如果转换失败，可将文件拆分为更小的部分进行转换，以隔离转换失败
的点。如果无法解决此问题，请与 Sybase 技术支持部门联系。
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归类实用程序 (dbcollat)
“归类”命令行实用程序 dbcollat 可将归类 （排序序列）提取到一个文
件，以便使用自定义归类创建数据库。

语法 dbcollat [options] output-file

参数 下表列出了 dbcollat 实用程序的可用选项。

表 3-8： dbcollat 选项

此实用程序接受 @filename 参数。

用法 由 dbcollat 生成的文件可以修改，并可与 Sybase Central 或 CREATE 
DATABASE 的 COLLATION 选项一起使用，以实现使用自定义归类创建
新数据库的目的。

退出代码为 0 （成功）或非零值 （失败）。

如果在尚未创建数据库的情况下创建自定义归类，可从样本数据库提取
归类。

有关自定义归类序列的详细信息，请参见《Sybase IQ 系统管理指南》中
的第 11 章 “国际语言和字符集”。

您必须更改归类文件中下面一行上的标签。如果您不更改该标签，则自
定义归类将与它所基于的原始归类冲突。

Collation label (name)

选项 连接参数 (-c) 有关连接参数的说明，请参见 《Sybase IQ 系统管理指
南》中的第 4 章 “连接和通信参数”。如果没有指定连接参数，则使用
SQLCONNECT 环境变量中的连接参数 （如果已设置）。

例如，下面的 Windows 命令从运行在 sample_server 服务器上的 asiqdemo
数据库中提取归类文件，并使用用户 ID DBA 和口令 SQL 进行连接：

选项 说明

-c "keyword=value; ..." 提供数据库连接参数

-d filename 使用位于 mapping-file 中的归类映射将定义文
件转换为 INSERT 语句

-e 包括空映射

-o filename 将消息记录到一个文件

-q 安静模式 – 不显示消息

-v 显示 IQ 软件的版本

-x 使用十六进制表示扩展字符 (7F-FF)
-y 替换文件而无需确认

-z col-seq 指定归类序列标签
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dbcollat -c 
"eng=sample_server;dbn=asiqdemo;uid=DBA;pwd=SQL" 
c:\sample\col

将定义文件转换为 INSERT 语句 (-d) 在创建数据库时，相应归类会被插
入到 SYS.SYSCOLLATION 系统表中。从该归类到字符集以及 Sybase TDS
归类的映射也会被插入到 SYS.SYSCOLLATIONMAPPINGS 系统表中。此
归类是从 collseqs.sql 文件所提供的一组归类中或从 Sybase IQ 安装目录
下 scripts 子目录的 custom.sql 文件的自定义归类中选择的。

有关 SYSCOLLATIONMAPPINGS 系统表的详细信息，请参见 《Sybase IQ
参考手册》中的 “SYSCOLLATIONMAPPINGS 系统表”。

将自定义归类添加到 custom.sql 脚本。-d 选项可将所编辑的归类文件转
换为可以复制到 custom.sql 中的 INSERT 语句。

例如，可以将 -d 选项与 dbcollat 命令一起使用，如下所示：

dbcollat -d coll-defn-file custom-file

coll-defn-file 被作为归类定义读取和分析。输出将写入到 custom-file。必
须将 custom-file 的内容添加到 custom.sql 中。

有关使用 -d 选项创建自定义归类的详细信息，请参见 《Sybase IQ 系统
管理指南》中的 “创建自定义归类”。

包括空映射 (-e) 通常，归类不指定字符要排序到的实际值，而是规定
归类的每一行的排序位置都比其上一行高一个位置。但是，较旧的归类
在某些排序位置之间存在间断。通常，归类实用程序会跳过这些间断位
置，并使用显式排序位置写入下一行。此选项将导致归类实用程序为间
断位置的每一行写入空映射 （只包含冒号 （:））。

向文件记录消息 (-o) 将输出消息写入指定的文件。

安静地运行 (-q) 不在窗口中显示消息。

显示版本 (-v) 显示 IQ 的版本号。

使用十六进制表示扩展字符 [ 7F 到 FF ] (-x) 根据您计算机上的代码页与
要提取的归类的代码页是否相同，扩展的单字节字符（其值大于十六进
制的 7F）在屏幕上的显示不一定正确。此选项可导致归类实用程序将对
应于十六进制的 7F 或更大数的任何字符写为 \xdd 形式的两位十六进制
数。例如：

\x80, \xFE

如果不使用 -x 选项，则只将从十六进制的 00 到十六进制的 1F、7F 和 FF
字符以十六进制形式写出。

在不确认操作的情况下运行 (-y) 如果选择了此选项，则自动替换现有归
类文件，而不提示进行确认。
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指定归类序列标签 (-z) 指定要提取的归类的标签。可以通过执行下面
的命令，找出相应归类序列的名称：dbinit -1。如果未指定此选项，归
类实用程序将提取相应数据库所使用的归类。有关归类的详细信息，请
参见 《Sybase IQ 系统管理指南》第 11 章 “国际语言和字符集”中的
“了解归类”。

如果使用一个可用归类标签指定了 -z 选项，则 dbcollat 不会连接到数据
库。否则，它将连接到数据库并提取该数据库的归类。如果该归类标签
与数据库的归类标签不匹配，则返回一个错误。

如果未指定 -z，则使用缺省的归类。对于低位 128 个字符，使用常规的
ASCII （二进制）排序。对于高位 128 个字符 （也称为扩展字符），为
低位 128 个字符中某个字母的带重音符形式的任何字符会与不带重音符
号形式的字符排在相同的位置。扩展字符是否为加变音的字母是根据代
码页 850 （多语言代码页）确定的。

有关可用归类标签的列表，请参见 《Sybase IQ 系统管理指南》第 11 章
“国际语言和字符集”中的 “提供的归类和建议使用的归类”。

示例 下面的 Windows 命令从运行在 sample_server 服务器上的 asiqdemo 数据
库中提取归类文件，并使用用户 ID DBA 和口令 SQL 进行连接：

dbcollat -c 
"eng=sample_server;dbn=asiqdemo;uid=DBA;pwd=SQL" 
c:\sample\col

下面的命令使用 dbcollat 的 -z 选项提取归类 850 的详细信息：

dbcollat -c "uid=DBA;pwd=SQL;eng=sample_server" -z 850 
c:\sample\col

另请参见 有关自定义归类序列的详细信息，请参见《Sybase IQ 系统管理指南》中
的第 11 章 “国际语言和字符集”。
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复制定义实用程序 (defncopy)
defncopy 实用程序可以将指定的过程、视图或 Adaptive Server Anywhere
触发器的定义从数据库复制到操作系统文件，或从操作系统文件复制到
数据库。

语法 defncopy
[-I interfaces_file]
[-P password]
[-R remote_server_principal]
[-S [server_name]]
[-U username]
[-z language]
{ in file_name database_name | 
out file_name database_name [owner.]object_name
[[owner.]object_name...] }

或 
defncopy -v

参数 -I interfaces_file 指定连接到 Sybase IQ 时要搜索的 interfaces 文件的名
称和位置。如果未指定 -I，则在 UNIX 平台上， defncopy 将在 SYBASE
环境变量指定的目录中查找一个名为 interfaces 的文件；而在 Windows
上，将在 Sybase 版本目录的 ini 子目录中查找 sql.ini。
-P password 指定口令。如果未指定 -P， defncopy 将提示提供口令。

-R remote_server_principal 指定远程服务器的主管名。缺省情况下，服
务器的主管名与服务器的网络名 （由 -S 参数或 DSQUERY 环境变量指
定）相匹配。当服务器的主管名和网络名不一致时，使用 -R 参数。

-S server_name 指定要连接的 Sybase IQ 服务器的名称。如果指定 -S 时
未使用任何参数，则 defncopy 将寻找名为 SYBASE 的服务器。如果未指
定 -S，则 defncopy 将使用由 DSQUERY 环境变量指定的服务器。如果未
指定 -S 且 DSQUERY 环境变量未设置，则会返回下面的错误消息：
“FATAL ERROR: A server name has not been specified. Check 
the value of your DSQUERY environment variable.”

-U username 指定登录名。登录名区分大小写。如果没有指定 
username， defncopy 将使用当前用户的操作系统登录名。

-z language 服务器用来显示 defncopy 提示和消息的替代语言的正式名
称。如未指定 -z 标志， defncopy 使用服务器的缺省语言。
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在 -z 参数中指定的替代语言可以是 $SYBASE/locales 目录下缺省提供的
十种语言 （以及 Unicode）之一。这些语言包括：中文、法语、德语、
日语、韩语、波兰语、葡萄牙语、西班牙语、泰语、 Unicode 和美国英
语。如果指定的语言未包含在 $SYBASE/locales 中，defncopy 将使用缺省
的美国英语提供提示和消息。在这种情况下，将返回信息性消息以告知
defncopy 正在使用缺省语言 – 美国英语。其它语言许可能够单独购买。

in | out 指定定义复制的方向。

file_name 指定用于定义复制的操作系统目标文件名或源文件名。拷出
操作覆盖任何现有文件。

database_name 指定将对其拷入或从其拷出定义的数据库的名称。

owner 如果您或数据库所有者拥有要复制的表，则此参数是可选项。如
果未指定所有者， defncopy 首先查找您所拥有的表中是否有此名称的
表，然后查找数据库所有者所拥有的表中是否有此名称的表。如果其他
用户拥有此表，则必须指定所有者名，否则命令将失败。

object_name 指定将由 defncopy 拷出的数据库对象的名称。拷入定义
时，不要使用 object_name。
-v 显示 defncopy 的版本和版权消息，并将此类信息返回操作系统。

用法 如果正在 IBM 平台上使用线程驱动程序，请使用 defncopy 的此语法。

必须首先将 SYBASE 环境变量设置为 Sybase IQ 的当前版本所在位置，
然后才能使用 defncopy。

直接从操作系统调用 defncopy 程序。defncopy 提供了一种将视图、规则、
缺省值、触发器或过程的定义 （CREATE 语句）从数据库拷出到操作系
统文件中的非交互式方式。另外，也可从指定文件拷入所有定义。

in filename 或 out filename 以及数据库名称都是必需参数，必须明确指定。
对于拷出操作，需使用既能体现对象名又能体现对象所有者的文件名。

defncopy 使用此注释结束其拷出的每个定义：

/* ### DEFNCOPY: END OF DEFINITION */

以文本形式创建的定义必须以此注释结束， defncopy 才能成功地完成拷
入操作。

如果 defncopy 中指定的值包含对于操作系统 shell 具有特殊含义的字符，
需将这些值用引号括起。

警告！如在 CREATE 语句前放置超过 100 个字符的长注释，可能会导致
defncopy 失败。
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权限 必须拥有对 SYSOBJECTS 和 SYSCOMMENTS 表的 SELECT 权限，才能拷
出定义；不需具有对于对象本身的权限。

必须具有对 SYSPROCEDURE 表的 SELECT 权限才能拷出存储过程定义，
具有对 SYSTABLE 表的 SELECT 权限才能拷出视图定义。

如果未拥有对 syscomments 表中 text 列的 SELECT 权限，则必须由对象
所有者或系统管理员执行 defncopy 才能拷出定义。

注意  如果文本已经过加密，那么即使拥有所有必需的权限也可能无法看
到此类文本。有关详细信息，请参见《Sybase IQ 中的加密列》。

对于要拷入的对象类型，必须具有相应的 CREATE 权限。拷入对象属于
对象复制者。代表用户拷入定义的系统管理员必须以该用户的身份登
录，从而向该用户授予对重建数据库对象的适当访问权限。

示例 示例 1 将定义从 new_proc 文件拷入 MERCURY 服务器上的 stagedb 数据
库中。与 MERCURY 的连接是使用“sa”用户名和 NULL 口令建立的：

defncopy -Usa -P -SMERCURY in new_proc stagedb

示例 2 将 sp_calccomp 和 sp_vacation 对象的定义从 SYBASE 服务器上的
employees 数据库拷入 dc.out 文件中。消息和提示以法语显示。将提示用
户输入口令：

defncopy -S -z french out dc.out employees sp_calccomp 
sp_vacation

另请参见 《Sybase IQ 参考手册》第 6 章“SQL 语句”中的“CREATE PROCEDURE
语句”“CREATE PROCEDURE 语句 [T-SQL]”“CREATE VIEW 语句”
和 “SELECT 语句”

《Sybase IQ 参考手册》第 10 章 “系统过程”中的 “sp_iqprocedure 过
程”“sp_iqview 过程”“sp_iqhelp 过程”和 “sp_iqcheckdb 过程”
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数据源实用程序 (iqdsn)
数据源实用程序是 ODBC 管理员用于创建、更改、删除、说明和列出
Sybase IQ ODBC 数据源的跨平台替代工具。在 Windows 操作系统上，数
据源保存在注册表中。在 UNIX 操作系统上，数据源保存在 .odbc.ini 文
件中。此命令行实用程序对于批处理操作是很有用的。

语法 iqdsn [ modifier-options ]
{ -l [ u ] [ s ] [ qq ]
| -d [ u ] [ s ]dsn 
| -g [ u ] [ s ] dsn 
| -w [ u ] [ s ] dsn [details-options;...] 
| -cl [ qq ] }

参数 下表列出了 iqdsn 实用程序的可用选项。

表 3-9： iqdsn 的主要选项

表 3-10： iqdsn 修饰符选项

主要选项 说明

-l [ u ] [ s ] [ qq ] 列出所有 Sybase IQ 用户数据源或所有 Sybase IQ 系统数据源。您也可
将所有用户数据源和系统数据源都列出。缺省为用户数据源。将此选项
与 -qq 一起使用将列出 DSN，但不列出任何旗标或标题。

-d [ u ] [ s ] dsn 删除指定的 Sybase IQ 用户数据源或 Sybase IQ 系统数据源。缺省为用
户数据源。

-g [ u ] [ s ] dsn 列出 （获取）有关指定的 Sybase IQ 用户数据源或 Sybase IQ 系统数据
源的详细信息。缺省为用户数据源。

-w [ u ] [ s ] dsn [ details-options ] 创建 （写入）用户数据源或系统数据源的定义。缺省为用户数据源。

-cl [ qq ] 列出可用的连接参数。将此选项与 -qq 一起使用将列出可用的连接参
数，但不列出任何旗标或标题。

修饰符选项 说明

-b 摘要。输出数据源的连接字符串

-q 安静。不输出旗标

-v 详细。以表格形式输出连接参数

-va 所有详细信息。以 -v 的同样格式输出连接参数，但还包含其它隐藏参
数。使用此选项可显示远程数据访问（在支持此类访问的 UNIX 平台
上）或某些第三方驱动程序管理器所需的 ODBC 驱动程序限定符。

-y 删除或覆盖数据源而无需确认
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表 3-11： iqdsn 详细选项

用法 iqdsn 修饰符选项可以出现在主要选项说明之前或之后。仅在多次指定连
接参数值的情况下，这种先后次序才具有意义。在这种情况下，会使用
最后一个指定的值。

主要选项 列出定义的数据源 (-l) 列出可用的 Sybase IQ ODBC 数据源。您可以使
用 -b 或 -v 选项修改列表格式。您可以使用 u（用户）或 s（系统）分类
符修改该选项。缺省分类符是 u。

删除指定的数据源 (-d) 删除指定的数据源。您可以使用 u（用户）或 s
（系统）分类符修改该选项。缺省分类符是 u。如果提供 -y，则覆盖任何
现有数据源而无需确认。

列出 （获取）指定数据源的详细信息 (-g) 列出（获取）指定数据源的定
义。您可以使用 -b 或 -v 选项修改输出的格式。您可以使用 u （用户）
或 s （系统）分类符修改该选项。缺省分类符是 u。

创建 （写入）数据源定义 (-w) 创建新数据源；如果存在同名的数据
源，则将其覆盖。您可以使用 -u （用户）或 s （系统）分类符修改该选
项。缺省分类符是 u。如果提供 -y，则覆盖任何现有数据源而无需确认。

列出可用的连接参数 (-cl) 这是列出 iqdsn 实用程序支持的连接参数的
便捷选项。

修饰符选项 输出数据源的连接字符串 (-b) 将列表的输出格式设置为单行连接字
符串。

不输出旗标 (-q) 取消信息性旗标。

不输出旗标或标题 (-qq) 取消信息性旗标或标题。此选项只能与 -l 和 -cl
选项一起使用。

以表格形式输出连接参数 (-v) 将列表的输出格式设置为数行 （即表格
形式）。

详细选项 说明

-c "keyword=value;..." 提供数据库连接参数

-ec encryption type 对所有网络包进行加密

-o filename 将客户端消息写入 filename
-p size 设置最大网络包大小

-r 禁止多记录提取

-tl seconds 客户端活动超时周期

-x list 列出要运行的网络驱动程序

-z 显示调试信息

server-name 连接到指定的数据库服务器
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删除或覆盖数据源而无需确认 (-y) 自动删除或覆盖每个文件，而不提示您
进行确认。

详细选项 连接参数 (-c) 将连接参数指定为连接字符串。

有关详细信息，请参见 《Sybase IQ 系统管理指南》中的第 4 章 “连接
和通信参数”。

对网络包进行加密 (-ec) 对在客户端应用程序和服务器之间发送的包
进行加密。

有关详细信息，请参见《Sybase IQ 系统管理指南》中的“Encryption 连
接参数 [ENC]”（第 136 页）。

将输出消息记录到文件 (-o) 将输出消息写入指定的文件。缺省情况下，
消息被写入到主控台。

有关详细信息，请参见《Sybase IQ 系统管理指南》中的“LogFile 连接
参数 [LOG]”（第 142 页）。

安静地运行 (-q) 不显示输出消息。该选项仅在命令行实用程序中可用。

设置最大网络包大小 (-p) 网络通信包的最大大小（以字节为单位）。该
值必须大于 300 且小于 16000。缺省设置是 1492。

有关详细信息，请参见 《Sybase IQ 系统管理指南》中的
“CommBufferSize 连接参数 [CBSize]”（第 128 页）。

禁止多记录提取 (-r) 缺省情况下，在数据库服务器获取简单提取请求
时，应用程序将要求提供额外行。您可以使用此选项禁止此行为。

有关详细信息，请参见 《Sybase IQ 系统管理指南》中的
“DisableMultiRowFetch 连接参数 [DMRF]”（第 135 页）。

设置客户端活动超时 (-tl) 在连接不再保持完好状态时将其终止。该值
以秒为单位。

缺省为服务器设置，其缺省值为 120 秒。

有关详细信息，请参见 《Sybase IQ 系统管理指南》中的
“LivenessTimeout 连接参数 [LTO]”（第 141 页）。

设置通信链接 (-x) 要运行的网络驱动程序的列表 （以逗号分隔）。

有关详细信息，请参见 《Sybase IQ 系统管理指南》中的 “CommLinks
连接参数 [Links]”（第 129 页）。

显示调试信息 (-z) 启动时提供有关通信链接的诊断信息。

服务器名称 连接到指定的服务器。只使用前 40 个字符。

有关详细信息，请参见第 1 章 “运行数据库服务器”。
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示例 编写数据源 newdsn 的定义。如果已存在同名数据源，不提示您进行确认。

iqdsn -y -x tcpip -w newdsn -c "uid=DBA;pwd=SQL" -v

您还可以更改选项的顺序 :
iqdsn -w newdsn -c "uid=dba;pwd=sql" -x tcpip -y

列出所有的已知用户数据源，一个数据源名称占一行：

iqdsn -l

列出所有的已知系统数据源，一个数据源名称占一行：

iqdsn -ls

列出所有数据源以及与其关联的连接字符串：

iqdsn -l -b

报告用户数据源 MyDSN 的连接字符串：

iqdsn -g MyDSN

报告系统数据源 MyDSN 的连接字符串：

iqdsn -gs MyDSN

删除数据源 BadDSN，但是首先列出 BadDSN 的连接参数，并提示您进行
确认：

iqdsn -d BadDSN -v

删除数据源 BadDSN，但不提示您进行确认。

iqdsn -d BadDSN -y

为数据库服务器 MyServer 创建名为 NewDSN 的数据源：

iqdsn -w NewDSN -c "uid=DBA;pwd=SQL;eng=bar"

如果 NewDSN 已经存在，则覆盖以前的定义。

下面的示例将连接到 sample 数据库服务器。服务器名称 sample 将覆盖之
前指定的值 MyServer：

iqdsn -w NewDSN-c "uid=DBA;pwd=SQL;eng=MyServer" sample

列出所有连接参数名及其别名：

iqdsn -cl

另请参见 《Sybase IQ 系统管理指南》第 3 章“Sybase IQ 连接”中的“使用 ODBC
数据源”和 “在 UNIX 上使用 ODBC 数据源”。
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文件隐藏实用程序 (dbfhide)
使用文件隐藏实用程序 dbfhide 可以向配置文件和初始化文件添加简单
加密，以隐藏各个文件的内容。

平台
仅 Windows 平台支持 dbfhide 实用程序。

语法 dbfhide original-configuration-file encrypted-configuration-file

参数 下表列出了 dbfhide 实用程序的可用选项。

用法 某些实用程序使用配置文件保存命令行选项。这些选项可能包含口令。
您可以使用 dbfhide 实用程序向配置文件、 Sybase IQ 及其实用程序使用
的 .ini 文件添加简单加密，从而对文件内容进行模糊处理。原始文件将
不会发生更改。向文件添加简单加密后，无法将其删除。若要对模糊处
理后的文件进行更改，您必须保存原始文件的副本，以便可以修改并再
次进行模糊处理。

隐藏 .ini 文件的内容 在许多情况下，Sybase IQ 希望 .ini 文件具有特定名称。若要向一个具有
重要名称的文件 （比如 asaldap.ini）添加简单加密，您需要在向该文件
添加简单加密前用不同的名称保存原始文件的副本。如果您没有保存原
始文件的副本，那么一旦对其进行了模糊处理，您就不能再修改此文件
的内容。以下步骤解释如何向 .ini 文件添加简单加密。

❖ 隐藏 .ini 文件的内容

1 将该文件使用不同的名称保存。

rename asaldap.ini asaldap.ini.org

2 使用文件隐藏实用程序对文件进行模糊处理，并将模糊处理后的文
件命名为要求的文件名：

dbfhide asaldap.ini.org asaldap.ini

3 使用文件系统或操作系统保护功能来保护 asaldap.ini.org 文件，或将
此文件存储到一个安全位置。

要更改 asaldap.ini 文件，可编辑 asaldap.ini.org 文件并重复步骤 2。

选项 说明

original-configuration-file 原始文件的名称。

encrypted-configuration-file 进行模糊处理后的新文件的名称。



文件隐藏实用程序 (dbfhide) 

96  Sybase IQ

警告！在 UNIX 上，除非仅使用 Sybase IQ 数据源，否则，不应使用文件
隐藏实用程序 (dbfhide) 向 .odbc.ini 系统信息文件添加简单加密。如果计
划使用其它数据源，那么对 .odbc.ini 文件内容进行模糊处理可能会妨碍
其它驱动程序的正常工作。

该实用程序不能使用 @data 参数从配置文件中读入选项。

示例 创建用于启动个人数据库服务器和样本数据库的配置文件。应设置 
10MB 的高速缓存，并将此个人服务器实例命名为 Elora。该配置文件
编写如下：

# Configuration file for server Elora -n Elora -c 10M 
path\asademo.db

（注意，以 # 开头的行是注释。）

将该文件命名为 sample.txt。如果要用该配置文件启动数据库，命令行
应为：

start_asiq @sample.txt

现在，向配置文件添加简单加密。

dbfhide sample.txt encrypted_sample.txt

使用 encrypted_sample.txt 文件启动数据库。

start_asiq @encrypted_sample.txt

有关加密的详细信息，请参见《Sybase IQ 中的加密列》。

有关如何使用配置文件的详细信息，请参见《Sybase IQ 安装和配置指南》。

下面的命令向 asaldap.ini 文件添加简单加密：

dbfhide asaldap.ini encrypted_asaldap.ini
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信息实用程序 (dbinfo)
“信息”命令行实用程序 dbinfo 用于显示有关数据库目录存储的信息。

注意  dbinfo 实用程序返回的信息仅与目录存储有关，不涉及 IQ 存储。

语法 dbinfo [ options ]

参数 下表列出了 dbinfo 实用程序的可用选项。

表 3-12： dbinfo 选项

用法 dbinfo 实用程序可指示数据库的创建时间、所维护的任何事务日志文件
或日志镜像的名称、目录存储页大小、所安装的 Java 类的版本以及其它
信息。另外，它还可以提供 Catalog 表的使用情况统计和详细信息。注
意，如果数据库不具有 SYSCOLLATION 表，将不会返回归类名。

选项 连接参数 (-c) 指定连接参数。有关连接参数的说明，请参见《Sybase
IQ 系统管理指南》中的第 4 章 “连接和通信参数”。

任何有效的用户 ID 都可以运行信息实用程序；但是要获得页面使用情
况统计，则需要具有 DBA 授权。

将输出消息记录到文件 (-o) 将输出消息写入指定的文件。

安静地运行 (-q) 不显示输出消息。

页面使用情况统计 (-u) 显示有关所有目录存储表的使用情况和大小的
信息，其中包括系统表和用户定义表。

只有在没有其他用户连接到数据库时，您才可以请求页面使用情况统计。

选项 说明

-c "keyword=value; ..." 数据库连接参数

-o filename 将输出消息记录到文件

-q 安静地工作

-u 输出页面使用情况统计
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日志转换实用程序 (dbtran)
使用日志转换实用程序，您可以将事务日志转换为 .sql 命令文件。

可以在命令提示符下使用 dbtran 命令访问日志转换实用程序。对于并入
批处理文件或命令文件，这种访问方法颇为有用。

语法 针对事务日志运行：

dbtran [options ] transaction-log [ SQL-file ]

针对数据库服务器运行：

dbtran [ options ]

参数
选项 说明

-a 包括未提交的事务

-c "keyword=value; …" 提供数据库连接参数 – 该选项不能与事务日志
名一起使用

-d 按时间顺序显示输出

-ek key 指定加密密钥

-ep 提示输入加密密钥

-f 只输出自最近检查点操作以来的事务

-g 在输出中包括审计记录

-ir offset1,offset2 只包括在两个指定偏移之间的日志部分

-is source,… 只包括来自指定源的行

-it user.table,… 通过指定逗号分隔的 user.table 列表，只包括对
指定表进行的操作

-j date/time 输出给定时间之前最后一次检查点操作以来的
事务

-m 指定事务日志目录（需要 -n 选项）

-n filename 在针对数据库服务器使用时，输出 SQL 文件

-o filename 将输出消息记录到文件

-q 安静地运行，不显示消息

-r 删除未提交的事务（缺省）

-rsu username,… 替换缺省的 Replication Server 用户名

-s 生成 ANSI 标准的 SQL UPDATE 事务

-sr 生成 SQL Remote 注释

-t 将触发器生成的事务包括在输出中

-u userid,… 只转换列出用户的事务

-x userid,… 排除列出用户的事务

-y 替换文件而无需确认

-z 只将触发器生成的事务作为注释包括在其中
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用法 dbtran 实用程序获取事务日志中的信息，并将该信息作为一组 SQL 语句
和注释置于输出文件中。能以下列方式运行此实用程序：

• 针对数据库服务器 以此方式运行时，此实用程序是标准的客户端应
用程序。它使用在 -c 选项之后指定的连接字符串连接到数据库服务
器，并将输出保存在使用 -n 选项指定的文件中。以此方式运行需要
有 DBA 授权。

下面的命令转换来自服务器 asiqdemo 的日志信息，并将输出保存在
名为 asiqdemo.sql 的文件中。

dbtran -c "eng=asiqdemo;dbn=asiqdemo;uid=DBA;pwd=SQL" 
-n asiqdemo.sql

• 针对事务日志文件 以此方式运行时，此实用程序直接针对事务日志
文件执行操作。如果要防止用户具有运行此语句的能力，则应防止
对事务日志文件的一般访问。

dbtran asiqdemo.log asiqdemo.sql

dbtran 实用程序运行时，将显示事务日志中最早的日志偏移。这可以作
为确定所生成的多个日志文件的顺序的有效方法。

退出代码为 0 （成功）或非零值 （失败）。

有关日志转换实用程序选项的详细信息，请参见 “选项”（第 99 页）。

此实用程序接受 @filename 参数。有关详细信息，请参见“服务器命令
行开关”（第 7 页）。

选项 包括未提交的事务 (-a) 事务日志包含任何事务在最近一次 COMMIT 之前
做出的任何更改。最近一次提交之后做出的更改不会出现在事务日志中。

连接字符串 (-c) 在针对数据库服务器运行实用程序时，此参数指定连接
字符串。

运行 dbtran 需要有 DBA 授权。

有关连接参数的说明，请参见 《Sybase IQ 系统管理指南》第 4 章 “连
接和通信参数”中的 “连接参数”。

Transaction-log 要转换的日志文件，该选项不能与 -c 或 -n 一起
使用

SQL-file 包含已转换信息的输出文件，该选项仅可与 
transaction-log 一起使用

选项 说明
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按时间顺序显示输出 (-d) 按照从最早到最晚的次序显示事务。提供此功
能的主要目的是在审计数据库活动时使用：不应针对数据库应用此命令
的输出。

指定加密密钥 (-ek) 使用此选项，您可以直接在命令行上为强加密数据
库指定加密密钥。如果您有一个强加密数据库，则必须提供加密密钥，
才能以任意方式使用数据库或事务日志。

对于强加密数据库，您必须指定 -ek 或 -ep，但不要同时指定这两者。
如果您没有为强加密数据库指定密钥，则该命令将失败。

如果您要针对数据库服务器运行此实用程序（使用 -c 选项），则确保使
用连接参数指定密钥，而不是使用 -ek 选项指定密钥。例如，下面的命
令将从引擎 sample 中获取有关数据库 enc.db 的事务日志信息，并将其输
出存入 log.sql。

dbtran -n log.sql -c 
eng=sample;dbf=enc.db;uid=dba;pwd=sql;dbkey=mykey

提示输入加密密钥 (-ep) 使用此选项，您可以在命令行中指定系统须提示
输入加密密钥。该选项将导致显示一个对话框，可以在该对话框中输入
加密密钥。这样，加密密钥始终都不会以明文显示，从而提供了额外的
安全保证。

对于强加密数据库，您必须指定 -ek 或 -ep，但不要同时指定这两者。
如果您没有为强加密数据库指定密钥，则该命令将失败。

如果您要针对数据库服务器运行此实用程序（使用 -c 选项），则确保使
用连接参数指定密钥，而不是使用 -ep 选项指定密钥。例如，下面的命
令将从引擎 sample 中获取有关数据库 enc.db 的事务日志信息，并将其输
出存入 log.sql。

dbtran -n log.sql -c 
eng=sample;dbf=enc.db;uid=dba;pwd=sql;dbkey=mykey

只输出自最近检查点操作以来的事务 (-f) 只输出自最近检查点操作以来完
成的事务。

包括审计信息 (-g) 如果启用了 AUDITING 数据库选项，则将审计信息添加
到事务日志中。使用此选项，可将审计信息作为注释包括在输出文件中。

有关详细信息，请参见《Sybase IQ 参考手册》第 2 章 “数据库选项”
中的 “AUDITING 选项 [ 数据库 ]”。

包括来自指定源的行 (-is) 隔离针对已由以下一个或多个源中的操作修改
的行的操作，这些源以逗号分隔列表的形式指定：

• All 所有行。这是缺省设置。

• SQLRemote 只包括使用 SQL Remote 修改的行。您也可以使用简写
形式 SR。
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• RepServer 只包括使用 Replication Agent (LTM) 和 Replication 
Server 修改的行。您也可以使用简写形式 RS。

• Local 只包括没有复制的行。

包括偏移范围 (-ir) 隔离在两个指定偏移之间的事务日志部分。

包括指定的表 (-it) 隔离对指定逗号分隔列表中的表所执行的操作。应该
以 owner.table 的形式指定每个表。

输出给定日期之前最后一次检查点操作以来的事务 (-j) 仅转换给定日期和/或
时间之前最后一次检查点操作以来的事务。用户提供的参数可以是日期、
时间或日期和时间（以引号括起的形式）。如果省略时间，则将时间假定
为一天的起始时间。如果省略日期，则假定为当天。下面是可接受的日期
及时间格式：“YY/MMM/DD HH:NN”。

事务日志目录 (-m) 使用此选项可指定包含事务日志的目录。此选项必须
与 -n 选项一起使用。

输出文件 (-n) 在针对数据库服务器运行 dbtran 实用程序时，请使用此选
项指定保存 SQL 语句的输出文件。

将输出消息记录到文件 (-o) 将输出消息写入指定的文件。

安静地运行 (-q) 不显示输出消息。只有在命令提示符下运行此实用程序
时才可以使用此选项。

不包括未提交的事务 (-r) 删除所有未提交的事务。这是缺省行为。

替换 Replication Server 用户名 (-rsu) 缺省情况下，-is 选项假定缺省的
Replication Server 用户名为 dbmaint 和 sa。您可以使用 -rsu 选项和用逗
号分隔的用户名列表来替换这些假定的用户名。

生成 ANSI 标准的 SQL UPDATE (-s) 如果不使用此选项，而且在表上没
有主键或唯一索引，则在有重复行的情况下，该转换实用程序将生成带
有非标准 FIRST 关键字的 UPDATE 语句。如果使用此选项，则忽略
FIRST 关键字，以便与 SQL 标准兼容。

生成 SQL Remote 注释 (-sr) 将生成的注释保存在说明 SQL Remote 如何
将操作分发到远程站点的输出文件中。

包括触发器生成的事务 (-t) 缺省情况下，触发器执行的操作不包括在命令
文件中。如果数据库中存在匹配的触发器，则在针对该数据库运行命令
文件时，相应触发器将自动执行操作。如果运行命令文件所针对的数据
库中不存在匹配的触发器，则应该包括触发器操作。

只输出列出用户的事务 (-u) 使用此选项，您可以将事务日志的输出限制
为只包括指定用户的事务。

输出除列出用户的事务以外的事务 (-x) 使用此选项，您可以将事务日志的
输出限制为排除指定用户的事务。



Ping 实用程序 (dbping) 

102  Sybase IQ

在不确认操作的情况下运行 (-y) 如果选择了此选项，则自动替换现有命令
文件，而不提示您进行确认。

仅将触发器生成的事务作为注释包括在内 (-z) 触发器生成的事务将仅作为
注释包括在输出文件中。

Ping 实用程序 (dbping)
Ping 命令行实用程序 dbping 可帮助诊断连接问题。

语法 dbping [options]

参数 下表列出了 dbping 实用程序的可用选项。

表 3-13： dbping 选项

用法 提供 dbping 实用程序的目的是为了帮助排除连接问题。它会获取完整或
不完整的连接字符串并返回消息，指示定位服务器或数据库或进行连接
的尝试是否成功。

该实用程序可以用于嵌入式 SQL 连接或 ODBC 连接。它不能用于 
jConnect (TDS) 连接。

退出代码为 0 （成功）或非零值 （失败）。

此实用程序接受 @filename 参数。

选项 连接参数 (-c) 有关连接参数的说明，请参见《Sybase IQ 系统管理指南》
中的第 4 章 “连接和通信参数” 。如果没有指定连接参数，则使用
SQLCONNECT 环境变量中的连接参数 （如果已设置）。

选项 说明

-c "keyword=value; ..." 提供数据库连接参数

-d 如果找到了服务器，则进行数据库连接

-l library 使用指定的 ODBC 驱动程序或驱动程序管理
器库

-m 使用 ODBC 驱动程序管理器。否则，使用嵌入式
SQL 连接。

-o filename 将输出消息记录到文件

-pc property,… 报告指定的连接属性

-pd property,… 报告指定的数据库属性

-ps property,… 报告指定的数据库服务器属性

-q 安静地运行 – 不显示消息

-z 显示调试信息
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进行数据库连接 (-d) 强制数据库回应，而不仅仅是强制服务器回应。

如果您不提供 -d 选项，那么 dbping 在找到 -c 选项指定的服务器时会报告
成功。如果提供 -d 选项，则 dbping 仅会在与服务器和数据库都建立了连
接的情况下才报告成功。

例如，如果您拥有一个运行 sample 数据库且名为 blair 的服务器，则下面
的命令将成功：

dbping -c "eng=blair;dbn=sample"

下面的命令将失败，并显示消息 Ping database failed -- 
specified database not found：

dbping -d -c "eng=blair;dbn=sample"

装载指定的库 (-l) 指定要使用的库（不带其文件扩展名）。此选项可避免
使用 ODBC 驱动程序管理器，因此在 UNIX 操作系统上是特别有用的。

例如，下面的命令将直接装载 ODBC 驱动程序：

dbping -m -c "dsn=ASIQ12 Sample" -l dbodbc9

在 UNIX 上，如果您希望使用线程连接库，则必须使用 Ping 实用程序的
线程版本 dbping_r。

使用 ODBC 进行连接 (-m) 使用 ODBC 建立连接。缺省情况下，dbping
使用嵌入式 SQL 接口尝试连接。

报告连接属性 (-pc) 在进行连接时，显示指定的连接属性。以逗号分隔列
表的形式提供这些属性。如果使用此选项，则您必须指定足够的连接信
息才能建立数据库连接。

有关连接属性的列表，请参见《Adaptive Server Anywhere 数据库管理指
南》中的 “连接级属性”。

例如，下面的命令显示作为连接属性提供的 DIVIDE_BY_ZERO_ERROR
选项设置。

dbping -c ... -pc Divide_by_zero_error

报告数据库属性 (-pd) 在进行连接时，显示指定的数据库属性。以逗号分
隔列表的形式提供这些属性。如果使用此选项，则您必须指定足够的连
接信息才能建立数据库连接。

有关数据库属性的列表，请参见《Adaptive Server Anywhere 数据库管理
指南》中的 “数据库级属性”。

例如，以下命令显示数据库正在使用的 Java 版本：

dbping -c ... -pd JDKVersion
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报告数据库服务器属性 (-ps) 在连接之后，显示指定的数据库服务器属
性。以逗号分隔列表的形式提供这些属性。

有关数据库服务器属性的列表，请参见《Adaptive Server Anywhere 数据
库管理指南》中的 “服务器级属性”。

例如，下面的命令将显示用于启动服务器的命令行：

dbping -c ... -ps CommandLine

将输出消息记录到文件 (-o) 将输出消息写入指定的文件。

安静地运行 (-q) 如果 dbping 失败，始终都会显示消息。如果成功，则在
指定 -q 的情况下不显示消息。

显示调试信息 (-z) 只有在尝试进行嵌入式 SQL 连接时，才能使用此选
项。亦即此选项不可与 -m 或 -l 搭配使用。该选项可显示用于尝试连接的
网络通信协议和其它诊断消息。

服务器定位实用程序 (dblocate)
提供 “服务器定位”命令行实用程序 dblocate 的目的为，通过在当前的
TCP/IP 网络上定位数据库服务器来帮助诊断连接问题。

语法 dblocate [ options ]

参数 下表列出了 dblocate 实用程序的可用选项。

表 3-14： dblocate 选项

用法 dblocate 实用程序会定位在当前网络上通过 TCP/IP 运行的任何 Adaptive
Server Anywhere 或 Sybase IQ 数据库服务器。该实用程序会输出数据库
服务器及其地址的列表。

根据网络的不同，该实用程序可能要在几秒钟之后才能输出结果。

选项 将输出消息记录到文件 (-o) 将输出消息写入指定的文件。

安静地运行 (-q) 不显示输出消息。

选项 说明

-o filename 将输出消息记录到文件

-q 安静地运行 – 不显示消息
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事务日志实用程序 (dblog)
Sybase IQ 可自动处理数据库事务日志的创建和删除。使用“事务日志”
命令行实用程序 dblog，您可以显示或更改与数据库关联的事务日志或事
务日志镜像的名称。使用 dblog，您还可停止数据库对事务日志镜像的维
护，或者启动事务日志镜像的维护。

数据库运行时必须维护事务日志。如不存在事务日志，Sybase IQ 服务器
将无法启动。事务日志镜像是事务日志的副本，由数据库以串联方式维
护。尽管维护事务日志镜像并非必需操作，但这在任何情况下都是推荐
做法，对于未经常性备份 IQ 数据库的站点则尤为如此。

语法 dblog [options] database-file

参数 下表列出了 dblog 实用程序的可用选项。

表 3-15： dblog 选项

用法 您可以使用 dblog 命令行实用程序显示或更改事务日志或事务日志镜像
的名称。您还可停止或启动事务日志镜像的维护。

事务日志的名称最先是在创建数据库时设置的。必须在数据库未运行时
更改其事务日志文件名。

在使用 RESTORE 语句移动和/或重命名数据库时，可以重命名除事务日
志以外的所有文件。数据库恢复之后，事务将继续写入之前名称的日志
文件，该文件与目录存储文件 （.db 文件）位于同一位置。

重命名或移动数据库中的所有其它文件时，最好也对日志文件执行同样
操作。若要移动或重命名日志文件，可以使用事务日志实用程序 (dblog)。
您应在以下情况下运行此实用程序：

• 对新的数据库名称使用 RESTORE 之后

• 使用带有 RENAME 选项的 RESTORE 之后

选项 说明

-m mirror-name 设置事务日志镜像名 
-o filename 将输出消息记录到文件

-q 安静模式 – 不显示消息

-r 不再使用事务日志镜像

-t log-name 设置事务日志名
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即使未恢复数据库，也可使用 dblog 重命名事务日志，不过必须满足以下
限制条件：

• IQ 服务器必须已停止。

• 数据库必须未参与 SQL Remote 复制。对于 Sybase IQ，也即意味着
此过程不可在 Multiplex 环境下使用。

• 重命名日志后，请将旧日志一直保留到下一数据库备份完成为止，
以备介质发生故障后进行恢复时使用。

dblog 实用程序显示有关事务日志的其它信息，其中包括：

• 版本号

• 复制时使用的起始偏移

• 复制时使用的结束偏移

• 页大小

• 总页数

• 空页数

• 正在使用的日志文件的百分比

有关如何截断事务日志文件的信息，请参见 《Sybase IQ 性能和调优指
南》第 5 章 “管理系统资源”中的 “事务日志文件”。

选项 设置事务日志镜像文件的名称 (-m) 此选项为新的事务日志镜像设置文
件名。如果数据库当前没有使用事务日志镜像，则会开始使用一个。如果
数据库已在使用事务日志镜像，则会改用此新文件作为其事务日志镜像。

将输出消息记录到文件 (-o) 将输出消息写入指定的文件。

安静地运行 (-q) 不显示输出消息。该选项仅在命令行实用程序中可用。

不再使用事务日志镜像 (-r) 对于维护镜像事务日志的数据库，此选项将
其行为更改为只维护一个事务日志。

设置事务日志文件的名称 (-t) 此选项为新的事务日志设置文件名，包括
可选的目录路径。数据库会改用此新文件作为其事务日志。

不要使用 dblog -n 选项。不支持对 IQ 数据库使用此选项。
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验证实用程序 (dbvalid)
“验证”命令行实用程序 dbvalid 可验证目录存储中的部分或所有 Adaptive
Server Anywhere 表的索引和键。验证实用程序扫描整个表，并在表上定义
的每个索引和键中查找每个记录。缺省情况下，验证实用程序使用快速检
查选项。

注意  dbvalid 实用程序可用来轻松验证 Adaptive Server Anywhere 目录存储
表，但是并不验证 IQ 表。可使用 IQ 存储过程 sp_iqcheckdb 验证 IQ 表。

可以在系统的命令行级别访问 dbvalid 实用程序，这一访问途径有助于将
dbvalid 并入批处理文件或命令文件。

语法 dbvalid [ options ] [object-name,... ]

参数 表 3-16 列出了 dbvalid 实用程序的可用选项。

表 3-16： dbvalid 选项

用法 使用 dbvalid 命令行实用程序，您可以验证目录存储中的部分或所有 
Adaptive Server Anywhere 表的索引和键。此实用程序扫描整个表，并验
证是否每行都存在于相应的索引中。其效果等同于对每个目录存储表都
运行 Adaptive Server Anywhere VALIDATE TABLE 语句。

注意  在 Sybase IQ 中，不支持 VALIDATE TABLE。 sp_iqcheckdb 过程可为
IQ 存储表提供相似的功能。

缺省情况下，验证实用程序使用快速检查选项。不过，如果指定了 -f、-fd、
-fi、 -fn 或 -i，则不会使用快速检查选项。

选项 说明

object-name 要验证的表或索引（如果使用了 -i）的名称

-c “keyword=value; ...” 提供数据库连接参数

-o filename 将输出消息记录到文件

-f 使用完整检查验证表

-fd 使用数据检查验证表

-fi 使用索引检查验证表

-fx 使用快速检查验证表

-i 每个 object-name 都是一个索引

-q 安静地运行 – 不显示消息

-s 使用校验和验证数据库页

-t 每个 object-name 都是一个表
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如果目录存储表存在不一致，则 dbvalid 将报告错误。如果报告了错误，
则可以删除表的所有索引和键，然后重新进行创建，还需要重新创建表
的所有外键。

警告！应在没有任何连接对数据库进行更改时对表或整个目录存储进行
验证；否则，可能会报告误报的错误，指出某种形式的数据库损坏，而
实际上并没有任何损坏。

退出代码是：

有关验证期间所进行的特定检查的信息，请参见以下的选项说明。

选项 连接参数 (-c) 提供数据库连接参数。有关说明，请参见 《Sybase IQ 系
统管理指南》中的 “连接参数”（第 123 页）。用户 ID 必须具有 DBA
授权或 REMOTE DBA 授权。

例如，下面的命令验证样本数据库，以口令为 SQL 的用户 DBA 身份进行
连接：

dbvalid -c “uid=DBA;pwd=SQL;dbf-c:\sybase\ASIQ-12_7\demo\asiqdemo.db”

对每个表的完整检查 (-f) 除了缺省验证检查之外，还执行数据检查 (-fd) 
和索引检查 (-fi)。此选项对应于 Adaptive Server Anywhere VALIDATE 
TABLE 语句中的 WITH FULL CHECK 选项。根据目录存储的内容，此选
项可能会极大延长验证所需的时间。

对每个表进行数据检查 (-fd) 除了缺省的验证检查之外，还检查是否可以
读取 LONG BINARY、 LONG VARCHAR、 TEXT 或 IMAGE 所有这些数据类
型。这些数据类型的条目可能跨越多页。在 IQ 目录存储中，以下所指为：

• Domain – 用户定义的数据类型

• IMAGE – 针对 LONG BINARY 的域

• TEXT – 针对 LONG VARCHAR 的域

程序退出代码 说明

0 数据库验证成功

1 实用程序发生一般性故障

2 验证数据库时出错

7 无法找到要连接的数据库（数据库名称错误）

8 无法连接到数据库（用户 ID/口令错误）

11 无法找到要连接的服务器（服务器名称错误）

12 用于启动数据库的加密密钥不正确
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此选项指示数据库服务器检查每一条目使用的所有页。此选项对应于 
Adaptive Server Anywhere VALIDATE TABLE 语句中的 WITH DATA 
CHECK 选项。根据目录存储的内容，此选项可能会极大延长验证所需
的时间。

对每个表进行索引检查 (-fi) 除了缺省验证检查之外，还验证表上的每个
索引。此选项对应于 Adaptive Server Anywhere VALIDATE TABLE 语句中
的 WITH INDEX CHECK 选项。根据目录存储的内容，此选项可能会极
大延长验证所需的时间。

对每个表进行快速检查 (-fx) 仅使用 Sybase IQ 12.5 版或更高版本创建的
数据库支持此选项。除了缺省检查和数据检查之外，还检查表中的行数
是否与索引中的条目数匹配。此选项对应于 Adaptive Server Anywhere 
VALIDATE TABLE 语句中的 WITH EXPRESS CHECK 选项。此选项不为每
个行执行单独的索引查找。

验证指定的索引 (-i) 验证索引，而不是验证表。确保表中确实存在索引中
引用的各行。对于外键索引，还要确保主表中存在相应的行。如果提供
table-name 而不是 index-name，将验证主键索引。在这种情况下，对
dbvalid 来说，所提供的每个 object-name 值都代表索引而不是表，其名称
格式如下：

[ [ owner.]table-name.]index-name
执行此选项的用户必须是创建索引的表的所有者，且具有 DBA 授权或
REMOTE DBA 授权。

将输出消息记录到文件 (-o) 将输出消息写入指定的文件。

安静地操作 (-q) 不显示输出消息。

使用页面校验和验证数据库 (-s) 校验和用于确定是否在磁盘上已修改了
数据库页。如果创建数据库时启用了校验和，则可以使用校验和验证目
录存储。校验和验证读取磁盘上的每个目录存储页，并计算其校验和。
如果计算出来的校验和与页面存储的校验和不同，则该页面已在磁盘上
被修改，从而会返回错误。任何无效目录存储页的页码都会显示在服务
器消息窗口中。 -s 选项不能与 -i、 -t 或任何 -f 选项一起使用。

验证表 (-t) object-name 值的列表是表的列表。这也是缺省行为。

示例 例如，下面的命令验证样本数据库的目录存储，以口令为 SQL 的用户
DBA 身份进行连接：

dbvalid -c “uid=DBA;pwd=SQL;dbf-c:\sybase\ASIQ-12_7\demo\asiqdemo.db”
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另请参见 • 《Sybase IQ 参考手册》第 10 章 “系统过程”中的 “sa_validate 系
统过程”

• 《Sybase IQ 参考手册》第 10 章 “系统过程”中的 “sp_iqcheckdb
过程” 

• 《Sybase IQ 故障排除和恢复指南》第 2 章“系统恢复与数据库修复”
中的 “数据库验证”
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第  4  章 SQL 预处理器

关于本章 本章提供 SQL 预处理器 (sqlpp) 的参考信息。

目录

SQL 预处理器简介 
嵌入式 SQL 是一种用于 C 和 C++ 编程语言的数据库编程接口。嵌
入式 SQL 由混杂在（嵌入于）C 或 C++ 源代码中的 SQL 语句组成。
这些 SQL 语句先由 SQL 预处理器转换为 C 或 C++ 源代码，然后您
再进行编译。

Sybase IQ SQL 预处理器实用程序 sqlpp 将输入文件 (.sqc) 中的 SQL
语句转换为 C 语言源代码并置于输出文件 (.c) 中。

主题 页码

SQL 预处理器简介 111
运行 SQL 预处理器 (sqlpp) 112
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运行 SQL 预处理器 (sqlpp)
本部分提供 sqlpp 命令的语法并对 sqlpp 命令行选项进行说明。

语法 sqlpp [ options ] sql-filename [ output-filename ]

参数 下表列出了 sqlpp 实用程序的可用选项。

表 4-1： sqlpp 选项

用法 SQL 预处理器会在编译器运行之前对包含嵌入式 SQL 的 C 程序或 C++ 程
序进行处理。sqlpp 将输入文件 sql-filename 中的 SQL 语句转换为 C 语言源
代码，转换后的代码将置于 output-filename 中。含有嵌入式 SQL 的源程序
的扩展名通常为 .sqc。缺省的输出文件名是 sql-filename，其扩展名为 .c。
如果 sql-filename 具有 .c 扩展名，则缺省的输出文件扩展名是 .CC。

选项 理想数据大小 (-d) 生成减小数据空间大小的代码。数据结构在使用之
前执行时会得到重新使用和初始化。这会增大代码的大小。

标记 SQL92 错误 (-e level) 此选项将不是 SQL92 指定集合组成部分的
任意嵌入式 SQL 标记为错误。

选项 说明

-d 理想数据大小

-e level 将不符合要求的 SQL 语法标记为错误

-f 将 far 关键字置于生成的静态数据上

-h line-width 限制输出的最大行长度

-k 包括 SQLCODE 的用户声明

-n 行号

-o operating-sys 目标操作系统规范（WINDOWS、WINNT 或 UNIX）

-q 安静模式，不打印旗标

-r 生成再入式代码

-s string-len 编译器字符串常量的最大长度

-w level 将不符合要求的 SQL 语法标记为警告

-x 将多字节 SQL 字符串更改为转义序列

-z sequence 指定归类序列
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可用的 level 值及其含义如下：

• e 标记不是入门级 SQL92 语法的语法

• i 标记不是中级 SQL92 语法的语法

• f 标记不是完整 SQL92 语法的语法

• t 标记非标准宿主变量类型

• w 允许所有支持的语法

添加 far 关键字 (-f) 将 far 关键字置于预处理器生成的数据之前。对于大
内存模型，可能需要将此选项与 Borland C++ 编译器结合使用。缺省情况
下，所有静态数据置于同一个段中。添加 far 关键字将会强制将静态数据
置于不同的段中。（缺省情况下， WATCOM C 和 Microsoft C 会将大于阈
值大小的数据对象置于其自己的段中。）

限制输出行的最大长度 (-h num) 将 sqlpp 输出的行的最大长度限制为 
num。续行符为反斜线 (\)，且 num 的最小值为 10。

用户 SQLCODE 声明 (-k) 通知预处理器，要编译的程序包括 
SQLCODE 的用户声明。

生成行号信息 (-n) 在 C 文件中生成行号信息。该信息包括生成的 C 代
码中适当位置处的 #line 指令。如果您使用的编译器支持 #line 指令，使
用此选项可使编译器按照 SQC 文件 （带有嵌入式 SQL 的文件）中的行
号报错，而不是用 SQL 预处理器生成的 C 文件中的行号报错。此外，
#line 指令由源代码级调试程序间接使用，以便您可以在查看 SQC 源文
件时进行调试。

目标操作系统 (-o) 指定目标操作系统。注意，此选项必须与程序运行
所使用的操作系统相匹配。在您的程序中会生成对特殊符号的引用。此
符号在接口库中定义。如果您使用的操作系统规范或库是错误的，则链
接程序会检测到一个错误。支持的操作系统有：

• WINDOWS Microsoft Windows ME

• WINNT Microsoft Windows 2000/2003/XP

• UNIX 适用于您的平台的 UNIX

安静地运行 (-q) 安静地运行。不打印旗标。

生成再入式代码 (-r) 有关再入式代码的详细信息，请参见《Adaptive 
Server Anywhere Programming Guide》（Adaptive Server Anywhere 编程指南）
中对多线程代码或再入式代码的 SQLCA 管理的说明。

设置字符串的最大长度 (-s string-len) 设置预处理器放入 C 文件中的字
符串的最大长度。长度大于此值的字符串将通过使用一组字符（'a'、'b'、
'c' 等）进行初始化。大多数 C 编译器都对可以处理的字符串文字大小有
限制。此选项用于设置其上限。缺省值是 500。
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标记 SQL92 警告 (-w level) 此选项将不是 SQL92 指定集合组成部分
的任意嵌入式 SQL 标记为警告。

可用的 level 值及其含义如下：

• e 标记不是入门级 SQL92 语法的语法

• i 标记不是中级 SQL92 语法的语法

• f 标记不是完整 SQL92 语法的语法

• t 标记非标准宿主变量类型

• w 允许所有支持的语法

转义 (-x) 将多字节字符串更改为转义序列，以便它们可以通过编译器。

指定归类序列 (-z sequence) 此选项指定归类序列或文件名。（有关可
用归类序列的列表，请参见“归类实用程序 (dbcollat)”（第 85 页））。

归类序列用于帮助预处理器理解在程序源代码中使用的字符，例如，识
别出适合在标识符中使用的字母字符。如果没有指定 -z，则预处理器会
尝试根据操作系统和 SQLLOCALE 环境变量确定要使用的合理归类。

另请参见 《Adaptive Server Anywhere Programming Guide》（Adaptive Server Anywhere
编程指南）中的“嵌入式 SQL 编程”章节。

《Sybase IQ Error Messages》（Sybase IQ 错误消息）中的 “SQL 预处理
器消息”。
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